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ABOUT THIS MANUAL 
SYMBOLS 

This manual provides important information to help in understanding the features and safe use of the  device. The symbols 
outlined below highlight helpful tips and important cautions that will aide in guiding the reader through the manual.  

 
 

 

CAUTION 
Caution/warning symbol describes information that the user needs to 
know to prevent minor injury or product damage.  

 

IMPORTANT 
Important symbol describes important information about using the 
device.  

 
 

NOTE 
Note symbol describes additional information about the device.  
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1 INTRODUCTION AND GUIDELINES FOR USE 
 
The LABORIE Next Generation Modular AQUARIUS® system is a fully wireless system providing mobility and ease-of-use. 
Procedures can be performed with the mountable modules and controlled by the AQUARIUS® software. 
 
Connect to all devices from one central control hub (CHC). The wireless and battery-powered features of each device allow 
for improved system setup and use. 

 
For warranty information and terms and conditions, visit the following website: 
http://www.laborie.com/terms-and-conditions/ 
 

 
Figure 1: AQUARIUS Modules  

 INTENDED USE 
1.1.1 AQUARIUS® SYSTEM 
The AQUARIUS® LT, AQUARIUS® CT, and AQUARIUS® XT are diagnostic analyzer systems.  The product is a data 
acquisition system for Urodynamics and peripheral diagnostics that records and displays physiological data from the 
patient. It is to be used as medical diagnostic equipment. Details are described as follows: 

• Central Hub Computer: has a touch LCD as a new HMI and collects/synchronizes data from all procedure modules 
and sends data to PC. It also displays the device status and provides interface for calibration and pump setup. 

• Pump Module: The pump on the Central Hub is used to infuse a patient’s bladder with saline from an IV bag. 
• Pressure transducers: These are the sensors for pressure measurement. 
• EMG: Electromyography (EMG) transducer for measuring the raw and enveloped muscle activity. 
• Urocap/Uroflow: Load cell transducer to detect volume and flow of liquid into a beaker.  
• UPP Puller: Retracts a catheter at a constant speed from the patient. 
• Roam™ DX: Wireless Battery Powered EMG Measurement Device. 
• PC: Computer which controls the system activity, displays, and stores data. 

1.1.2 ANORECTAL MANOMETRY (ARM) SYSTEM  
• LABORIE’s ARM system is intended to measure physical parameters such as pressures and EMG of the terminal 

end of the digestive tract as it relates to Urodynamics, Incontinence, and the Pelvic Floor. 

1.1.3 SPINNING DISK FLOW TRANSDUCER 
The Flow Transducer is intended to sense voiding flow. It is used together with UDS devices for 
assessing voiding disorders. 
 

http://www.laborie.com/terms-and-conditions/
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 TARGET POPULATION 
• The major application of Urodynamics is the diagnosis of uncontrolled loss of urine (incontinence), abnormal 

urinary retention, neurological causes of Micturition disorders, or anorectal manometry. 
• The major application of anorectal manometry (ARM) is to aid in the diagnosis of anorectal disorders and 

incontinence in men, women and children. 

 CONTRAINDICATIONS 
 WARNING: The AQUARIUS® system is contraindicated for any patient who is not a candidate for Urodynamic 

testing.  
 
Catheters should not be used on patients who suffer from: 

• Bladder infections 
• Strictures in the urethra 
• Prior to testing, a urinalysis and urine culture should be considered to rule out the presence of infection. 

 
Single use, disposable catheters supplied by LABORIE Medical Technologies are “sterile”, unless stated otherwise on the 
packaging label and instructions. 
 
Reusable catheters are cleaned but not sterilized before shipping. 
 

 TARGET USERS 
• Only medical professionals trained in Urodynamics should operate this device. The operator must read the 

Owner’s manual entirely and refer to any additional training materials before using the device. Optional In-
Service is available from LABORIE. 

• To reduce the risk of cross-contamination or infection, physicians should be knowledgeable and qualified in 
applying the appropriate aseptic technique during the intended use of the device.  The use of prophylactic 
antibiotics is at the discretion of the physician and the policies of the institution. 

• To reduce the risk of serious patient injury, it is vital that physicians and clinicians performing Urodynamics 
studies on patients with a Spinal Cord Injury be prepared to recognize and treat Autonomic Dysreflexia.  

• To reduce the risk of serious patient injury, it is vital that physicians and clinicians performing Urodynamics 
studies be prepared to recognize and treat symptoms associated with vasovagal syncope (fainting) during 
Urodynamics procedures. 

Warnings related to Ureteral Catheterization can be referenced within the T-DOC instructions for use (TDOC-UM01).  
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 WARNINGS AND PRECAUTIONS 

  PRECAUTION: 
 LABORIE equipment and accessories are licensed by Governments and approved by Safety Agencies to work 

with each other ONLY. 
 To prevent any risk of damage to the cart: 
• Do not lean on trays, accessories, monitors, main tower, or spine of any carts. 
• Monitor should be free of any obstacles. Do not hang anything on the monitor. 
• Do not suspend extra weight from the monitors. 
• Maximum weight on the work trays should not exceed more than 22 lbs. (10 kg). 

 

CAUTION: 
UNITED STATES FEDERAL LAW RESTRICTS THIS DEVICE TO SALE OR USE BY OR ON THE ORDER OF A LICENSED 
PHYSICIAN. 

 WARNINGS: 
READ CAREFULLY BEFORE USE! 
 

 ONLY LABORIE trained technicians may service the unit   
 LABORIE equipment and accessories are warranted to work with each other ONLY. 

 Do not use if device packaging has been opened, or damaged, or if it presents any fault due to improper 
transport, storage, or handling that could in any way hamper its use. 

 Ensure all wheels are locked during testing procedures to prevent injury to the patient. Do not lean on the 
equipment nor hang excessive weighted objects other than LABORIE standard accessories on the platform. 

 Exhibit caution when raising the PC & monitor from its lowest position as the mount may rise abruptly due to 
the strong springs used to counter-balance the weight. 

 Do not immerse the UDS equipment or any components in water or any other liquids. 
 Do not place your fingers inside the pump head when the pump rollers are moving. 

 LABORIE is not responsible for loss of patient files or test data. We recommend that you back up patient data 
on a regular basis. 

 DO NOT USE in the presence of a flammable anesthetic mixture with air or oxygen or nitrous oxide. 

 DO NOT USE electromyography (EMG) simultaneously with high frequency surgical equipment. 
 Do not operate the NXT System near shortwave or microwave therapy equipment as proximity may produce 
instability in the APPLIED PARTS.  

 Do not allow applied parts linked to a PATIENT CONNECTION, but not connected to the PATIENT, to 
contact other conductive parts including those connected to protective earth. Preserve the patient connection 
electrical isolation.  

 Use the AQUARIUS® with LABORIE equipment and accessories ONLY. Do not reuse single-use accessories. 
After use, dispose in accordance with local regulations. 

 Re-use, reprocessing or resterilization of disposables can lead to device failure and create a risk of cross-
infection and/or cross transmission of infectious disease(s) from one patient to another.  

 Sterilization failure of reusable items prior to initial use or reuse can result in cross infection and/or cross-
transmission of infectious disease from one patient to another. 

 DO NOT USE the AQUARIUS® in the presence of a magnetic resonance imaging system as the AQUARIUS® 
may contain ferromagnetic objects that pose a risk to the patient in the presence of a magnetic core.  The 
strong magnetic field produced by the MRI may cause disruption of the system.  

 Always ensure the Transducer cup drain hole on the Spinning Disk Flow Transducer is unobstructed. If 
obstructed, clear away the obstruction before use. 

 Be aware that prolonged use of video capture may result in elevated temperatures at the rear of the AIO PC 

 To avoid the risk of electric shock, only connect this equipment to supply mains with protective earth. 

 Device intended for use in a clinical environment with controlled EMC standards to limit potential 
interference.  The AQUARIUS® may be adversely affected by Bluetooth®, cellular or EMC interference.  
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Minimize interference from other Bluetooth devices by setting up all components of system in proximity to 
each other. 

 Only connect devices specified and approved by Laborie to the AQUARIUS® multiple socket outlets. 
Connecting any device not approved by LABORIE to the ME system alters the functional integrity of the 
product creating a safety risk. 

 Avoid altering or adding to AQUARIUS® medical electrical system.  Any alteration to the AQUARIUS® system 
by an unauthorized party transfers responsibility for meeting ME system requirements from LABORIE to the 
altering party.  Anyone connecting supplementary equipment to medical electrical equipment configures a 
medical system and is therefore responsible for ensuring that the system complies with the requirements for 
medical electrical systems, encompassed in the IEC 60601 series. 

 Batteries are not operator removable.  Do not attempt to remove battery.  All servicing of AQUARIUS system, 
components or attachments to be completed by LABORIE. 

 Do not place the printer in the patient environment unless it is powered via the Laborie provided Line 
Isolation Transformer (Separating transformer). 

 Only connect items that have been approved by Laborie to the system. Any additional connections become 
the responsibility of the operator and shall tested to meet the IEC 60601-1, ME SYSTEMS requirements. 

 There is the risk of electrical shock if the operator plugs in Non-ME Equipment (i.e. printer or laptop) directly 
into the MAINS supply that is intended to be powered by a Line Isolation Transformer (Separating 
transformer) 

 Do not touch the printer/laptop and the patient simultaneously. 

NOTE: Local laws take priority over the above-mentioned requirements and warnings; if in doubt, consult your local 
Laborie representative or the technical service department. 
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2 CLEANING AND PREVENTIVE MAINTENANCE 
 IMPORTANT: Do not immerse the equipment or devices in water or any other liquids! 

 GENERAL CLEANING AND PREVENTIVE MAINTENANCE 
• Always wear protective gloves when cleaning the equipment to prevent biological contamination. 
• The AQUARIUS® system is non-immersible. The system and its modules, including the cart and its 

components, should be wiped down with a clean cloth dampened with a cleaning solution such as soap and 
water or as per hospital cleaning instructions.   

• The EMG electrodes, tubing, disposable catheters, optional strap, and cartridges are intended for SINGLE 
PATIENT USE only.  Do NOT re-use disposables. 

• For the pressure transducers, clean any fluids or other foreign matter from the external surfaces of the 
transducers and cables using a slightly damp cloth and a mild detergent solution. Do not immerse. Do not 
use chlorine-based cleaning solutions/agents. Do not autoclave or EtO sterilize the transducer. 

• Performing regular maintenance will reduce the need for repairs. Check the calibration every 6 months or 
whenever you suspect the transducers are off calibration to maintain optimal system performance. 

• Pay close attention to the LED lights on each device. If they indicate a broken connection and/or low battery, 
then make sure that the connection is re-established, or the battery is fully charged. For information on LED 
lights refer to the Equipment Status and Light Signals section on page 29.  Always charge the devices when 
alerted to do so by the system. 

 CARING FOR THE ROAM™ DX 
• The Roam™ DX is not immersible. Wipe the outside only with soap and water or with a hospital-grade 

disinfectant. 

 IMPORTANT: Do not spray cleaning solution directly on or in the Roam™ DX. 
• Clean the Roam™ DX holster with standard hospital wipes. 
• The optional strap is disposable, non-sterile, and recommended for single use only. 

 

NOTE:  
• The insertion points of the EMG headstage/processor must be kept dry; never immerse the EMG into water 

or any liquids.  The EMG headstage/processor can be wiped clean with a cloth dampened with soap or mild 
detergent and wiped dry immediately. 

• LABORIE recommends charging and using the Roam™ DX at least once or twice a year to maintain optimal 
performance.  If it will be placed in storage, make sure it is stored with the battery fully charged. 

 CARING FOR THE UROCAP V UROFLOWMETER 
Follow the instructions below to clean the Urocap™ V of possible urine contamination.  Always wear protective gloves 
when cleaning the equipment to prevent biological contamination. 
 

 IMPORTANT: Do not soak or immerse the Urocap™ V in water! Do not immerse or soak in water or in any other 
liquids (Figure 2). 

 
Figure 2: Do not Immerse 
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• The lid of the Urocap™ V is not removable.  
• The Urocap™ V should be cleaned using a damp cloth with alcohol, soap, or disinfectant detergent (Figure 3).  

Store the Urocap™ V in a cool and dry area at room temperature.  Refer to System Specifications on page 183. 

 
Figure 3: Cleaning the Urocap™ V 

 
• Rinse and dry the Uroflow beaker after each use. Use Soap and water, or a mild detergent solution, for cleaning.  
• Wipe the chair, Flowstand, and funnel clean with a cloth dampened with soap or mild detergent and wiped dry 

immediately.  When cleaning the funnel, the maximum cleaning temperature should not exceed 80°C (176°F). 
To check if the Urocap™ V is functioning, refer to page 12. 
 

NOTE: Although the beaker is reusable, it will discolor over time and may need to be replaced. 
 

 CARING FOR THE SPINNING DISK FLOW TRANSDUCER 
On a weekly basis, test the device for proper functionality.  Inspect all cables and the sensor for cuts and other damage.  If 
in doubt, send the device for service. No additional maintenance is required. 

Clean the Flow Transducer at minimum once a week, preferably daily, to avoid deposits and odor.  Clean the device as 
follows: 

Quick Cleaning (Daily) 
• Slowly pour approximately 1L of clean water into the funnel. 
• Keep the disc running to flush the transducer cup. 

Thorough Cleaning (Weekly) 
1. Disconnect the Flow Transducer from the System. 
2. Disconnect the jug, the funnel, and the disk from the Spinning Flow Transducer. 
3. Use cleaning detergents appropriate for lavatory pans.  Clean all the parts according to the detergent 

manufacturers’ recommendations, including the inside and outside of the transducer cup. 
4. Wipe off all parts with an appropriate disinfection solvent. 

 IMPORTANT: To avoid spill, do not tilt the Flow Transducer during cleaning with liquid in the transducer cup. 
5. To avoid damage to the device, do not exceed the recommended cleaning temperatures for the different device 

components: 
Funnel Max 140°C / 284°F 
Rotating Disk Max 150°C / 302°F 
Transducer cup  Max 100°C / 212°F 
Disc Holder  Max 100°C / 212°F 
Jug 1.5L, Steel  Max 200°C / 392°F 
Jug 1L, White  Max 140°C / 284°F 
Motor Housing Max 100°C / 212°F 

Table 1: Component Cleaning - Fluid Temperatures 
6. After cleaning, rinse the components. 
7. Reassemble the flow transducer. 

 IMPORTANT:  
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• Never immerse the connector into any liquid. Always keep it dry. 
• Never remove the disk holder for cleaning. 
• Never immerse any parts of the device in liquid (motor part/housing). 

 CARING FOR THE UPP PULLER 
 
The UPP puller catheter guide and clamp have 
been designed so that they may be quickly 
disconnected, cleaned, and reprocessed to prevent 
cross contamination. Follow the instructions in this 
section to disassemble and reassemble the UPP 
parts for cleaning, disinfection, or sterilization. 
 

 IMPORTANT: It is extremely important to 
sterilize the Catheter Guide of the UPP puller. 
Failure to do so may result in cross-contamination if 
a new catheter contacts an unsterilized Catheter 
Guide and is used on a patient during testing. 
 

 
Figure 4: Disconnected Catheter Guide 

 

 WARNING:  
Procedures That Will Damage the UPP Unit and Void the Warranty 

• Autoclaving is not permitted. It will warp or destroy any other device or component. 
• Do not immerse any connectors into any liquid. Always keep them dry. 
• Do not use solvent or abrasive cleaning agents. 
• Make sure that liquids do not enter the motor through apertures in the enclosure. 
• Do not use Chlorine Bleach, Ammonia, Acetone, Methanol, Denatured ethyl alcohol, Mineral oil, or Iodine. 
• The maximum service temperature is 100°C (212°F). 

 

2.5.1 CLEANING AND DISINFECTION OF THE MOBILE CLAMP 
After each procedure release the Mobile Clamp from the UPP and complete disinfection procedure.  

 HIGH-LEVEL DISINFECTION REAGENTS 
The UPP components can be high-level disinfected using any of the approved high-level disinfectant solutions as per 
label instructions.  
 
When selecting a high-level disinfectant, investigate the full properties and regulations. Strictly adhere to the instructions 
on the label. 
 
The following disinfectants can be used: 

• Aldehydes (Cidex®) 
• Corsoline® 
• Sporicidin® 
• Chlorates (DiversolBX®) 
• Sani-Cloth Plus or equivalent 
• Dilute Bleach wipes – do not soak 
• Alcohol is nearly inactive against certain organisms. 70% Isopropyl Alcohol cleaners may be used on the devices; 

however, higher level cleaners are recommended. 
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 RELEASING THE MOBILE CLAMP  
 

1. Click the UPP Return button then click the 
UPP Stop button. (Repeat this action until 
the mobile clamp is fully released from the 
motor body.) 

2. Click the UPP Stop button to stop the 
motor. 

3. Slide the mobile clamp down towards the 
catheter guide (Figure 5). 

 

 
Figure 5: Mobile clamp moving toward catheter guide 

 
4. Once the mobile clamp is flush to the 

catheter guide, twist the mobile clamp 
downwards (Figure 6). 

 
Figure 6: Mobile clamp downwards 

 
5. Slide the mobile clamp completely off the 

nose tube. (Figure 7) 
6. Clean and disinfect the mobile clamp. 
7. Thoroughly rinse and dry the clamp. 

 

 
Figure 7: Mobile clamp off nose tube 
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2.5.2 STERILIZATION OF THE CATHETER GUIDE  
Follow the instructions provided to remove and sterilize the catheter guide. 

 STERILIZATION REAGENTS AND PROCESSES  

NOTE: Components must be disassembled before sterilization. 
 
The UPP puller components are compatible with the following sterilization processes: 

• ETO 
• Gas Plasma 
• Peracetic Acid 
• Instrument detergent or enzymatic instrument detergent 
• Suggested Cleaning Solutions*: 

o KLENZYME (STERIS Corporation 1‐800‐548‐4873) 
o ENDOZYME (The Ruhof Corp. 1‐800‐537‐8463) 

Follow the manufacturer’s instructions. 
*Reference to any specific brand name is not an endorsement of their efficacy. 
 

 REMOVE AND STERILIZE THE CATHETER GUIDE  
 

1. Grasp the rounded section of the catheter 
guide with your thumb and forefinger as 
shown in Figure 8.    

 

 
Figure 8: Catheter Guide Removal - Step 1 

2. Pull the Catheter Guide out. 
3. Sterilize the Catheter Guide using the 

recommended solutions. 
4. Put the Catheter Guide back by pushing it 

into the nose tube. 

NOTE: The tip has a silver ball that allows you to 
snap the Catheter Guide back into place and keep it 
at the correct position. 

 
Figure 9: Catheter Guide Removal - Step 2 
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 UPP REASSEMBLY 

To Reattach the Catheter Guide: 
Push the Catheter Guide back into the nose tube.  The tip has a silver ball that allows you to snap the Catheter Guide back 
into place and keep it at the correct position. 

To Reattach the Mobile Clamp: 
1. Slide the mobile clamp onto the nose tube with the clamp facing downward (Figure 7). 
2. Once passed the catheter guide, twist the mobile clamp upward. 
3. Observe as the mobile clamp begins to move by itself up towards the motor body. The magnet on the end of the 

nose tube senses the approach of the mobile clamp and will place it back into the opening.  It will stop moving by 
itself. 

4. Click UPP Pull to ensure that the mobile clamp is securely in place. 
5. Click UPP Stop. 
6. Click UPP Return. 

 

 CARING FOR THE AIR-CHARGED TRANSDUCER/CABLE 
The risk of patient to patient cross-contamination with sterile, single-use air-charged catheters using sterile technique is 
negligible. However, any procedure in high-risk settings with body fluids and skin-to-skin contact increases the risk of 
contamination of non-disposable components. 
 
The following is recommended after each patient use: 
• Air-charged catheters are single patient use only. Discard after use. 
• Replace the tethered protective cap to the transducer housing via Luer Lock to protect the transducer. 
• Spray or wet-wipe the transducer/cable with a hospital-grade, broad-spectrum disinfectant that covers standard 

potential pathogens as well as HIV, HBV, HCV, VRE, MRSA, MRSE, Pseudomonas and Mycobacterium. 
• Wipe the transducer/cable until dry. 

 
Refer to the General Cleaning and Preventive Maintenance section on page 5 for cleaning instructions for pressure 
transducers. 
 

 BATTERY - CHARGING AND PREVENTIVE MAINTENANCE 
 

 IMPORTANT! For proper and safe charging, use only USB cables provided by LABORIE. 

2.7.1 CHARGING THE BATTERY 

Urocap™ V:  
Place the Urocap™ V on the charging bay/docking station on the cart or plug 
one end of the USB cable into the device and the other end into the medical 
grade power supply provided by LABORIE. This power supply can be plugged 
into a wall outlet; the Urocap™ V should be placed on the provided spacer to 
ensure it rests parallel to or flat against the ground.  
 
It will take approximately 7.5 hours to fully charge the device (when not in use).  
When the Urocap™ V is sampling, it will take 9 hours for the device to fully charge.  
 

NOTE: LABORIE recommends having the device plugged in or have at least 
40% battery charge before the start of a test. 

 
Figure 10: Urocap™ V Charging 

Spacer 
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Roam™ DX:  
Place the Roam™ DX on the charging bay/docking station on the cart. Make sure 
it clicks into place to ensure a proper connection (a beeping sound signifies it is 
fully connected). It will take approximately 7.5 hours to fully charge the device 
(when not in use).  
When the Roam™ DX is sampling, it will take 10.5 hours for the device to be fully 
charged.  
When the LED light on the device is green it is fully charged. 
 

NOTE: LABORIE recommends having the device plugged in or have at least 
40% battery charge before the start of a test. 

  
Figure 11: Roam™ DX Charging 

Bay 

UPP: 
Plug the USB cable from the UPP stand into the front USB port under the central 
pump hub to charge the UPP.  It will take approximately 7.5 hours to charge (about 
9 hours if sampling).  
It is recommended to plug the UPP in at the end of every day to ensure a full 
charge for testing. 
 

NOTE: LABORIE recommends having the device plugged in or have at least 
40% battery charge before the start of a test. The equipment can still be used 
during battery charge time.  

 
Figure 12: UPP 

 

 

2.7.2 BATTERY PREVENTIVE MAINTENANCE 
• Do not step on, drop, drop in water, or puncture the battery. If misuse, abuse, or damage is suspected, or any 

form of mechanical damage to the casing is visible, then discontinue use and return the battery to LABORIE. 
• If a sudden change in the battery’s ability to hold a charge or a sudden change in battery lifetime is noticed, 

discontinue use and return the battery to LABORIE. 
• It is recommended to charge all device batteries overnight to ensure proper function. Once the battery level 

drops to 40% charge, it is best to start recharging. 
 

 COMPUTER VIRUS PROTECTION 
All computers purchased from LABORIE are virus-free before shipment and are installed with an antivirus program. It is the 
customer’s responsibility to correctly use and maintain the anti-virus program to prevent virus problems.  LABORIE is not 
responsible for any virus-related computer problems after point of delivery to the customer. 
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 TREATING AND DISPOSING OF PRODUCT AFTER USE 
• After use, discard the contaminated, plastic, single-use disposables and any packaging according to your 

institution’s standard operating procedures on medical waste handling. 
• For end of life product, waste electrical and electronic equipment should be collected separately and 

returned to the designated local recycling service. 
• For end of battery life, disposal must be handled according to local regulations. 
• Packaging waste should be collected separately for available national packaging collection and recycling 

services. 
 

 ENVIRONMENTAL CONSIDERATION OF WASTE DISPOSAL 
It is important to dispose of waste (such as urine) properly to prevent environmental pollution. The waste should be disposed 
of in such a way that will not pollute the fresh water supply system — especially the drinking water system. Normally, this is 
not an issue in areas that have proper sewage systems with water treatment procedures. In this case, the most convenient 
way is to use these sewage systems. 
 

 PREVENTIVE MAINTENANCE – CHECKING CALIBRATION 
Performing regular maintenance will reduce the need for repairs. As a step in maintaining optimal system 
performance check the calibration every 6 months or whenever you suspect the transducers are off calibration. 
 
If the Uroflowmeter, the pump, the EMG, the UPP puller, the pressure transducers, and/or the infusion transducer are giving 
incorrect readings, try the following checkups before attempting to calibrate the system. 
 

2.11.1 CHECK THE FLOW AND VOLUME OF THE UROCAP™ V UROFLOWMETER 
Check Volume 

1. Open the AQUARIUS® software and start a sample Uroflow test. 
2. Put an empty beaker on the Uroflow transducer. 
3. Select Set Zeroes! 
4. Remove the empty beaker. 
5. Fill a beaker with 500cc of water and place it on the Uroflowmeter. 

The volume channel should display a volume of 500ml (+/- 5 ml). If the reading is above or below the 5ml threshold, then 
calibration is required. Once calibration is complete perform a re-check by following the instructions provided above.  
Contact LABORIE service for assistance if problems continue after the calibration and re-check. 

Check Flow 
1. Open the AQUARIUS® software and start a sample Uroflow test. 
2. Put an empty beaker on the Uroflow transducer. 
3. Select Set Zeroes! 
4. Fill another beaker with 500cc of water. 
5. Slowly and steadily pour the water from the filled beaker into the empty beaker. Try to keep the rate between 25 

to 50 ml/second. 
The volume channel should display a volume of 500ml (+/- 5 ml). If the reading is above or below the 5ml threshold, then 
calibration is required. Once calibration is complete perform a re-check by following the instructions provided above. 
Contact LABORIE service for assistance if problems continue after the calibration and re-check. 

2.11.2 CHECK THE PUMP 
Some reminders before pump check-up: 

• If contrast is used for testing procedures, it should also be used for check-up and calibration procedures. 
• Use only LABORIE recommended and approved tubing for accurate readings and measurements. 
 

1. Prime the pump tubing. 
2. Connect the pump tubing to a catheter and angle into an empty beaker.  
3. Open the AQUARIUS® software and start a sample test. 
4. Fill to a volume of 150 cc and stop the test. 
5. Measure the volume.   
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The volume channel should match the pump fill volume (+/- 10 ml). If the reading is above or below the 10ml threshold, 
then calibration is required. Once calibration is complete, perform a re-check by following the instructions provided 
above. Contact LABORIE service for assistance if problems continue after the calibration and re-check. 
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2.11.3 CHECK THE ROAM™ DX 
    CHECK EMG 

 IMPORTANT: EMG leads tend to expire after six months of use; it is recommended that they be replaced every six 
months. 

 
1. Open the AQUARIUS® software and start a sample 

test with an EMG channel. 
2. Place two EMG electrodes, 1 inch apart, on your 

forearm (where the muscle flexes the most) and the 
third EMG patch on your elbow. 

3. Keep your arm relaxed, palm open, and down to your 
side. You will notice minimal EMG activity. 

      
relaxed 

4. Keep your palm open and lift your arm slightly (at a 
45-degree angle) and hold the position to keep it at a 
constant rate. You will notice an increase in activity on 
the EMG channel. 

 
at 50% strain 

5. Keep palm open and lift your arm further up until it is 
parallel to the floor. You will notice more activity on 
the EMG channel. 

 
at 100% strain 

6. Keeping your arm in the parallel position, clench your 
fist. You will see an increase in EMG activity on the 
EMG channel. 

7. Unclench your fist and return to the relaxed position. 
8. Check the EMG channel for activity.  

 
at 100% strain with full contraction 

Table 2: EMG Calibration Check 
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A sample reading can be seen here: 
 

 
Figure 13: EMG Chanel During Check 

 
If the EMG channel does not display any activity, then calibration is required. Once calibration is complete perform a re-
check by following the instructions provided above. Contact LABORIE service for assistance if problems continue after 
the calibration and re-check. 

   CHECK THE PRESSURE TRANSDUCER USING T-DOC™ 
 

1. Switch the charger on the T-DOC to the OPEN position. 
2. Connect the catheter to the charger and gently squeeze the balloon on the catheter to expel any air in the 

balloon. 
3. Switch the charger to the CHARGE position. 
4. Fill a standard graduated beaker with 1000ml of water. 
5. Open the AQUARIUS® software and start a sample test with pressure channels. 
6. Click Set Zeroes. 
7. Dip the catheter into the beaker until the balloon on the catheter sits just below the water line. The pressure 

channel should read between 0 and 1 cmH2O. 
8. Carefully lower the catheter into the beaker until the tip gently touches the bottom of the beaker. Do not touch 

the sides of the beaker. 
9. Hold the catheter in a steady position and wait for a reading on the pressure channel. 

 
The pressure channel should display a reading of 15 cmH2O (+/- 2 cmH2O). If the reading is above or below the 2 cmH2O 
threshold, then calibration is required. Once calibration is complete perform a re-check by following the instructions 
provided above. Contact LABORIE service for assistance if problems continue after the calibration and re-check. 

 CHECK THE PRESSURE TRANSDUCER USING WATER CATHETERS 
1. Setup the water transducers as described in the Pressure Transducer Setup for Fluid-based Consumables section 

on page 25.  
2. Connect the measurement tubing to the pressure channel of a water catheter, then prime the pressure channel. 
3. Open the UDS120 software and start a sample test with pressure channels. 
4. Align the catheter pressure hole with the center of transducer dome, Click Set Zeroes. 
5. Raise the pressure hole of the catheter 15 cm above the center of transducer dome.  Hold the catheter in a steady 

position and wait for a reading on the pressure channel. 
 
The pressure channel should display a reading of 15 cmH2O (+/- 2 cmH2O). If the reading is above or below the 2 cmH2O 
threshold, then calibration is required. Once calibration is complete perform a re-check by following the instructions 
provided above. Contact LABORIE service for assistance if problems continue after the calibration and re-check. 
 

relaxed 50% strain 100% 
 

contraction relaxed 
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2.11.4 CHECK THE INFUSION TRANSDUCER 
Ensure the saline bag does not touch any other mechanical component of the system (such as transducers, etc.) during the 
calibration check. 

  CHECK THE INFUSION TRANSDUCER USING THE UROFLOWMETER 
Ensure the Uroflowmeter is checked and calibrated before checking the infusion transducer. To check the Uroflowmeter, 
refer to the Check the Flow and Volume of the Urocap™ V Uroflowmeter section on page 12.   
 

1. Place a full infusion bag on the infusion transducer. 
2. Place an empty beaker on the Uroflowmeter. 
3. Open the AQUARIUS® software and start a sample test with a VH2O channel. 
4. Click Set Zeroes. 
5. Infuse 1000ml into the beaker on the Uroflowmeter.  Read the volume channel to track infused volume. 

 
The volume on the channel should match the volume emptied into the beaker. If there is a strong difference (+/- 10 ml) 
between the volume from the infusion bag and that of the volume displayed on screen, then a calibration is required. Once 
calibrated, perform a re-check with the instructions provided above. Contact LABORIE service for assistance if problems 
continue after the calibration and re-check. 
 

   CHECK THE INFUSION TRANSDUCER USING AN INFUSION BAG 
1. Place a full infusion bag, with a declared volume of 1000ml at maximum, on the infusion transducer. 
2. Open the UDS120 Goby™ software and start a sample test. 
3. Click Set Zeroes. 
4. Remove bag and replace with an empty infusion bag. 
5. Read the volume channel. 

 
If there is a strong difference on the channel volume compared to the declared weight of the infusion bag, +/- 10ml, then 
calibration is required.  Once calibrated, perform a re-check with the instructions provided above.  Contact LABORIE 
service for assistance if problems continue after the calibration and re-check. 
 

2.11.5 CHECK THE UPP PULLER 
1. With a pencil, mark two points 50mm apart along the UPP puller shaft. 
2. Open the AQUARIUS® software and start a sample UPP test. 
3. Move the UPP to the distal (furthest) marker on the puller shaft. 
4. Start a timer and then run the puller and measure the time it takes for the UPP puller to move to the proximal 

(closer) mark on the puller shaft. 
 
The puller should stop at the proximal (closer) mark after 50 seconds (+/- 3 seconds). If the UPP puller does not move to the 
proximal mark in the required range of time, then calibration is required. Once calibration is complete perform a re-
check by following the instructions provided above. Contact LABORIE service for assistance if problems continue after 
the calibration and re-check. 
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 SAFELY MOVING THE CART 
1. Before moving the cart, always make sure that all system components are disconnected from the main power 

source. 
2. The cart should be in transport position before moving. Transport position consists of the following items: 

• All caster wheels should be unlocked. 
• Secure all loose parts and accessories. 
• Do not move the cart while connected to the main power source. 
• Do not move the cart while connected to separate accessories (furniture, etc.). 
• Monitors should be swiveled for maximum clearance when passing through doorways.  
• All drawers and doors should be closed and secure (if applicable). 
• All cables and tubes should be organized and contained to prevent trip hazards. 

3. Maneuver the cart by grasping the cutout area on the keyboard tray. If there is no cutout, apply force horizontally 
to the highest tray with two hands. 

4. Do not push the cart. Pull the cart as shown in Figure 14 . 

 
Figure 14: Safe movement of cart 

 
5. Do not move the cart faster than average walking speed (1.4 m/s or 4.6 ft. /s). 
6. Do not go over obstacles higher than 10 mm or 0.4 inches. 

 CAUTION: To prevent any risk of damage to the cart: 
• Do not lean on trays, accessories, monitors, main tower, or spine of any carts. 
• Monitor should be free of any obstacles. Do not hang anything on the monitor.  Do not suspend extra weight 

from the monitors. 
• Maximum weight on the work trays should not exceed more than 22 lbs. (10 kg). 
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3 SOFTWARE AND EQUIPMENT SETUP 
 SOFTWARE INSTALLATION 

The AQUARIUS® software is installed prior to shipping. Only install the software if it has been accidentally uninstalled or if 
an upgrade is required. Installation instructions are available in the Software Installation Guide located in the LABORIE 
software disc. 

NOTE: Some software features may be optional.  Check with your LABORIE representative for details.  

 IMPORTANT: Do not upgrade any Microsoft Windows® 7 PC/laptop to Microsoft Windows® 10 OS as UDS systems 
and software provided by LABORIE are tested as a complete package and will not work correctly after such an update.  
Please contact your LABORIE support representative for more information. 

 STANDARD EQUIPMENT AND OPTIONAL ACCESSORIES 
The AQUARIUS® is available in four models each with a Central Hub Computer (CHC) that houses the pump, connection 
ports for cables, and more.  Verify that all ordered equipment and accessories have been received. Please contact LABORIE 
if there are any discrepancies between ordered and received equipment. Inspect the equipment for any visible signs of 
damage or mishandling. Notify the carrier immediately if damage is found.  
 

NOTE: Save carrying cases and cartons to provide a convenient and safe way to return the equipment should service 
be required. 
 
Refer to Table 3 for an overview of modules and parts available in each configuration: 
 

AQUARIUS® LT AQUARIUS® CT 

o Laptop 
o Keyboard/worksurface shelf 
o 1 Roam™ DX (maximum) 
o AQUARIUS Central Hub Computer (CHC) 
o 1 Charging Bay for Roam™ DX 
o Infusion transducer holder with drip cup (optional) 
o Pump - 4 roller 
o LIT (Isolation Transformer) 
o Uroflowmeter (Urocap™ V or Spinning Disk Flow 

Transducer) (separate charging plug supplied) 
o UPP Puller with Bracket or Stand (optional) 
o Sensor Array Extension Mount (optional) 
o Printer Shelf and Color Printer (optional) 

 

o All In One (AIO) PC 
o Keyboard/worksurface shelf 
o 2 Roam™ DX 
o AQUARIUS Central Hub Computer (CHC) 
o 2 Charging Bays for Roam™ DX 
o Infusion transducer holder with drip cup(optional) 
o Pump – 4 roller 
o LIT (Isolation Transformer) 
o Uroflowmeter (Urocap™ V or Spinning Disk Flow Transducer) 

(up to 2; separate charging plug supplied) 
o UPP Puller with Bracket or Stand (optional) 
o Sensor Array Extension Mount (optional) 
o Video (optional) 
o Printer Shelf and Color Printer (optional) 

AQUARIUS® XT AQUARIUS® CTS 

o All In One (AIO) PC 
o 2nd Monitor 
o AQUARIUS Tower and AQUARIUS Computer Workstation 
o Keyboard/worksurface shelf 
o 2 Roam™ DX 
o AQUARIUS Central Hub Computer (CHC) 
o 2 Charging Bays for Roam™ DX 
o Infusion transducer holder with drip cup (Optional) 
o Pump – 4 Roller 
o 2 LIT – one for workstation and one for tower (Isolation 

Transformers 
o Uroflowmeter (Urocap™ V or Spinning Disk Flow 

Transducer) (up to 2; separate charging plug supplied) 
o UPP Puller with Bracket or Stand (optional) 
o Sensor Array Extension Mount (optional) 
o Video (optional) 
o Printer Shelf and Color Printer (optional) 

o All In One (AIO) PC 
o Keyboard/worksurface shelf 
o 2 Roam™ DX 
o AQUARIUS Central Hub Computer (CHC) 
o 2 Charging Bays for Roam™ DX 
o Pump – 4 roller 
o LIT 
o Uroflowmeter (Urocap™ V or Spinning Disk Flow Transducer) 

(up to 2; separate charging plug supplied) 
o Wireless Color Printer 
o Infusion transducer holder with drip cup(optional) 
o UPP Puller with Bracket or Stand (optional) 
o Sensor Array Extension Mount (optional) 
o Video (optional) 
 

 
 

Table 3: AQUARIUS® System Configurations 
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 EQUIPMENT SETUP 
3.3.1 CART SETUP 
LABORIE recommends to setup the AQUARIUS® cart as follows: 
 

 Open shipping box. 

 For carts with shelves, lift and align shelf 
with screws and slide into position. 
Tighten screws using 1/8” hex key. 

 

 

 Place the plastic 
bottom cover on cart 
base. 

 

 Secure the power cord 
at the system base, 
located at the back of 
the cart, and connect 
the system power cable 
to an electrical outlet. 

  

 
 

AQUARIUS LT AQUARIUS CT AQUARIUS XT AQUARIUS CTS 

Table 4: Cart Setup 

 RESET BUTTON 
Use reset button to stop system.  It will stop all moving components such as the pump and UPP as well as provide a reset 
to the digital portion of the Urodynamic processor. The system is designed to automatically stop or reset when the firmware 
is unresponsive after 5 seconds. 

 LOCKABLE WHEELS SETUP 
Use the AQUARIUS® lockable wheels as follows: 
 

 IMPORTANT: Ensure all wheels are locked during testing procedures to prevent injury to the patient. 
The AQUARIUS® system is equipped with built-in locking caster wheels, 
making it a mobile unit that can be moved from room to room. This is also a 
safety feature to ensure that the unit will remain securely in place and will 
not move during tests. 
 
To lock the wheels, press down on the lever with the bottom of your foot 
(Figure 15).  To unlock, push the lever up from underneath with the top of your 
foot. 

 
Figure 15: Lockable Wheels 
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 SPINNING DISK FLOW TRANSDUCER SETUP 
LABORIE recommends the Spinning Disk Flow Transducer setup as follows: 

 

1 = Splash guard 

2 = Transducer cup 

3 = Rotating disk 

4 = Disk holder 

5 = Motor housing 

6 = Jug (1.5L steel; 1L white) 

7 = Motor cable 

8 = Connector (connect to control box on the stand) 

9 = Uroflow holder (turn the end of the holder clockwise 
to secure it tightly on to the stand) 
 

NOTE: Ensure that all cables are organized and 
contained to prevent trip hazards. 

Table 5: Spinning Disk Flow Transducer Setup 

 FLOWSTAND 
For assembly instructions see the AQUARIUS® Flowstand User Assembly Instruction booklet on the LABORIE Software 
Disc. 
 

 BUBBLE DETECTOR (OPTIONAL) 
A bubble detector is connected the Central Hub Computer (CHC) to help detect air bubbles in the pump tubing.  To set 
up the detection feature in the software, see page 180. 

 

 
 
1 = Tubing from pump placed in groove 
2 = LED light: 

Green = no air bubbles 
Red=air bubbles detected 

 

 

NOTE: To avoid errors, make sure the pump tubing is pushed securely and completely into the groove. 
 

1 

2 
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 UPP PULLER (OPTIONAL) 
The battery powered UPP Puller mounted on the cart or on the puller stand can be used when performing urethral pressure 
profile tests.  The UPP Puller consists of the Nose, the Motor Body, the Arm, and the Stand. 

 

 
Figure 16: UPP Cart Mount 

 
Figure 17: UPP stand 

 
Remember to connect the UPP to the system. For more information on connection, see How to Add a Device to the System 
on page 36. 

3.4.1 ASSEMBLE THE PULLER STAND (OPTIONAL) 
To assemble the Puller Stand (UPP1006), prepare one 6mm and one 4mm HEX L-KEY. 

 Connect the Pole Assembly to the H-Base Assembly using the provided Washer M8, Split Washer M8, and Screw 
M8.  Use the 6mm HEX L-Key to secure the screw (Figure 18).    

 Slide the Clamp Assembly into the post of the Puller Base Assembly and lock it in position with the Knob Screw 
provided.  Use a 4mm Hex L-Key to insert the Puller into the Clamp Assembly (Figure 18). 

 

                    
    Figure 18: Puller Base and Puller Stand Assembly 

Washer, M8 
Split Lock Washer, M8 
Screw Socket Head, M8 

H-Base 
Assembly 

Pole 
Assembly 

Clamp 
Assembly 

Knob Screw 

Puller Base 
Assembly  

Puller Stand Assembly  
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3.4.2 ARM AND STAND 
  
 
The adjustable arm contains the electrical 
control pad (Figure 19). The UPP’s speed 
setting is set in the UDS software program. 
The working range can be set for speeds 
varying from 0 to 3 mm/s. 

 
Figure 19: UPP Arm and Stand 

 

3.4.3 NOSE AND MOTOR BODY  
Refer to Figure 20 below for an overview of the UPP Nose and Motor Body: 

 

 
 

Figure 20: UPP Nose Unit and Motor Body 
The motor body (1) is held by a universal joint (2) so that the system can be positioned to a preferred angle.  
On the side of the universal joint is a ball-joint knob (3), which can be loosened to allow you to move and reset the nose 
unit in different directions. The power supply to the motor comes from a cable (4) extending from the adjustable arm. 
This cable is plugged into the side of the body. 
 
The catheter is held and pulled via the nose section. It is guided through the catheter guide (5) and fixed at the mobile 
clamp (6). When the drive is engaged, the catheter will be pushed or pulled along the nose tube (7). For sterilization 
purposes, both the catheter guide and the mobile clamp may be removed. 

 
 
 

4 

3 

6 

7 

5 

2 

1 
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 UROCAP™ V AND SPINNING DISK FLOW TRANSDUCER SETUP  
3.5.1 UROFLOW TRANSDUCER 
The Flow Transducer is intended to sense voiding flow. It is used together with UDS devices for assessing voiding disorders. 
 
The AQUARIUS system is compatible with the Urocap™ V and the Spinning Disk Flow Transducer.  Once the Uroflow 
Transducer of choice and its accessories are removed from their packaging, setup the Uroflow Transducer, the chair, and 
the beaker. The Bluetooth technology built into the Uroflow Transducer provides the patient with a higher degree of privacy 
during voiding. The Uroflow Transducer, beaker, commode chair, and funnel can be set up in one room while the computer 
and printer are positioned in another room collecting and printing data. 

 IMPORTANT: It is critical the beaker is well centered on the Urocap™ V.  Ensure that the beaker and the funnel are 
aligned but not touching. 
 

 Place the funnel on the plastic frame of the 
commode chair. 

 Carefully place the Uroflow transducer on the 
floor.  
a. If using a Urocap™ V, place a graduated 

beaker on top of the transducer (Figure 
21).  

b. If using a Spinning Disk Flow Transducer, 
place the metal beaker under the flow 
transducer outlet (Figure 22). 

 Place the commode chair and funnel over the 
Urocap™ V and beaker or over the Spinning 
Disk Flow Transducer.  

 
Figure 21: Urocap™ V Setup 

 
Figure 22: Spinning Disk 
Flow Transducer Setup 

 INFUSION VOLUME TRANSDUCER (OPTIONAL) 
 Ensure that the infusion transducer cable is 

connected to the Pump module. 
 Place a 1000 ml bag of sterile saline inside a 

pressure cuff. Hang the pressure cuff on the 
hook of the infusion transducer.  Use an 
infusion pressure cuff for faster flow rate 

 Inflate the pressure cuff to 300 mmHg (when 
the red line appears on the pressure cuff 
gauge). 

 Connect an infusion line with a drip chamber 
to the saline bag. 

 IMPORTANT: 
• Ensure that the infusion line is not pulled 

tight or else the transducer reading will 
not be accurate.  

• The infusion transducer is calibrated for 
up to 1000 ml of sterile saline or water. If 
using a different medium, such as 
hypaque, re-calibration is required. 

• The saline bag must not touch any other 
mechanical component of the system 
(such as transducers, etc.). 

  
 

Figure 23: Infusion Transducer Connections 

Drip Chamber 

Infusion 
Transducer 

Saline Bag 

Infusion Line 
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 PUMP SETUP 
Pump accuracy is not guaranteed if the pump tubing is used more than once.  DO NOT run pump at a speed exceeding 
the limitation of the catheter and do not run pump at a high speed with a contrast medium. 
To maintain patient safety during normal use, the pressure limit for the pump is preset to 150 cm H2O and the volume limit 
is preset to 750mL. 
 

 Hang a bag of saline solution on the IV pole hook and insert pump tubing spike into the bag. 
 Flush the line completely. 
 Use the thumbwheel to close tubing and stop the flow.  
 Open pump head. Position compressible portion of pump tubing across rollers from left to right. 
 Close pump head. 
 Open the thumbwheel on the pump tubing. 

 

 ROAM™ DX SETUP FOR PRESSURE AND EMG 
 

Roam™ DX Connections: 
Insert the EMG cable into the Roam™ DX port labeled E2.  
 
Attach the P1 cable to the port labeled “1” on the Roam™ 
DX and attach the P2 cable to the port labeled “2” and so 
on.  

 
Figure 24: Roam™ DX 

Roam™ DX Setup with a Patient: 
If placed on the patient, position the ROAM™ DX either on a waist belt, on a lanyard, or on a waist strap.  Alternatively, 
place the Roam™ DX on a nearby table/counter at level with the patient’s waist (or higher). This will help prevent any liquid 
from dripping along the cables to the Roam™ DX device when the patient voids. 

 
 

 
Figure 25: Roam Patient Setup  

 
 

Keep level with patient’s 
waist or higher 
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 CONSUMABLES AND TRANSDUCER SETUP 
3.9.1 PRESSURE TRANSDUCER SETUP FOR FLUID-BASED CONSUMABLES 
To Set-up the Fluid-Filled Pressure Transducer for a test follow the instructions below.  Refer to Figure 26 for a visual 
representation of the steps provided. 
 

1. Take each pressure cartridge out of its package.  Remove protective covers from the back and from the 
connector ends. 

2. Slide a cartridge over each transducer until it clicks in place. 
3. Attach pressure measurement tubing, with a three-way stopcock, to the lower (male) end of the pressure 

cartridge. 
4. Attach a 10 ml sterile fluid filled syringe to the side port of the stopcock. 
5. By turning the stopcock lever in appropriate directions, flush fluid from syringe through both the pressure 

cartridge and the pressure measurement tubing.  Refer to Figure 20.  

 NOTE: Be sure that the stopper cap is always securely in place whenever the stopcock position is being changed.  
Always keep transducers level with the patient’s symphysis pubis. 

 CAUTION: AIR BUBBLES must not be present in the system during testing. 

 
Figure 26: Pressure Transducer Setup 

 

3.9.2 FLUID-FILLED PRESSURE TRANSDUCER CONNECTIONS - PRIMING 
 
Do not plug in or unplug any transducers when a procedure is running. Always stop the procedure before plugging in or 
unplugging transducers.  Follow the instructions provided to prime the transducer, pressure measurement tubing, and 
catheter: 
 

  Attach a 3-way stopcock with pressure measurement tubing to the bottom (male) connector of the pressure 
cartridge.  Attach the opposite end of the pressure measurement tubing to the catheter.  For TUB101 connect a 
3-way stopcock to the tubing before linking to the pressure cartridge. 

 Attach a 3-way stopcock with pressure measurement tubing to the bottom (male) connector of the pressure 
cartridge.  Attach the opposite end of the pressure measurement tubing to the catheter.  For TUB101 connect a 
3-way stopcock to the tubing before linking to the pressure cartridge. 

 Attach a syringe filled with water or saline to the stopcock. 
 Turn the stopcock “OFF” to the catheter (See Figure 27, Option B). 
 Remove the Luer lock plug from the top (female) connector of the pressure cartridge.  Fill the pressure cartridge 

with water. Reattach the Luer lock plug. 
 Turn the stopcock “OFF” towards the Luer lock plug (See Figure 27, Option D).  
 Prime the pressure measurement tubing and the catheter. 
 Turn the stopcock “OFF” towards the syringe for pressure recording (See Figure 27, Option A). 

Syringe 

Luer Lock Plug 

Pressure 
Cartridge 

MEDEX Transducer 

Measurement Tubing 
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Each option in Figure 27 indicates a stopcock position; arrows indicate lumens open to flow based on stopcock position 
while squared off arrows indicate off position.   

 
Figure 27: Stopcock Flow Directions 

 

3.9.3 CATHETER SETUP 
The following section is a reference guide to catheter setup and connection.  
 
Ensure that only single-, dual-, and triple-lumen catheters supplied by LABORIE are used for Urodynamic tests involving the 
UDS System.  
 

 

Do NOT use Foley catheters, as these catheters are not designed for pressure measurement, bladder infusion, 
or pressure recording.  Do NOT use catheters on patients that suffer from bladder infections or strictures in the 
urethra. 

3.9.4 FLUID-FILLED CATHETER SETUP  
 BLADDER CATHETER SETUP 

Use a dual-lumen catheter to record bladder pressures: 
 Connect the infusion line to the bladder filling port of the catheter. 
 Connect the P1 measurement tubing to the vesical port of the catheter. 

Use a triple-lumen catheter to simultaneously record urethral pressure and bladder pressures:  
 Connect the infusion line to the bladder filling port of the catheter. 
 Connect the P1 measurement tubing to the vesical port of the catheter. 
 Connect the P3 measurement tubing to the urethral port of the catheter. 

 

 TWO CATHETER TECHNIQUE 
To perform a Micturition test during which the patient will void with a vesical catheter in place, use two separate catheters: 
one narrow/small catheter for pressure measurement and a second for infusion only.    

 
At the end of the filling portion of the study, the catheter used for infusion should be taken out and the catheter used for 
pressure measurement left in so that bladder pressure can be measured during voiding. 

To Catheter 

To Transducer 
Cartridge 

Off to Syringe 
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 ABDOMINAL (RECTAL) BALLOON CATHETERS 
Abdominal balloon catheters are used to measure abdominal pressure.  Before connecting the balloon catheter  to the 
measurement tubing, the balloon should be primed and be free of any air bubbles. 
 

To prime a single-lumen catheter so it is free from air bubbles: 
 Fill a 20 cc syringe with 10 cc of sterile fluid. 
 Connect the syringe to the balloon catheter. 
 Hold the catheter vertically, in a “U” shape, with both ends facing 

up. 
 Draw back on the syringe to remove air from the rectal balloon. 
 Push on the syringe until the balloon fills with water. 
 Repeat Steps 4 and 5 until all air bubbles are removed from the 

balloon and the balloon is full of water. 
 Draw back on the syringe to deflate the balloon for insertion. 
 Depress the Syringe plundger to infuse water back into the 

catheter.  Remove the syringe. 
 Connect the primed measurement tubing to the balloon catheter. 

 
To prime a double-lumen catheter so it is free from air bubbles: 

 Connect the syringe to the longer port. 
 Open the venting port (the shorter port.) 
 Flush the catheter until there are no air bubbles in the balloon. 
 Cap the exhaust port. 
 Draw back on the syringe to deflate the balloon. 
 Clamp the end of the catheter that is to be connected to the 

measurement tubing. 
 Remove the syringe. 
 Connect the primed measurement tubing to the balloon catheter 

 

 
 

Figure 28: Abdominal Single-
Lumen Balloon Catheter Priming 

 

 

 

To Insert a Single or Dual-Lumen Balloon Catheter: 
 

 Attach a syringe to the stopcock. 
 Insert the rectal balloon into the 

patient. 
 Turn the stopcock switch OFF to the 

transducer cartridge (A). 
 Fill the balloon with 1.5-3 cc’s of water. 
 Turn the stopcock switch OFF to the 

syringe (B). 

 
Figure 29: OFF to the Transducer 

Cartridge             

  
Figure 30: OFF to the Syringe 
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3.9.5 T-DOC AIR-CHARGED CATHETER SETUP 
Follow the instructions provided to setup T-DOC Air-Charged Catheters and Transducers: 

1. Ensure Transducer Cables are connected to the machine.  Check that the charger is in the OPEN position. 
2. Remove the protective cap from the pressure line and connect it to the matching Transducer Cable.  Repeat for 

all pressure lines.  Secure each connection by twisting the luer lock another ¼ turn. 
3. Zero all catheters using the Set Zeros button in the software. 
4. For each pressure transducer verify charging pressure by completing the following: 

a. Squeeze the associated balloon through the packaging to reduce the volume of residual air (use 
fingertips – not nails).   

b. Move the associated transducer slider to the charge position while still applying pressure. 
c. Remove fingertips and check reading.  If pressure is ≤5 cm H2O, return the transducer slider to OPEN.  If 

the pressure is >5 cm H2O, move the slider to OPEN and repeat. 
5. Remove the catheter from the packaging by holding the catheter just below the Y-junction. 
6. Coat the distal end of the catheter with a sterile, water-based lubricant and insert into the patient. 
7. Tape the catheters as close to the insertion site as possible. 
8. Ask the patient to cough to remove residual air from the balloon.   
9. Slide the transducer to the CHARGE position.  Remove tape and position urethral sensor at the desired point in 

the urethra, often at the highest-pressure area. 
10. Connect the vesical catheter to the pump tubing.   

NOTE: Ensure bladder and rectal pressures are within normal values.  Have the patient cough and ensure the detrusor 
pressure (Pdet) is equal to zero and that both Pabd and Pves pressures are reacting appropriately.  If Pabd is higher than 
Pves, reposition the Pabd catheter. Click the Equalize button on the UDS120 control panel. 

11. Continue with the testing procedure when ready. 
 

 IMPORTANT: Do not plug in or unplug any transducers when a procedure is running. Always stop the procedure 
before plugging in or unplugging transducers.  Ensure to consult Instructions for Use available with product. 
 

3.9.6 EMG SETUP 
Before the start of an EMG test: 

 The electrodes should be connected to the 3 EMG leads 

 The patient’s anal area should be clean, dry, and free of hair. 

Once the patient’s skin is properly prepared, the electrodes 
may be applied.  

• Place two electrodes peri-anally at the 10 o’clock 
and 2 o’clock position (or the 9 o’clock and 3 
o’clock position), as close to the anal verge as 
possible and placed opposite each other.  

• Place the third electrode on a bony prominence 
(such as the knee) or on a fatty portion of the inner 
thigh. 

 IMPORTANT: Ensure the electrodes are placed as close 
to the anal sphincter as possible or the EMG activity will be 
weak. 

 

 
 

Figure 31: EMG Patch Placement.  

NOTE: LABORIE recommends that each electrode be secured in place with an additional piece of surgical tape. If the 
electrodes detach, dry the skin and apply new surgical tape. 
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4 EQUIPMENT STATUS AND LIGHT SIGNALS 
 PUMP HUB 

1 = Bluetooth Status indicator:  
• blue= connected 
• green= system at work but not connected 
• orange = System fault 
• light off = not connected 
 

2 = Equipment Status Indicator: 
• green = connected 
• blinking green = connected and sampling 
• orange = System fault 
• blinking orange = not connected 
• light off = system off 
 

3 = Stop button: 
• Press to stop pump 
• Press and hold for 5 seconds to reset  

 
Figure 32: Pump Buttons and Indicators 

 

1 = Infusion Transducer Connection:  
Plug the infusion transducer cable into the port(s). 

 
2 = USB port:  

Connect the USB cable from the UPP or the Urocap™ V into 
the port. 

 
3 = BDT:  

Plug the cable from the bubble detector into this port. 
 

 
Figure 33: Pump Connections 
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 ROAM™ DX 
 
Refer to Figure 34 for identification of buttons and indicators 
available on the Roam™ DX. 
 

1 = Toggle keys to move from screen to screen or setting 
to setting 
 
2 = Start and stop buttons/ on-off power button 
(OK/Stop) 
 
3 = Battery and Bluetooth status 
 
4 = Message screen 

 
For more information on the buttons and indicators 
described refer to Table 6. 
 

 
Figure 34: Roam DX Buttons and Indicators 

 

Toggle Keys (1): 

Normal mode = Moving from one screen to another. 
Changing settings mode (see screen descriptions on following pages) = Moving from one line to 
another. 
 

 

Changing settings mode (see screen descriptions on following pages) = Increase/decrease selected 
value or scroll through options. 

 

Start/Stop/OK (2): 

Manual wake-up from hibernation. 
Press for 5 seconds to enter changing settings mode. 
Single push = Exit from changing settings mode.  

Press for 5 seconds to force device to hibernation mode. 
Single push = Exit from Changing Settings mode. 

 

Battery and Bluetooth Status (3): 

Solid green = External power connected; battery fully charged. 
Solid green and orange = External power connected; battery is charging. 
Solid orange (no display, no response to keyboard) = External power connected; battery is 
charging but battery level is still below critical. Just wait till battery is pre-charged. 
Blinking green = No external power. Battery is OK. 
Blinking orange = No external power. Battery is low. Connect external power immediately. 

 

OFF = Bluetooth channel is disconnected. 
ON = Bluetooth channel is connected. Every transmitted block forces this LED to blink. 
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Message Screens (4): 

Pressure sensor port status (P1, P2, P3, etc…) 
• If a field is empty, no function has been selected for this port (see Set up/Modify on page 65). 
• E means EMG is selected for this port. 
• Scroll bar displays current level of pressure signal. 
• “Stars” display the last calibration levels of this port: bottom for low level and top for high level. If both Stars 

are aligned at the border to the right, the port has not yet been calibrated. 
• Stars are blinking when device is sending EMG and pressure samples to UDS. 

Port connection (USB or Bluetooth) 
• PC Bond = Check mark indicates that device is currently bonded to UDS. This icon is blinking when device is 

sending EMG and pressure samples to UDS 
• BT = Bluetooth Address 
• Battery = Displays current battery voltage (4.2 – full; 3.6 – empty) and charger status: Battery Full, Charging or 

Battery Powered (no external power) 

System Information 
• Unit = Roam™ serial number 
• Ver = Firmware version 

Table 6: Functions of Roam Buttons and Indicators. 

 UROCAP™ V 
The Urocap™ V LED indicators are described below.  Refer to Figure 35 for the location of the LED Indicators on the 
device. 

BT (Bluetooth)   
blue = connected 
green = system at work but not connected 
orange = system fault 
light off = not connected 

Equipment status  
green = connected 
blinking green = connected and sampling 
orange = System fault 
blinking orange = not connected 
light off = system off  

Power  
green = battery full and plugged into charger 
blinking green= battery good 
orange = charger plugged and battery charging; battery not fully charged 
blinking orange = low battery; time to re-charge 
light off = battery empty; re-charge 

 
Figure 35: Front of Urocap™ V 

The Urocap™ V buttons are described below.  Refer to Figure 36 for the location of buttons on the device. 

 ON button = use to “wake up” Uroflowmeter 
 
 Reset button = Press and hold for 5 seconds or longer to bring 
to sleep  

Figure 36: Bottom of Urocap™ V 
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 UPP 
The control pad on the UPP arm has buttons and indictors for use during a study as described below.  Refer to Figure 37  
for the location of buttons and indicators on the device. 
 

1 = Arrows (up and down):  
• Press UP to pull the arm 
• Press DOWN return the arm 

2 = UPP Stop button: 
• Press to stop UPP 
• Press and hold for 5 seconds or longer to bring to sleep 

3 = Battery Status Indicator: 
• green = battery full and plugged into charger 
• blinking green = battery good 
• orange = charger plugged and battery charging; battery not 

fully charged 
• blinking orange = low battery; time to charge 
• light off = battery empty; re-charge 

4 = Bluetooth Status Indicator: 
• blue = connected 
• green = system at work but not connected 
• orange = System fault 
• light off =  not connected 

5 = Equipment Status Indicator: 
• green = connected 
• blinking green = connected and sampling 
• orange = System fault 
• blinking orange = not connected 
• light off = system off 

 
 Figure 37: UPP Buttons and 

Indicators 

NOTE: Closely monitor the battery level of the UPP when in use. 

 WIRELESS PRINTER SETUP 
4.5.1 BEFORE YOU BEGIN 
Ensure the following: 

• The wireless network is set up and working properly. 
• The printer and the computers that use the printer are on the same network (subnet). 

 
While connecting the printer, you might be prompted to enter the wireless network name (SSID) and a wireless password. 

• The wireless network name is the name of your wireless network. 
• The wireless password prevents other people from connecting to your wireless network without your 

permission. Depending on the level of security required, your wireless network might use either a WPA 
passphrase or WEP key. 

 
If you have not changed the network name or the security passkey since setting up your wireless network, you can sometimes 
find them on the back or side of the wireless router.  If you cannot find the network name or the security password or cannot 
remember this information, see the documentation provided with your computer or with the wireless router. If you still 
cannot find this information, contact your network administrator or the person who set up the wireless network. 

4.5.2 SET UP THE PRINTER ON YOUR WIRELESS NETWORK 
To set up the printer on your wireless network use the Wireless Setup Wizard from the printer control panel to set up wireless 
communication. 

 On the printer control panel, from the Home screen, touch  (Wireless). 
 Touch  (Settings). 
 Touch Wireless Setup Wizard or Wi-Fi Protected Setup. 
 Follow the display instructions to complete the setup. 
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If you are already using the printer with a different type of connection, such as a USB connection, follow the instructions in 
the To Change Connection Method section on page 33 to set up the printer on your wireless network. 

4.5.3 PRINT USING WI-FI DIRECT 
Using Wi-Fi Direct, print wirelessly from a computer, smart phone, tablet, or other wireless-capable device—without 
connecting to an existing wireless network. 

 GUIDELINES FOR USING WI-FI DIRECT 
• Ensure the computer or mobile device has the necessary software.  If using a computer, make sure you have 

installed the HP printer software.  If you have not installed the HP printer software on the computer, connect 
to Wi-Fi Direct first and then install the printer software.   Select Wireless when prompted by the printer 
software for a connection type. 

• Make sure Wi-Fi Direct for your printer is turned on. 
• Up to five computers and mobile devices can use the same Wi-Fi Direct connection. 
• Wi-Fi Direct can be used while the printer is also connected either to a computer using a USB cable or to a 

network using a wireless connection. 
• Wi-Fi Direct cannot be used to connect a computer, mobile device, or printer to the Internet. 

 TO TURN ON WI-FI DIRECT 
 On the printer control panel, from the Home screen, touch  (Wi-Fi Direct). 
 Touch  (Settings). 
 If the display shows that Wi-Fi Direct is Off, touch the toggle button next to Wi-Fi Direct to turn it On. 

 TO CHANGE CONNECTION METHOD 
 On the printer control panel display, from the Home screen, touch  (Wi-Fi Direct). 
 Touch  (Settings). 
 Touch Connection Method and then select Automatic or Manual. 

 TO PRINT FROM A WIRELESS-CAPABLE COMPUTER (WINDOWS) 
 Make sure you have turned on Wi-Fi Direct on the printer. 
 Turn on the computer's Wi-Fi connection. For more information, see the documentation provided with the 

computer. 
 From the computer, connect to a new network.  Use the process you normally use to connect to a new wireless 

network or hotspot. Choose the Wi-Fi Direct name from the list of wireless networks shown such as DIRECT-**- 
HP ENVY 5000 series (where ** are the unique characters to identify your printer).  Enter the Wi-Fi Direct password 
when prompted. 

NOTE: To obtain the Wi-Fi Direct password, touch  (Wi-Fi Direct) on the printer’s control panel in the Home Screen. 
 Proceed to step 5 if the printer has been installed and connected to the computer over a wireless network. If the 

printer has been installed and connected to your computer with a USB cable, follow the steps below to install the 
printer software using the Wi-Fi Direct connection. 

a. Open the HP printer software. For more information, see Open the HP printer software (Windows) on 
page 15. 

b. Click Tools. 
c. Click Device Setup & Software, and then select Connect a new device.  
d. When the Connection Options software screen appears, select Wireless. 
e. Select your HP printer from the detected printer list. 
f. Follow the onscreen instructions. 

 Print your document. 

4.5.4 CHANGE THE CONNECTION TYPE 
After you have installed the HP printer software and connected the printer to your computer or to a network, you can use 
the software to change the connection type (for example, from a USB connection to a wireless connection). 

 TO CHANGE FROM A USB CONNECTION TO A WIRELESS NETWORK (WINDOWS) 
 Open the HP printer software.  
 Click Tools. 
 Click Device Setup & Software. 
 Select Convert a USB connected device to wireless. Follow the onscreen instructions. 
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 TO CHANGE FROM A WIRELESS CONNECTION TO A USB CONNECTION (WINDOWS) 
Connect the printer and the computer with a USB cable. This USB port is at the rear of the printer. 
 

NOTE: A USB connection between the computer and printer can only be used if these two devices are isolated from 
the patient environment to reduce the risk of electric shock to the patient. LABORIE always recommends the use of a 
wireless connection between the computer and printer. 
 

5 USING THE MODULE TOUCHSCREEN 
 ICONS IN THE TOUCHSCREEN 

Set up device connections, perform calibration, and adjust pump controls with the AQUARIUS® tower touchscreen. 
 
Refer to Table 7 for an overview of touchscreen icons and their functions: 

1 = DEVICE IDENTIFICATION:  
Displays device type and connection status. 

 = wired connection   

 = Bluetooth connection 

 
 
 
 

 

2 = DEVICE NAME and SERIAL NUMBER. 

3 = POWER:  
Displays power on or off to device. 

4 = BATTERY:  
Displays battery charge level. 

5 = PC CONNECTION: 

 = wired PC connection   

 = wireless PC connection 

 = no PC connection; tap to turn OFF or 
restart the central hub computer. 

6 = CALIBRATION:  
Tap to open calibration procedure for each 
device.  See page 44 for more information. 

7 = PUMP CONTROLS: tap to open pump settings 
menu. 
See page 38 for more information. 

8 = SETTINGS: tap to add devices, remove 
devices, and configure connections.  
See page 32 for more information. 
9 = REMOTE CONTROL CONNECTION. 

HOME 
Tap to return to the Home (main) screen.  Only 
visible when adding devices, removing devices, 
setting up pump controls, and calibration. 

 
Table 7: Module Touchscreen Icons 

 

7  

  2   3   1 4 

  5   6   8   9 
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 SYSTEM STATUS MESSAGES 
System status messages display the current status of the device modules configured with the system. 

5.2.1 MESSAGES ON THE COMPUTER SOFTWARE 
The following symbol indicates that the System and software are connected 
and functioning: 
 

NOTE: There may be a 1 to 2-minute delay from when the software starts and 
when it establishes a connection to the system.   

 . 

 

5.2.2 MESSAGES ON THE CHC TOUCHSCREEN 
System Status messages are communicated per device on the CHC touchscreen.  Look under the device serial number for 
status information.  Table 8 below provides an overview of common system status messages: 

Bluetooth Error: 
This occurs when the Central Hub Computer (CHC) attempts 
to connect to the device module via Bluetooth but fails. The 
device may be out of range or the battery is depleted.  

USB Error: 
This occurs when the Central Hub Computer (CHC) attempts 
to connect to the device module via USB but fails. The 
device`s USB cable may not be plugged-in.  

Communication Error: 
This occurs when the Central Hub Computer (CHC) 
successfully connects via Bluetooth or USB but fails to 
communicate (Bond) with the firmware on the device 
module. Try resetting the power on the device module. 

 

Device Hibernation: 
This occurs when the Central Hub Computer (CHC) puts the 
device module into ‘Sleep’ mode. This is usually after 2 hours 
of inactivity. After 5 minutes, the LCD turns off. 
If the UDS software is running, it will put the device to sleep. 

 

Battery LOW Disconnect: 
This occurs when the device battery is very low.  The firmware 
forces a disconnection. This will not occur if the USB charger 
is plugged-in. The status message scrolls across the screen.  

Battery LOW: 
This occurs when the device battery is very low. Recharge the 
battery.  

Battery SUSP: 
This occurs when the battery reaches a temperature above 
45°C (113°F) or the power supply is not properly connected 
to the Central Hub Computer (CHC).  This status message 
appears under the battery icon.  
Disconnect the Roam™ DX from the power supply then 
reconnect. If the message still appears, contact LABORIE 
technical support. 

 

Table 8: CHC - System Status Messages 
 

NOTE: System messages can be found in the Software’s title bar. 
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 USING THE TOUCHSCREEN FUNCTIONS 
5.3.1 HOW TO ADD A DEVICE TO THE SYSTEM 
Follow the instructions below to connect any additional devices including the Urocap™ V Uroflowmeters, UPP pullers, or 
Roam™ DX.  

NOTE: Make sure the UDS software is closed when connecting devices.  Make sure to restart system after adding 
all NGM devices. 

 Tap the Settings Icon: 

. 

 Tap the Add Device option: 

. 

 Wait for the device search to complete in the 
Device Search window: 

. 

 Select the device for connection by tapping the 
search option that correlates with the serial number 
on the device:  

. 

 Tap Yes to add the device: 

. 

 A message will appear confirming addition of the 
device: 

 
 
 
 
 
 

 Repeat for any additional devices. . 

Table 9: Adding Devices 
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5.3.2 HOW TO REMOVE A DEVICE 
 

 Tap the Settings Icon: 

. 

 Tap the Remove Device option: 

. 

 Tap to select the devices to remove and then tap 
Remove: 

. 

 Repeat for any additional devices. 

Table 10: Removing Devices 
 

5.3.3 HOW TO CONNECT DEVICES 

NOTE: Before connecting devices make sure the UDS software is closed and not running and the device is not 
connected via Bluetooth. 

 Tap the Settings Icon: 

. 

 Tap the Configure Connections option: 

. 

 Slide to select the type of connection for the 
devices listed, either Bluetooth or USB: 

. 

 Tap the Home icon at top left of the screen to go 
back to the home screen: 

. 
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 The devices and their type of connections will be 
displayed: 

. 
Table 11: Connecting Devices  

5.3.4 HOW TO SET UP PUMP CONTROLS     

Control the pump speed during a UDS procedure or prime the pump to remove any bubbles from the Central Hub 
Computer (CHC).  Before starting, make sure: 

• Pump is calibrated. 

• UDS software is running and a test procedure is selected containing pressures. 

• Bubble Detector is setup for Auto Pump Stop during Priming (Optional). 

 
 
 
 

Using the Pump Controls: 

 Tap the Pump Icon: 

. 

 Tap the Play button to start the pump: 

. 

 Tap the PLUS and MINUS buttons to increase or decrease the speed as necessary. 

Prepare Pump Settings 

 Tap the Settings button on the lower right of the 
Pump screen to open the Pump Settings screen: 

. 

 In the Pump Settings screen, adjust the Bubble Detection threshold or the Volume Warning Limit for the 
pump. 

 Tap the edit box to type in the values. 

 In the Seconds edit box, enter the time (in 
seconds) to alert the pump to stop when it no 
longer detects bubbles: 

. 
Table 12: CHC - Pump Controls and Settings 
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5.3.5 CONNECT THE PC/LAPTOP TO THE SYSTEM 
An important final step when setting up device connections is the linking of the PC/laptop to the AQUARIUS system. 

NOTE: Depending on the AQUARIUS model, screens and steps mentioned in this section will be slightly different from 
what you see with your system. 
 

 On the Central Hub Computer (CHC) home 
screen, tap the Settings Icon: . 

 Scroll down to the Device Serial Number 
section.  Tap the blank field and type the 
System serial number as it appears on the 
AQUARIUS cart device label (the label can be 
found on the bottom leg of the system):  
 

 

. 

 Once the Device Serial Number has been 
entered press Done: 

NOTE: The number should be in the format: 
NAXX-1-YYMMZZZZ where: XX = the system model 
type of LT or CT or XT; and YYMMZZZZ = all numerical 
digits. In the example above, the serial number entered 
is NALT-1-12345678. 

. 

 Tap the Set button: 

. 
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 Tap Yes to confirm the Device Serial Number is 
correct: 

. 

 When ready to start pairing with the computer, 
tap Bluetooth Discoverable and then tap Yes 
in the resulting permission request screen: 

. 

 Double-click the Bluetooth icon in the tool tray 
of the PC to pair to the system: 

 
 
 

. 

 The Add a device window will load.  Click Add 
device to begin searching for the AQUARIUS 
system. The AQUARIUS system name will 
appear as XX-NAXX-YYYYYYYY where: XX = the 
system model type LT, CT, or XT; and 
YYYYYYYY = all numerical digits.  In the 
following example, the system chosen is XT-
NACT-1-12345679: 

. 
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Depending on the model type one of two options will appear: 

a. If it is the LT system, then a passkey 
will be automatically generated as 
shown here. Tap Pair to continue. 

 

 
b. If it is the CT or XT system, then a 

passkey will need to be manually 
generated. Click Create a pairing 
code for me to continue. 

 

 
 Once the passkey is generated, enter that 

passkey in the field on the Central Hub 
Computer (CHC) screen, then press next: 

 

For LT systems, ensure the code on the Central 
Hub Computer (CHC) and the computer are the same; 
only then continue by selecting Yes. Then click Next to 
continue. 
 

For XT systems 

, 
 
For LT systems 

. 
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 After clicking Next, the following window may 
appear. Close the window by clicking the X in 
the top-right corner. Do not make any changes 
under this window.  Example window, LT-
NALT-1-12345678: 

. 

 When the Add a device window appears, click 
the Devices and Printers link to confirm that 
AQUARIUS® system has been added:. 

 
 
 

. 

 The AQUARIUS® system should appear under 
Bluetooth Devices as shown: 

. 
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NOTE:  
Disregard error messages regarding Peripheral Devices.  These errors appear due to additional Bluetooth profiles that 
are available for use but are not recognized or used by the PC.  This does not affect the functionality of the system or the 
Central Hub Computer (CHC).  Refer to the two examples below of this error: 

 "Device driver software was not 
successfully installed” for Bluetooth 
Peripheral Devices.  Refer to 
example provided:  

. 

 Exclamation marks next to 
“Bluetooth Peripheral Device” 
under Device Manager.  Refer to 
example provided: 

 

. 

Central Hub Computer (CHC) setup is complete. 

Table 13: Connecting the PC or Laptop to the System 
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6 CALIBRATION 
 IMPORTANT: 

• Do not plug or unplug any USB device from the Central Hub Computer (CHC) during the calibration 
procedure. 

• Ensure that battery operated devices are either connected to their charger or fully charged before starting 
calibration procedures.  Run the calibration procedure in one continuous process to ensure proper function. 

 HOW TO CALIBRATE FLOW AND VOLUME 
6.1.1 CALIBRATE FLOW AND VOLUME WITH THE UROCAP™ V 

 Tap the Calibration icon on the home screen: 

. 

 Tap the UC5 device in the Calibration window:  

. 

 Listen for a `beep` from the Urocap™ V to signal it is ready for 
calibration.  The touchscreen will display instructions for 
calibration of the device. 

 Follow the on-screen instructions to complete the calibration: 

. 

Table 14: Calibrating the Urocap™ V 

6.1.2 CALIBRATE FLOW AND VOLUME WITH THE SPINNING DISK FLOW TRANSDUCER 
1. Tap the Calibration icon on the home screen: 

. 

2. Tap the Spinning Disk Flow Transducer device: 
 
 
 
 
 

. 
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3. The Calibration will open for the Spinning Disk Flow Transducer.  
Follow the on-screen instructions to complete the calibration: 

 

NOTE: The Next button in the final screen does not need to be 
tapped. After 10 seconds of no flow, spinning disk will automatically 
complete calibration. 

. 

2. When complete, tap the Home button to return to the Home 
screen: 

. 
Table 15: Calibrating the Spinning Disk Flow Transducer 

 

 HOW TO CALIBRATE THE ROAM™ DX FOR PRESSURE AND EMG 
Calibrate the Roam™ DX pressure and EMG channels. Ensure the transducers are securely connected to the device.  Refer 
to the Consumables and Transducer Setup section on page 25.  

6.2.1 CALIBRATE PRESSURE 
 

 Tap the Calibration icon on the home screen: 
 

. 

 Tap to select the Roam™ DX device. 

 Tap to select the Catheter System set up for calibration: 

. 

 The calibration window for the selected Catheter System will 
load; in this example Water-based Disposable Catheter 
System has been selected.  Tap the boxes correlating with the 
the transducer Channels being calibrated and tap Next to 
continue: 

 

NOTE: Scroll down the screen to see the other checkboxes (P4, P5) 
 . 
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Table 16: Calibrating Roam™ DX Pressure Channels and Transducers 

6.2.2 CALIBRATE EMG 

Table 17: Calibrating ROAM™ DX EMG Channel 

 Type 0 (zero) in the low load box and tap Next: 

. 

 Continue calibration by following the on-screen instructions 
until the calibration complete window appears: 

. 

 Tap the Return button to go back to the Calibrate Pressure 
Transducers screen: 

 Repeat steps 2 to 7 for the other Transducer Types. . 

 Tap the Calibration icon on the home screen: 
 
 . 

 Select the Roam™ DX device. 

 Tap to select Electromyography Calibration.  The calibration 
window for Electromyography will load. 

 Tap to select EMGR1 transducer and tap Next to continue: 

. 

 Short the EMG leads. The green progress bar moves when 
moving the leads. Tap Next: 

. 

 Wait for calibration to complete.  Click Next to complete 
calibration for electromyography:  

. 
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 HOW TO CALIBRATE THE PUMP 
 
Calibrate the pump by assigning different Pump sets. A maximum of 10 sets are allowed. 
 

 Tap the Calibration icon on the home screen: 

. 

 Tap to select the ‘HUB’ device: 

. 

 Tap to select the Pump Calibration option: 

. 

 The Pump Calibration window will open.  Tap the empty box 
and enter a calibration name. For example, Saline8f:  

This name is required to setup the pump for a test as outlined in 
the Pump Tab section on page 72.  

 
 Tap Next to continue. 

. 

 Select the pump roller from the combo box and tap Next:   

. 

 Select a Urocap™ V device from the dropdown menu, then tap 
Next to continue: 

 

. 
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 Select the correct catheter size from the listing, then tap Next:  

. 

 Select the fluid density from the combo box and then tap Next: 

. 

 Tap Next to start priming: 
 

NOTE: Tap Skip to go directly into calibration if desired. 

. 

 Tap OK to stop the pump and tap Next to continue: 

. 

 Follow the on-screen instructions to complete calibration: 
 

NOTE: During calibration there will be 8 calibration steps. 
 

. 

  Once complete, the pump calibration window will provide a 
confirmation message that calibration is complete: 
 

 Press the Home button to exit. 

. 
Table 18: Calibrating the Pump 
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 HOW TO CALIBRATE THE INFUSION TRANSDUCER 
1. Tap the Calibration icon on the home screen: 

. 

2. Tap to select the ‘HUB’ device: 

. 

3. Tap to select the Infusion Transducer Calibration option: 

. 

4. Select a transducer and tap Next. 

 

5. Type in the Low Load value and then tap Next. 

 

6. Continue by following the on-screen instructions until calibration 
is complete: 

. 
 

Table 19: Calibrating the Infusion Transducer 
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 HOW TO CALIBRATE THE UPP PULLER 
NOTE: Before starting UPP calibration, gather a ruler and pencil. 

 

1. Tap the Calibration icon on the home screen: 

. 

2. Tap to select the UPP device: 
  

. 

3. Follow the on-screen instructions to complete the calibration: 

. 

4. Tap the Home button to exit: 

. 

Table 20: Calibrating the UPP Puller 
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7 SOFTWARE FEATURES AND FUNCTIONS 
 
Double-click the UDS icon on the desktop to start the UDS software: . 

The AQUARIUS® software window will open.  Refer to Figure 38 for identification of the main sections contained within the 
software window. 

 
 

Figure 38: AQUARIUS Software Window 
 

• Menu Bar: Click to access the features available for testing and analysis.  The menus in the menu bar at 
the top of the Goby™ software window contain items that allow you to view saved test files, customize the 
appearance of the control panel, create custom configurations, and view test summaries.  The Menu bar 
contains the File, Configure, Info, Options, Video, View Horizontal, and Calibration Sets menus. 

 

• Control Panel: Contains buttons for selection during Urodynamics procedures. 
 

• Graph Display Area: Displays the scrolling graph during procedures, saved graph during review, and 
contains zoom level options. 

 

 NOTE: Device Icons are displayed on the CHC Touchscreen.  Icons display equipment status.  Any changes to the 
status will automatically appear on the CHC screen.  For information on Device Status Icons refer to the Icons in the 
Touchscreen section on page 34. 
 
The following subsections provide information regarding features available through the Control Panel, Graph Display Area, 
and Menus contained in the Menu Bar.  In addition, this section provides information for VBN and ARM optional features.   
 
 

Menu 
Bar 

Control 
Panel 

Graph 
Display 
Area 
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 DYNAMIC CONTROL PANELS 
The UDS tests can be setup to open to a default control panel set each time the software starts. For more information on 
adding and configuring control panels, refer to the Control Panel Settings on page 115.   

7.1.1 PRETEST 
Use the Control panel to start the test.  always enter patient information before starting a test.  Once the patient information 
is entered, click the desired test button to open the Pretest screen (Figure 39). 
 

 
Figure 39: Pretest screen 

 
The Pretest screen facilitates checks for proper catheter placement and verification of pressure responses before the start 
of a test. Data is not recorded while this screen is running. 

• Click the Summ. Review button at any time to view the summary results of the test at that stage. 
• Click Return to Test to go back to the test screen. 
• Click the Main Menu button to return to the main welcome screen. 

Refer to Figure 40 for reference: 

 
Figure 40: Pretest Window - Verifications 
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7.1.2 ZOOM BUTTON ON CONTROL PANEL 
Create and use a zoom button on the control panel for a more detailed look at a particular section of the graph. 

NOTE: A test must be at least 3 minutes long for the zoom feature to work properly. 

To setup the zoom button on the control panel follow the instructions below: 
 Begin by creating a Zoom button on the control panel (if not already created).  
 Click Options > Control Panel Definition and find an empty spot on the control panel to add the button.  
 Type the name under the Label column, the zoom value under the Definition column, and select the Zoom 

description under the listing in the third column (Figure 41). 

NOTE: Zoom values are always set as 2X, 3X, 4X, etc… which corresponds to 2X=200%, 3X=300%, 4X=400% etc. 

 
Figure 41: Command Window – Zoom Button Setup 

 Click OK. 
 
To Zoom in on a portion of the graph follow the instructions below: 

 Press and hold the left mouse button and drag the cursor to highlight the area on the UDS graph to zoom.  The 
area will be highlighted in black. 

 Click the Zoom button on the control panel to zoom in on the selected section. 
 Click the Zoom Back button to return to regular view. 

 
Figure 42: Zoom Feature  
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 GRAPH DISPLAY AREA 

7.2.1 HIDING/SHOWING CHANNELS 
To hide any visible channels, right-click on the channel’s line on the graph and then select the Hide Channel option in the 
resulting context menu. For example, to hide the Volume channel, right-click on the Volume Channel’s line and select Hide 
Channel from the context menu (Figure 43). This can be repeated for as many channels as needed. 

 
Figure 43: Hiding a Channel 

 

To bring back the channel, right-click anywhere on the graph and select Show Channels and then select the channel name 
to make it visible again (Figure 44). Note that the channel will appear at the bottom of the graph. 

 
Figure 44: Showing a Channel 

7.2.2 MODIFYING CHANNELS 
 MODIFY CHANNEL TITLE AND UNITS 

Change the channel title and units by simply clicking on them and typing in the new data.  
 

To change a channel title: 

1. Click a channel title.  An edit box will appear above the channel 
title. 

2. Type the new channel title into the edit box to replace the 
previous title and press Enter.  The channel title of that channel 
will be changed. 

Refer to Figure 45.  
Figure 45: Channel Title 
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To change the channel units: 

1. Click on a channel units.  An edit box will appear above the 
channel units. 

2. Type the new channel units into the edit box to replace the 
previous entry and press Enter.  The channel units of that 
channel will be changed. 

 Refer to Figure 46.  
Figure 46: Channel Units 

 MODIFY CHANNEL SCALES 
Change the channel scales (minimum and maximum) by simply clicking on them typing in the new data. 

To change either the maximum and minimum scales: 
1. Click on a channel scale.  An edit box will appear above the 

channel scale. 
2. Type the new channel scale into the edit box to replace the 

previous entry and press Enter.  The channel scale of that channel 
will be changed. 

Refer to Figure 54.  
Figure 47: Channel Scale 

 CHANNEL VALUE MARKER 
This feature displays the triangular channel value marker at the edge of the 
graph window to facilitate identification of the channel curve.  The marker 
functions like a pen that draws the curves as the test is running.  Refer to Figure 
55. 

 
Figure 48: Channel Value Marker 

 DRAG/DROP CHANNEL ORDERING  
Change the channel order quickly, in the Graph Display Area, without accessing the Configuration dialog box.  For 
instructions on changing channel order in the Configuration dialog box refer to the Config Menu section, subheading 
Channels Settings Tab on page 66. 
 
To change channel order using drag/drop mouse tool: 

1. Right click on the channel information area.  The channel 
information area displays the title of the channel.  To use the 
drag and drop tool the user must right click the channel 
information area; do not select the graph portion of the 
display.  A popup menu appears. 

2. Select Change Channel Order.  The mouse pointer will 
change to a hand. 

3. Drag the channel information area of the channel being 
moved to its new position.  Release the left mouse button.  
The channel changes order in accordance with selected 
positioning.  

4. Repeat steps 2-3 for other channels selected for re-ordering.  
5. After all channels are re-ordered, right-mouse click in the 

channel information area to show the popup menu and 
deselect the Change Channel Order menu item. 

Refer to Figure 49. 

 
Figure 49: Reordering Channels 
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 FILE MENU 
The File menu is the first menu located on the menu bar at the top of the screen.  It contains items that allow you to view 
saved files as well as contact information for the LABORIE support department.  

7.3.1 Open 
The Open feature on the File menu opens patient tests that have already been created.  
Before opening a saved data file, be sure that any patient tests running are saved. Once the file is saved, opening a saved 
file automatically closes the old one. 

To open a saved file: 
 Click File from the menu bar. 
 Select Open.  The Open Test window will open (Figure 50).  

 
Figure 50: Open Test Window 

 Select the patient and then the file to be opened. 
 Click Open Test to open the file. 

NOTE: Numbers always appear before letters when sorted in ascending order. 
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7.3.2 OPEN SCHEDULED TESTS (OPTIONAL – FOR I-LIST SOFTWARE USERS) 
Retrieve the scheduled test information assigned to the local computer and/or for all computers for the day.   
Click File > Open Scheduled Tests to launch the Scheduled Test window: 

 
Figure 51: Scheduled Tests Window 

• Search by name, MRN, or perform a general search to see all the tests in the i-LIST database. 
• Select any test from the list and select OK to continue. 

 Patient Name and Doctor information cannot be changed. 

7.3.3 SAVE AS 
The Save As feature is used to: 

• Save a test for the first time. 
• Resave a test using a different filename. 
• Setup Patient File Security features (more information on this can be found in the Security Tab section on 

page 74). 
When choosing a new file name, keep the following points in mind:  

• The filename should not have been previously used. 
• The filename should not contain punctuation marks. 
• Establish a system for filing so that test data may be recognized and retrieved easily. 

To assign a name to a file: 
 Click File from the menu bar. 
 Select Save As to open the Save Test File dialog box. 

 

Figure 52: Save Test File Window 
 Click inside the text box and enter the desired filename using the keyboard.  The file extension .DTA is 

automatically added to the filename. 
 If required, make sure that the Encrypt Patient Information box is selected.  
 Select the file type to save from the Save As Type list. 
 Click Save. 

NOTE: All patient files are automatically stored in the c:\data directory. To change the directory, refer to File Saving 
Directory section on page 123 
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7.3.4 PRINT STUDY 
Select the information for inclusion in the printed report through this window.  At first print per test configuration, the Print 
Study option will navigate to the Print Options window.  Use fields in the Print Options window to select print options.  To 
change the font of a feature on the report, click the font button in the Print Options window and select the feature.  Double-
click the feature and select size and style.  Click OK to confirm changes. 
 
During the first print of a report for a specific test configuration, select preferred print options in the print menu and click 
the Apply button.    Each time you print a report for this test configuration, the report will automatically print using options 
previously set.  The Print Options window will no longer appear automatically when you click the PRINT button. 
 
Click File from the menu bar and select Print Study. The Print Options window will appear (Figure 53). 

 
Figure 53: Print Options Window 
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Refer to the following figure and its accompanying legend to select printing options. 
 

Number Description Print Output 

(1) Preferences Uroflow Report One page voiding study report. 

 PNTML Summary Printout of PNTML (EVOX) tests. See the PNTML (EVOX) operating 
manual for more information. 

 Tetra NIRS Summary Not available with AQUARIUS® UDS software. 

 UDS Report Multi page complex study report. 

 Graph Pages Graph pages of UDS report. 

 Report Pages Report pages. 

(2) Address-o-graph One to two page report style. 

 Physical Exam. Physical exam. section in address-o-graph report. 

 Standard Report Prints all information pertaining to study. 

(3) Voiding Summary Uroflow Summary information. 

 UPP Summary UPP Summary information. 

 Event Summary Event Summary information. 

 CHESS CHESS Nomogram information. 

 URA1 ICS Nomogram information. 

 WF Bladder Work Function information. 

 LinPURR Shafer’s Nomogram information. 

 Diagnosis Patient Diagnosis information. 

 Compliance Prints compliance report information. 

 History Patient History information. 

(4) ARM ARM Profile Summary ARM Summary table as part of the report pages (ARM option). 

 Pressure Profile 
Summary 

ARM Pressure Summary as part of the report pages (ARM option). 

 Stationary Summary ARM Stationary Summary as part of the report pages (ARM option). 

 Pressure Variation  
Summary 

ARM Pressure Variation Summary tables as part of the report pages 
(ARM option). 

 Squeezing Summary ARM Squeezing Summary table as part of the report pages (ARM 
option). 

 Rectal Volume Summary ARM Rectal Volume Summary as part of the report pages (ARM option). 

 RAIR Summary ARM RAIR Summary as part of the report pages (ARM option). 

 Expulsion Summary ARM Expulsion Summary as part of the report pages (ARM option). 
(5) Nomograms and 
Summary Information 

STEPP N/A 

 Eberhard UPP Static and Stress curves and summary information as part of report 
pages. 

 Pediatric Nomograms 
(optional) 

This option is only available if the patient is between 3 – 16 years of age. 
Both the Voiding Summary screen and the Pediatric Nomogram option 
must also have been opened to enable this feature. 

 Liverpool Nomogram 
(optional) 

Optional feature for Uroflow procedures. 
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Number Description Print Output 

 Siroky Nomogram 
(optional) 

Optional feature for Uroflow procedures. 

(6) Print Range Default Test from beginning to end. 

 UPP Sections UPP segments only. 

 Default and UPP  Prints both options. 

(7) Print Border Check 
box 

Print Border This feature will frame the graph with a simple line border. 

(8) Number of Copies 
Control 

Number of Copies The default number of copies to print is one. 
Click on the combo box arrows to change the number of copies to be 
printed. 

(9) Grids Fine Small grid squares on graph. 

 Coarse  Large grid squares on graph. 

 None No grid squares. 

(10) Apply and Font 
buttons 

Apply  Click this button to set up a default configuration when printing each 
test. 

Font The Font button can change the look of some of the items on the 
printed report. Once the Font button is clicked, double-click the name 
of the feature that will have a font change. Select the size and style and 
click OK to confirm the changes. 

(11) Graph Scaling 1-Page Graph Graph page is condensed into one page. 

 Standard Standard Graph pages printed out with no compression or expansion 
applied. 

 Min/page  Selectable number of minutes per graph page. Use the scroll bar to 
adjust the desired number of minutes per page view. 

(12) Graph Segments Segments Manually select up to 8 segments or sections of the graph to be printed 
as opposed to printing out the entire graph. 

(13) Preview Graph 
Segments Button 

Preview Graph 
Segments  

Displays a sample of the graph printout. 

 
For information on Print Setup, see page 62. 
1Griffiths et al. (1989) Neurourology and Urodynamics 8:17-27.  
 
*The URA may be difficult for first time AQUARIUS® users to interpret. The URA must be viewed on the screen before 
printing. Once the curve is viewed, the options in the dialog box become available. 
 

Table 21: Print Options Descriptions 
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7.3.5 BATCH PRINT 
Print multiple procedures together using the Batch Print feature.  Select procedures from a particular day or from different 
time periods.  
 
To access Batch Print for tests performed on the same day: 

  Click File from the menu bar and select Batch Print.  The Batch Print window will appear (Figure 54). 

 
Figure 54: Batch Print Window 

 Click the Select Today’s button.  A dialog box appears indicating the number of data files that have been 
selected. 

 Click OK.  The selected file(s) appear in the Print Files box at the bottom of the screen. 
 Click Print. 

 
To access Batch Print for files which have been run on previous days: 

 Click File from the Menu bar and select Batch Print.  The Batch Print window appears. 
 Select the files to be printed by double-clicking on each file or clicking on a file and pressing the Select button.  

The selected file will appear in the Print Files box at the bottom of the screen. 
 Click Print. 

 
To cancel printing a file after it has been selected in the Print Files box: 

 Click on the file from the Print Files box in the Batch Print window. 
 Click Remove.  The file name will disappear from the Print Files box and reappear in the File List box. 

NOTE: The Re-Index option is only needed when an Index file is corrupt (A corrupt file means that the file is 
damaged. If the file is corrupt, a message box will tell you to use the Re-Index option). This option generates the 
index file that contains the patient’s name, comments, file date, and the procedure date for quick look up. The 
Index file can be re-generated by re-indexing. 
 
To access the Re-Index option: 

 Click the Re-Index button in the Batch Print window.  The Re-indexing Dialog box appears. 
 Click OK.  The file is automatically re-indexed. 
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7.3.6 PRINT SETUP 
To access and adjust Print Setup options: 

 Click on File from the Menu bar and select Print Setup.  The Print Setup window appears. 
 Set preferences: 

a. Select the appropriate printer in the Printer Name dropdown menu. 
b. Select the appropriate paper size in the source field. 
c. Select page orientation; click Portrait. 

 Click OK. 
The changes made to the Printer setup will be applied to the printing process of the test.  
 
Printer Properties: To change the printer options, please refer to the user’s manual for the printer. 

7.3.7 ABOUT UDS CLIENT 
The About UDS Client window displays the contact information for LABORIE Technical Support and formulas used in 
Urodynamics. It also includes the software version number, the ServerX version number, the Firmware version number, and 
the VBN version numbers (if applicable).  Use this window to create a fax cover sheet that can be sent to the LABORIE 
Support department for inquiries into any problems you may be experiencing with the equipment or software. 

NOTE: The software version number is the same for single and multiple connections. 
 
 

To access About UDS Client information: 
 Click File from the menu bar. 
 Select About UDS Client. 
 Use the window to review LABORIE contact information and system technical information. 
 Use the Fax Cover button to open the Fax Cover Sheet window (Figure 55). 

Use the available fields in this window to log information that will help the LABORIE Support team identify the 
problem and provide a solution. Click the Print button to print the cover sheet. Once it is printed, fax the sheet(s) 
to LABORIE Support with the fax number provided. 

NOTE: The comments section has a maximum of 1024 characters. 
 

 
Figure 55: Fax Cover Sheet Window 

 
NOTE: The Update button is only for use by the LABORIE Technical Support team. 

7.3.8 IMPORT ASC 
Importing and open test data saved in ASCII format using this feature. 

7.3.9 IMPORT ICS 
Import and open test data saved in ICS format using this feature. 

7.3.10 EXIT 
The Exit feature closes the UDS software. 
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 EDIT MENU  
The Edit menu provides access to features described in the following subsections. 

7.4.1 MARK BLOCK 
The Mark Block feature marks an image block (for example, a graph or graph segment) so that it can be copied and pasted 
into another application which supports Windows image pasting (for example: Microsoft Word, PowerPoint). This feature 
can also be used in the workstation mode.  

NOTE: The Mark Block feature is not available when a test is running. Stop the test to enable this feature. 
 
To mark an image block: 

 Open a saved test or stop the procedure if it is running. 
 Click Edit from the menu bar and select Mark Block.  The cursor changes to a "+" symbol. 

 Select a section by dragging the + cursor from the top left corner to the bottom right corner ().  The selected 
area will be highlighted.  The section is ready for copying.This area is highlighted and is ready to be copied. 

 

Figure 56: Mark Block Feature 
Refer to the Copy section on page 63 for instructions on how to copy the marked area.  To unmark a copy, refer to the Undo 
section on page 63. 
 

7.4.2 COPY 
Once an image block has been marked, it may be copied onto the clipboard for pasting into another Windows application.  
The clipboard is a temporary storage area that holds all marked items for the purpose of transferring data from one 
application to another in Windows. These marked items are not displayed on the screen. 
 
To copy a test: 

 Mark the image block to be copied. 
 Click Edit from the menu bar. 
 Select Copy.  The marked image block is copied into the clipboard until it is pasted into another application or 

deselected by using the Undo command. 
 Paste the marked image block into a document in Word, PowerPoint, Notepad, etc. 

7.4.3 UNDO 
The undo feature clears the selected (marked) image block. This menu item is only enabled if an image block has been 
selected. 
 
To unmark a marked portion of a test: 
After selecting an image block, click Undo from the Edit menu.  The marked selection is unmarked. 
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7.4.4 UNDO SET ZEROES 
The undo set zeroes feature clears the settings of a previous zeroing operation. 
 
To Undo the Set Zeroes of a Test: 

 Click File > Undo Set Zeroes. 
 Select Undo.  The previous Set Zeroes operation is reversed. 

7.4.5 ZOOM – SELECTED AREA AND BACK 
Use the zoom function for a more detailed look at a section of the graph.  The test must be at least 3 minutes long for the 
zoom feature to work. 
 

 Press and hold the left mouse button and drag the cursor to select an area on the UDS graph to zoom (Figure 57). 

 
Figure 57: Zoom – Selected Area 

 Click Edit > Zoom Selected Area.  The selected area is zoomed in and expands to fill the entire graph window 
(Figure 58). 

 
Figure 58: Selected Area Zoomed 

 Highlight an area of the zoomed graph again and select Zoom Selected Area to continue zooming in if 
necessary, or click Edit > Zoom Back to return to the original graph. 

NOTE: A Zoom button can be created for one-click zoom-in to a preferred magnification level. Refer to the Zoom 
Button on Control Panel section on page 53 for more information. 
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 CONFIG MENU 
The Config menu contains items to help you set up files that can be loaded and used as standard configurations for testing. 
Clicking the Config menu title lists the following menu items: 

7.5.1 OPEN 
The Open feature serves a similar function as the control panel procedure buttons.  Both controls load a test configuration 
to start a procedure. Select the test configuration file (example, CMG.cfg) and click Open to load the file using the Open 
feature. 
 

7.5.2 SAVE AS 
The Save As feature under the Config menu is used to save or redefine a configuration. Remember that a new file name 
should not include any punctuation marks. It is important that a system for filing be established so that test data may be 
recognized and retrieved easily. For example: A file may be named Uroflow.CFG for Uroflow studies or CMG.CFG for 
Cystometry. 
 
To save a configuration with a different file name: 
 

 Click Config on the menu bar and select Save As.  The Save Test File dialog box will appear (Figure 59). 

 

Figure 59: Save Test File Dialog Box 
 Enter the desired filename and click Save.  

NOTE: The file extension ".CFG" stands for "configuration" and is automatically added to the configuration filename.  
Select the Encrypt Patient Information checkbox if you wish to encrypt patient information.   

 Set up/Modify.  All of the test configuration files are automatically stored in the C:\CFG folder. 

7.5.3 SETUP/MODIFY 
Complete the following configurations using the Set up/Modify menu: 

• Connect devices to a test configuration file 
• Change data rate 
• Change channel order 
• Change channel title, scale, and units 
• Change test name 
• Add channels 
• And more…. 

 
The configuration parameters tabs are divided into two major categories: 

• Channel parameters configure individual channels and are found in the Channel Settings Tab. 
• Global parameters customize the test format. 
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For access to Configuration: 
Click Config from the menu bar and select Set up/Modify (Figure 60). 

 
Figure 60: Configuration Window – Channels Settings 

 
Before saving a new test configuration, use the Clear Config button to erase any changes made in this window and start 
again. 

NOTE: To resize the columns or rows in the Configuration window for ease of reading information in the boxes, place 
the pointer on the shaded areas along the top or left side of the window. Move the pointer over the lines between the 
columns or rows until it changes to a double-ended arrow. Drag the arrow across to resize the columns, or up and down to 
resize the rows, until you get the right size for the column or row.  Repeat resizing of the chart each time the Configuration 
window is opened. 
 
The following section explains the parameters that can be changed and the procedures for performing these changes. After 
each change, press the Apply button to apply any changes made. Press OK to apply the most recent changes and to close 
the window. 

 CHANNELS SETTINGS TAB 

Devices 
Depending on the system, when a new test file is configured the devices belonging 
to the system will need to be linked with the new test file to ensure proper data 
recording. 
Select the connected device from the Roam and Uroflowmeter drop down menus. 
 

NOTE: Devices must be set up before any other settings are configured in 
this screen.  If at any time devices are removed or added to the system, the 
configuration tab needs to be updated with the newly added or removed device. 

 
Figure 61: Channel Tab – Devices 
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Curve Index, Channel Name, and Channel Title 
The default transducer configuration displays: Uroflow, Pves, Pabd, 
Pdet, EMG, IH2O, and VH2O. Channels can be added or removed 
according to test requirements. 

To order channels: 
 Click in the Curve Index box of the channel requiring 

reordering. 
 Select the new positions from the dropdown menu.  Repeat 

for all channels requiring reordering. 

To remove a channel: 
 Click the box corresponding to the desired transducer.   
 In the Channel Name column, select None from the 

dropdown menu corresponding to the test channel being 
remove.  

 Click OK to remove the specified transducers from the graph. 

 
 
Figure 62: Curve Index, Channel Name, and 

Channel Title 

To add a channel: 
 Click in the Channel Title box and select the desired transducer/channel for use. 
 Repeat until all the required transducers are selected and click OK. 

 
Change the Channel Title for identification purposes by entering a new name in the Channel Title field. 
For example, if the default name "flow" is too vague, it may be replaced with "Uroflow."  
 
To change the channel title: 

 Click in the Channel Title field box. The channel title is highlighted. 
 Enter a new Channel Title. 

Click OK to save the new Channel Title.  The new name will display on the procedure graph. 

NOTE: For curves, verify that the Display Curve in the Display Attributes section has been selected. A maximum of 
8 curves can be displayed on the screen or on a printout. 
  

Setting up CH5 and EMG1 Channel 

 
Figure 63: Roam EMG Connection Warning  

 IMPORTANT: The CH5 and EMG1 channels are the same port 
on the Roam™ DX and cannot be connected to the same Roam™ DX 
device. If using one Roam™ DX then configure either a CH5 or EMG1 
for the test.  Refer to Figure 63 for the warning that will appear if both 
channels are entered into the Channels Settings Tab for the same 
device. 

   

Scale-Min/Max 
Use the Scale-Min/Max column to specify a Scale range for the test 
curve. 
 
To change the Maximum and Minimum scale: 

 Click on the Scale (Min) or Scale (Max) box of a channel. 
 Type the desired value for the Min and the Max using the 

keyboard. The new scale range will be displayed on the 
graph. 

 
Figure 64: Scale Min/Max 
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NOTE: If the full-scale value entered is a lower number than the recorded peak value, the peak of the curve will be 
clipped off or extended into the curve above it, depending on the graph clipping Settings.  For additional information 
on graph clipping, refer to the Graph Clipping section on page 125. 

  

EMG Slider 
The EMG channel box contains slider which allows the user to control 
Max and Min volumes without accessing the Configuration Window. 
(Figure 65). 

Instead of manually adjusting the values, adjust the Max and Min scale 
values of the EMG channel using the slider. The slider control range is 
from (-10µV…+10 µV) to (-1000 µV...+1000 µV).  

 
Figure 65: EMG Slider 

Units 
Use the Units column to set default units for each channel. 
 
To change the scale units: 

 Click the Units box of a channel (Figure 66). 
 Open the drop-down menu for the Units combo box. 

Select the desired unit.  The unit change is displayed on the graph channel. 
 

Math Def. 
Use Math Channels to perform arithmetic operations between one or more channels. The math channels support basic 
arithmetic operations such as addition, subtraction, multiplication, division, and the parenthesis operator (). 

For instance: 
If you have the pressure channel labeled Pves calibrated in cmH2O and you wish to display the pressure in mmHg. 
Knowing 1mmHg = 1.36cmH2O, you can type the following in the Math Definition for the Math1 channel and change 
the units of Math1 channel to mmHg. 

Pves / 1.36 

Note that the channel label used in the math definition must exactly match the title of the channel used. In addition, 
combine the operators to make complex expressions like: 

((Pves+100) - Pabd) / 1.36 

To create a math channel: 
 Select Config > Set up/Modify > Channels Settings. 
 Select a new channel. 
 Select the Curve Index number. 
 Select Math 1 under the Channel Name column. 
 Type the name of the math channel under the Channel Title 

column. 
 Select the Units. 
 Type the Math Def (Figure 66). 
 Verify the Data Rate as desired. 
 Select Display Curve under the Display Attributes column 

to show the curve on the screen. 
 Click Apply. 

Click OK to close the window. 

 
Figure 66: Channel Tab – Math and Units 

Channels 
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Data Rate 
The Data Rate is the number of data points collected and stored per second during the recording process.  
Variable High-Rate Sampling mode II: date rate 10 to 3000 Limitation: Multiple of 10 
Variable High-Rate Sampling mode III: data rate 10 to 5000 Limitation: Multiple of 10 
 
A higher data rate means the recorded curve has more data points, and therefore is more precise. However, higher data 
rate uses more memory storage. As a result, the maximum duration for the test is reduced. 
 
To edit the data rate: 

 Click the Data Rate box corresponding to the specific channel. A Data Rate box will appear with a listing of 
data rates. 

 Select the desired value from the list.  The new data rate is displayed on the graph. 
 Repeat for other channels (High Rate Sampling mode only). 

 

Display Options 
Display Attribute: Select to display the channel data as a curve on the 
graph or in the digital window. 
Curve Appearance: Customize the channel color. Both the channel 
curve color and the channel information will be displayed (and printed 
on a color printer) in the new color. 
Display Line Width: Make the channel curve thicker (in pixels) on the 
display by clicking the box under the Display Line Width column of 
the test channel and typing the desired display line width in pixels. 
Print Line Width: Make the channel curve thicker (in pixels) on the 
print out only by clicking the box under the Print Line Width column 
of the test channel and typing the desired print line width in pixels. 
Symmetry: Mirror a channel’s curve to make a negative mirrored curve. 
Click the box under the Symmetry column for the test channel and 
select Mirrored or Simple. 
Interior: Fill the area under the curve with the channel color.  

 

 
Figure 67: Channel Tab – Display Options 

  

Use Filter 
Use this feature to select curve filter options. Select to use a Standard Filter, use a 2 Second Filter, use a RealTime 2 
Second Filter, or not use a Filter. Apply the 2 Second Filter and the RealTime 2 Second Filter options to any pressure 
channel to remove any positive and negative spikes on the test curve. 
 

Display Original 
Use this feature to display the original graph if graph filters were applied. 
 

Printable 
Use this feature to see the graph on the printout of the test results. 
 

i-LIST Channel  
(for i-LIST Office Reporter users only) 
Select the channels for inclusion in the data transfer from the UDS software to the i-LIST reports. 
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Test Name and Graph Scrolling Speed 
The Channels tab provides Test Name and Graph Scrolling Speed 
Settings.  Use the Test Name field to set the name of the test to 
facilitate search and retrieval.   
 
Use the Graph Scrolling Speed field to set the scrolling speed for all 
curves. The Scrolling Speed controls the resolution of the curves. 
Values must be set between 2 and 10 pixels per second; the higher the 
number, the higher the resolution. 
 
To change a test name*: 
Click the Test Name box and select the current test name.  Type the 
new test name and click OK.  Alternatively, type the new test name and 
set the Graph Scrolling Speed. 
 
To set the Graph Scrolling Speed: 
Click the Graph Scrolling Speed box and enter the number of pixels 
per second for the curve. Click OK to set the values. 

 
Figure 68: Channels Tab – Test Name and 

Scrolling Speed 
* NOTE for i-LIST Users: The test name is 
vital to properly link to the patient database 
system.  Please consult with LABORIE 
before changing the test name. 

 

 UPP TAB 
Use the UPP tab to set the UPP Puller speed or calculate the UPP Distance Summary based on the distance a catheter is 
pulled with an attached sensor. 

NOTE: Make sure to first select the UPP test button on the Control Panel before setting up this feature.  Ensure the 
Distance Sensor has been calibrated 
 

 Connect the Distance Sensor/Catheter to Ch1. 
 

 Select the Distance Sensor Channel option.  Select Ch1 from the listing and click OK (Figure 69). 

 
Figure 69: UPP Tab – Distance Sensor Channel 

 

 Run a UPP test and press the UPP Stop button to stop the test. 
 

 Click Info > UPP Summary to open the UPP Summary window (Figure 70). 

 
Figure 70: UPP Summary Window 
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 Click the Preview button to display the UPP Plots (Figure 71).  Click OK to close the screen.  
NOTE: The Preview button is only available when using the UPP Distance Summary option. 

 
Figure 71: UPP Summary – UPP Plots 

 
 Print the results by clicking File > Print Study and selecting the UPP Summary option.  Refer to an example of a 

UPP Summary Printout in Figure 72.  

 
Figure 72: UPP Summary Printout 

 
 Once the UPP Distance Summary is complete, reconfigure UPP settings for speed.  Click Setup/Modify to 

navigate to the Configuration window, select the UPP Tab and click Configure; select UPP Puller Speed option 
and run the UPP test. 
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 PUMP TAB 
Use the Pump tab to select the pump to use during a test and configure its settings.  Settings include parameters for the 
pump such as fluid density and auto pump actions. Refer to  

 
Figure 73: Configuration Window - Pump Tab 

Refer to Table 22 below for a descriptions of settings and parameters available in the Pump Tab: 
 

Feature Function 

Calculate VH2O from IH2O 
When selected, the VH2O values are automatically calculated by the software based on 
the IH2O. 

Empty Infusion Bag Warning 

(valid only if Calculate VH2O from IH2O is not selected)  
When selected, the UDS software will automatically stop the pump and display the 
following warning message: Infusion bag is empty! when the Infusion transducer 
registers 5 ml or less of liquid in the infusion bag. 

Volume Channel Specifies the infusion volume channel 

Pressure Channel Specifies the channel used for pressure feedback. NOTE: this channel must not contain 
a math channel. 

Slow (rate speed) Determines the slow speed of the flow rate 

Medium (rate speed) Determines the medium speed of the flow rate 

Fast (rate speed) Determines the fast speed of the flow rate 

Prime (rate speed) 
Determines the prime speed of the flow rate 
NOTE: The Prime rate feature runs the pump at the speed set in the prime box in the 
Configure Pump screen. The default speed is 150 ml/min. 

Pump Flow Limit Specifies the max pump flow rate during calibration.  NOTE: This setting cannot be 
changed manually in the UDS software. 

Pressure Limit Stops the pump if the pressure channel exceeds this limit. CAUTION: Do not exceed 150 
cm H20 



LABORIE AQUARIUS XT/CT/LT/CTS Owner’s Manual   AQS-UM01   73 

Feature Function 

Volume Limit  Stops the pump if the volume channel exceeds this limit. 
CAUTION: Do not exceed 750 ml 

Volume Warning Limit Displays a warning message when the infused volume reaches the specified limit. 

Infusion Bag Warning Limit 

When the value entered is greater than zero the UDS software will display the following 
warning message without stopping the pump: Infusion bag is nearing empty! When 
the infusion transducer registers the value equal or less than the value entered inside the 
Infusion Bag Warning Limit box but greater than the threshold value for the Infusion Bag 
is empty the warning is displayed. By default the threshold value is 5 ml. 

Auto Pump Option 
 Stop, Slow, Med, Fast 

This option starts the pump at the selected pump speed when the test starts. Choose 
Stop if you do not want to use this option. 

Auto Pump Event This option records events automatically when the pump runs or stops. This option is 
enabled by default. Deselect the box to disable the feature. 

Pump Calibration Name: Select the appropriate calibration line from the dropdown list. The name contains all the 
information given during pump calibration on the Central Hub Computer (CHC).  

Table 22: Pump Tab Settings Description 

Set Up the Pump 
 Navigate to the Channels Settings tab in the 

Configuration window.   
 Ensure that the Roam™ DX, Urocap™ V, and 

Pump combo boxes are selected for the 
corresponding channels. 

 
Figure 74: Channels Tab – Devices and Channels 

 Navigate to the Pump tab in the Configuration 
window 

 Select a Pump Calibration Name. 
 

 Enter values in the Slow, Medium and Fast fields. 
 

 Click OK to save changes and close the 
Configuration window. 

 
Figure 75: Pump Tab – Pump Calibration Name 
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 FILTER TAB 
Set the filter frequency under this tab.  

 UROFLOW TAB 
Set the parameters for Uroflow such as auto Voiding Summary and auto printing under this tab. Refer to the Voiding 
Summary section on page 94 for more information. 

 ARM TAB 
Set the channels that correspond to the ARM measurements under this tab. Run a four-channel ARM test or an eight-
channel ARM test. For more information on setting up and performing ARM tests, refer to the Customizing the ARM Test 
section on page 164.  
 

 
Select the Enable Reverse Pump option to activate the reverse pump button on the control panel. 

 SECURITY TAB 
Set the security features to protect, or encrypt, a patient’s name and information such as Medical Record Number, History, 
Diagnosis, Doctor’s name, Clinic name, and Comments. Once encryption is set, only the software key that is associated to 
the patient file can see the decrypted information. 
 

NOTE: This security feature needs to be set before you start running a test.  Make sure that a software key is installed 
in your PC. 
 

To encrypt patient information: 
1. Click the Security tab. 
2. Make sure that the Enable Encryption 

of Patient Information box is selected. 
3. Click the Add button to add your key’s 

serial number to the secure list. 
4. Click Apply to save your selections. 
5. Run your UDS test and save the test 

data.  
6. In the File > Save As box, make sure 

that the Encrypt Patient Information 
box is selected.  

Refer to Figure 76. 
 
Once you save the patient information with 
encryption and if someone uses a virtual key 
that is not associated with the file, they will see 
the word ENCRYPTED in all the Patient 
Information fields. 

 
Figure 76: Configuration – Security Tab 

 

To select all data files for encryption with a newly added serial key, even those already saved, select the Update all the data 
files…. option. 
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 I-LIST EVENTS LINKING TAB 
Events that are not in the I-LIST Events Linking may not appear in some of the printed reports. Use the iList Events Linking 
tab to view available events. 
 
Follow the instructions below to review event availability in the Event Summary: 
 

 In the software click Config > Set up/Modify. 
 Click the I-LIST Events Linking tab (Figure 77). 

 

 
Figure 77: Configuration Window – ILIST Events Linking Tab 

 
LIST Office Reporter will display only the events that appear in the list under this tab. Also, the Annotation Alias needs to 
exactly match what you mark on the UDS test in order to appear in the Event Summary. 
 
If a new event is required or the software is being used with a language other than English, use the Annotation Alias listing 
located at the left most column of the iLIST Events Linking tab to add or translate an event name.  Double click on the 
event name and change naming as needed.  For example, the event Strong Cough is added to the list. Click the Event 
button on the control panel and the newly added event will appear in the Event Annotation window. 
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The ILIST Events Linking tab provides a listing of events in addition to Load Default Events, Full Test Graph Settings, and 
Graph Segments buttons. 
 

• Click the Load Default Events button to add the standard iList™ events to the listing. 
• Click Graph Segments to customize the width, height and minutes per page for reports (Figure 78).  

 
Figure 78: Graph Segments Window 

 
• Select Channels to specify the channels to appear on the graph segment (Figure 79). 

 
Figure 79: iLIST Linking Window 

 COMPLIANCE TAB 
The Compliance tab, in the Configuration window, provides configuration options for automatically calculated Bladder 
Compliance.  Bladder Compliance is commonly calculated from events in the filling stage of a study. Refer to the Bladder 
Compliance (Optional) section on page 105 for instructions on using automatically calculated Bladder Compliance and for 
information on accessing Bladder Compliance options from the Info Menu.   
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 INFO MENU 
The Info Menu contains items that that allow viewing of patient information as well as test summaries. 

7.6.1  PATIENT INFORMATION 
The details of a patient’s file are easily added to and accessed through the Patient Information window. 

 To access the Patient Information box: 
 Click Info from the menu bar and select Patient Info.  The Patient Information window appears. 
 Click in the Patient field and enter the patient’s name. 
 Continue entering information into the fields available. 
 Click OK.  The data entered in the Patient Information dialog box is saved and the Patient Information 

dialog box closes. 
Refer to Figure 80 for a visual of the Patient Information window in the UDS software.  Refer to Figure 81 for a visual 
of the Patient Info window in iList. 

 
Figure 80: Patient Information Window – UDS 

 
Figure 81: Patient Info Window – iList 

 

 IMPORTANT: 

• Enter the patient’s date of birth as month/day/year/, with one or two digits for the month or day and four 
digits for the year. For example: A patient born on September 8, 1972 would be entered as 09/08/1972 or 
9/8/1972. 

• Once the date of birth field is filled, the Age field automatically calculates from the date of birth to the date 
of the procedure.  Pediatric patients, patients 16 years of age and younger, require additional setup.  Refer to 
the Pediatric Information section on page 78 for more information. 

• The Gender field selection informs statistical deviation information appearing in the Voiding Summary. 
• The Patient Name field must be complete for the appropriate statistical deviation to print. Enter blank spaces 

into the Patient Name field if you do not want to enter a name.  
• The MR# (medical record number) field keeps track of the patient’s medical records, especially when names 

appear more than once. 
• To add more than one doctor’s name to the Doctor listing, enter a name and click the Add Doctor button. 

To remove names, click the Clear List button. 
• If there is a change in any patient information in this window, you will need to save the CFG and/or DTA file 

again to confirm any changes. 
• The Patient Names (first and last) fields can accommodate up to 44 characters. 
• Medical record numbers cannot contain a back slash (\) or a forward slash (/). 
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7.6.2 PEDIATRIC INFORMATION  
When entering information for a patient who is 16 years of age or younger, the Patient Information window will automatically 
adjust itself to allow for the addition of necessary information (Figure 82).  Refer to overview of fields below: 

• EBC: Bladder Capacity – shown in milliliters - automatically calculated using 
the formula: 30 x (Age + 1)i. 

• ATBC: Acceptable Total Bladder Capacity. This limit is the maximum 
amount of fluid that can be infused into the patient according to bladder 
capacity at a given age. Calculated using the formula: ATBC = 16 x (Age of 
child in years) + 70 mlii. 

• Height: add height in centimeters. 
• Weight: add weight in kilograms. 
• Surface Area: of the bladder - shown in square meters – automatically 

calculated based on height and weight. 
• MPUR: Maximum Physiological Urinary Rate - shown in milliliters per 

minute – automatically calculated based on patient’s height and weight. 
• Fill Rate: fill rate of the pump. 

o Current Pump Speed: allows for selection of slow, medium, or fast fill rate 
o Use MPUR (10% of EBC) for pump speed and Use ½ MPUR (5% of EBC) 

for pump speed: automatically sets the ideal pump filling rate based on 
MPUR value. 

o Sq.Root Bladder Volume: automatically sets the ideal pump filling rate 
based on EBC value. 

 
Figure 82: Patient 

Information Window 

 

NOTE: To enable pediatric pump settings, select the test configuration (.cfg) file first then enter patient 
information.  MPUR and Sq Root Bladder Volume fill rates can then be selected for the test. 

 VOLUME WARNING LIMIT 
The Volume Warning Limit is used in the pediatric “Uro Mode” which applies to patients under 16 years of age. This limit 
is the maximum amount of fluid that can be infused into the patient according to bladder capacity at a given age. 
The Volume Warning Limit is determined by Acceptable Total Bladder Capacity (ATBC.): 

ATBC = 16 x (Age of child in years) + 70 ml.ii 

The pump receives the information to calculate the ATBC from the data entered in the Patient Information dialog box. 
NOTE: The ATBC is automatically calculated and cannot be changed. 

If the infused volume exceeds the limit specified in the Volume Warning Limit box, a message appears. 
IMPORTANT: After the warning appears, the pump does not automatically stop. It must be manually stopped. 
 

7.6.3 HISTORY  
Save a brief patient history with the study. The information in the History box is easily retrievable for future reference. 
 

 Click Info from the menu bar and select History.  The History window will appear. 
 Enter helpful information about the patient. 
 Click OK to save the information. 

NOTE: The History feature can also be accessed from the Patient Information dialog box (Figure 127). 

7.6.4 DIAGNOSIS  
The diagnosis feature holds notes made about a patient's condition after the test has been performed. Save the Diagnosis 
window with the test for future reference. 
 

 Click Info from the menu bar and select Diagnosis.  The Diagnosis window will appear. 
 Enter information about the patient. 
 Click OK to exit.  The information is saved when the file is saved. 

NOTE: The Diagnosis feature can also be accessed from the Patient Information dialog box (Figure 127). 
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7.6.5 X-Y PLOT  
The X-Y Plot can be used to calculate the urethral resistance factor (URA), the bladder work function (WF), the Linear Passive 
Urethral Resistance (LinPURR) graph, and CHESS functionality. 
The formulas used to determine ICS Nomogram (URA) and WF are located in the appendix of the article. 

 ICS NOMOGRAM (URA) 
The ICS Nomogram or URA (Urethral Resistance Factor) plot determines if a patient’s urethra is obstructed or unobstructed 
by graphing the flow and Detrusor pressure (Pdet) curves of a pressure-flow test on the x- and y-axis respectively.  
 

NOTE: A default delay factor of 0.8 seconds is used to account for any lag time before the Uroflow transducer in a 
pressure-flow test detects flow. It takes about 0.5 to 1.0 seconds for urine to travel through the urethra and into the Uroflow 
beaker. (Refer to Dr. Griffith’s article for more information). 
 
The URA Curve is a curve calculation based on the mathematical model of the equation. Please refer to the article by Dr. 
Derek Griffiths for more information. 
 
Mathematical equations used for calculating the URA: 

URA index: 

 
The URA index is the y-intercept (Pdet intercept) of the following 
equation: 

URA=   

 

 

 
Pdet* = 

  at Maximum flow  

Where: 

 

d = 3.8 x 10-4      
Q = maximum flow 
Pdet = Detrusor pressure 
Pdet* = Detrusor pressure at 
maximum flow 

  

 
 

 
To display the URA window: 

 Click Info > X-Y plot.  
 Select ICS Nomogram (URA).  The URA Plot 

window will appear. 
 Refer to Figure 83. 
  

• In the URA plot figure, the solid curve is 
Flow vs. Pdet and the dotted curve is 
URA. 

• To cancel the URA option select Exit! in 
the URA Plot window. 

• To display the URA Curve select URA. 
 

 
Figure 83: URA plot window 

 

Pressure/Flow 
Curve 
 

URA Curve 
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To change a channel name, threshold, or scale: 
 Click Options! from the URA plot window to launch 

the X-Y Options window. 
 Double-click in the text box of the name, threshold, or 

scale to be changed. 
 Type the appropriate modification. 
 Repeat until all parameter changes are complete. 
 Click OK to exit. 

 
 
To specify the analyzing range: 

 Click Options! from the URA plot window to open the 
X-Y Plot Options window (Figure 84). 

 In the Segment section, click the Change button. 
Select the segment analyzing range by dragging the 
mouse pointer across the graph from left to right 
(Figure 85). 

 Click Confirm. 
 Click OK. 

 
By default, the complete test is plotted on the graph and the 
scale is determined by the scale of the channels. This 
information is configured in the X-Y Plot options window. 

 

 
Figure 84: X-Y Plot Options Window 

 

 
Figure 85: X-Y Plot Options – Change Segments 
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 LINPURR 
The LinPURR graphiii is based on the work by Dr. Werner Schäfer. The LinPURR (Linear Passive Urethral Resistance) feature 
is available after a Micturition (pressure-flow) test has been run. A LinPURR graph determines urethral resistance by 
comparing flow and pressure. 
 
To open the LinPURR Graph: 

 Select the Info menu and select X-Y Plot. 
 Select LinPURR.  

 
To cancel the LinPURR Option, select Exit! in the LinPURR window. 
 

  
Figure 86: LinPURR Window 

 
A complementary analysis of pressure/flow data can be made using Dr. Schäfer’s techniques combined with 
Abrams/Griffiths. This representation is also in an X-Y format; however, the Flow and Pdet channels are plotted on the Y-
axis and X-axis respectively. 
 

To change the Parameters set for the LinPURR graph: 
Click Options from the LinPURR window.  The PURR Options window will load. 

  
Figure 87: PURR Options Window 
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To change the Channel parameters or the Graph Range for the Lin PURR graph:   
Refer to Figure 87 for a visual of the fields described. 

Change the channel: 
1. Click the drop-down button of the combo box beside the channel name to be changed. 
2. Select the appropriate channel. 

Change the Scale or Threshold: 
1. Double click inside the appropriate text box. 
2. Type a new value using the keyboard. 

Change the Graph Range: 
1. Click the Change button. 
2. Select the new range. 

Activate/Deactivate the Display Options*:  Click the check box beside the appropriate option. 
Color of Display: Select the Channel button.  Press Color button. 
 
* These Options are regions of discrimination to assist the clinician in categorizing the pressure/flow event.  
The following list explains these regions: 
 

• Pressure Flow Curve: This curve plots Uroflow and Pdet. It is similar to a URA curve, but LinPURR plots the pressure 
channel on a horizontal axis and the flow channel on a vertical axis. 

• URA Curve: Please refer to page 79. 
• URA Region Border: These lines on the graph divide the obstructed, unobstructed, and equivocal regions. 
• Detrusor Contractility: Detrusor Contractility is displayed as six regions marked in a left-diagonal fashion by the 

following labels: VW, W-, W+, N-, N+, and S. The software looks at the dataset to determine the relative strength 
of the bladder using Pdet and Flow as factors. 

• Normalized Detrusor Contractility: Normalized Detrusor Contractility represents the pressure at which the 
minimum "normal" bladder performance has been achieved on the Detrusor Contractility Scale. If this value is 0, 
then a minimum pressure has not been achieved. 

• OBI Pressure: This pressure represents the point at (50% of Qmax+2.4ml/s.)  
• LinPURR Grade: To perform a LinPURR Grade, use the following 2 above data points: 

o Pdet at max. Flow  
o Pdet at min. flow  

 
The LinPURR plot can show a rough estimate of the relative grade (0 to VI.) 
The digital parameters for LinPURR can be viewed from the LinPURR Summary box. 
 

To access the LinPURR Summary Box: 
Click Summary from the LinPURR window (Figure 86).  The LinPURR Summary window appears. 

To Change information in the LinPURR Summary Box: 
 
To change any channel or pressure values in the boxes: Double-click the text box to be changed and type the new 
information using the keyboard.  

To Change the LinPUUR Grade or Detrusor Contractility: Select the appropriate option. 

To Save the information for printing: Click Save Diagnosis. The numerical results of the LinPURR calculation appear in the 
info-Diagnosis section of the software. 
 

• Click the Exit! button to close the LinPURR Summary. 
• Click the Exit! button in the LinPURR plot window to close the LinPURR Plot Window. 
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 BLADDER WORK FUNCTION (WF) 
The Bladder Work functioniv is based on the work of Dr. Derek Griffiths. The Bladder Work Function feature is available after 
a Micturition (pressure-flow) test has been run.  This feature calculates the bladder work function (also called bladder power) 
by using Pdet, Flow, and Bladder Volume. 
 

To access the WF Plot: 
 Click Info and select X-Y plot. 
 Select WF.  The WF plot is displayed and the 

complete test is plotted on the screen. The 
parameters can be changed in the WF 
Configuration window. 

 Select Exit! in the WF Plot window to close the WF 
Plot window. 

 

 
Figure 88: WF Plot Window 

To change the Default Settings of the WF Plot using the 
WF Configuration Window: 

 Click Options from the WF window. 
 Change the range by using the Change button, if 

applicable. 
 Type any other changes using the keyboard. 
 Click OK. 

  

By default, the Inflow Channel is the infused volume (VH2O) 
and the Outflow Channel is the voided volume (Volume).  
Usually the Inflow and Outflow volumes are equal in value; 
however, if a patient has a residual volume of urine in the 
bladder, the volumes will not be the same.  Residual volume is 
the difference between the inflow and the outflow. It is 
automatically calculated and is displayed in the Residual 
Volume text box. 

 
Figure 89: WF Configuration  

 
Mathematical formulas used in this feature are listed here: 
 
Bladder Power: 
 
• WF=  (units: µW/mm2) 
 

 Where: vdet = 

 
Variables and constants used in these equations are listed here: 
• Q = maximum flow 
• Pdet = Detrusor pressure 
• Vol = bladder volume = infused volume-voided volume 
 

• a = 25 cm H20 
• b = 6 mm/s or 0.6 cm/s 
• V = 10 ml 
 

 

3
2

188790205.42 





+VtVolQ
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 CHESS 
The CHESS classificationv is based on the work by Dr. K. Hofner. This feature will display a two-dimensional feature based 
on the independent values of footpoint (pvoid min) and curvature from the passive urethral resistance relation (PURR). The 
CHESS menu item is enabled only when there is a FLOW and PDET pressure. 
 

To use the CHESS feature: 
 Run a test with Flow, Volume, and Pressure 

channels. 
 Stop the test. 
 Click Info > Event Summary.  The Event 

Summary dialog box is displayed 
 Click Info > X-Y Plot > ICS Nomogram (URA). 
 Select Info > X-Y Plot > CHESS.  The CHESS 

Classification Scheme dialog box will display. 
 Click File > Print Study. NOTE: Ensure that the 

URA and CHESS items are checked. 
 Click OK to print test. 

 

 
Figure 90: CHESS Classification Scheme Window 

 

 SIROKY NOMOGRAM 
The Siroky Nomogram was developed to provide an accurate and reliable indication of outflow obstruction.vi The UDS 
software provided by LABORIE will help you compare the results of a patient’s pre-therapy and post-therapy Uroflow test. 
 
To view the Siroky Nomogram: 

 Start the UDS software and click File > Open to open a saved Uroflow test. 
 Click Info > X-Y Plot > Siroky Nomogram (Figure 91). 

  

 
 

Figure 91: Access Siroky Nomogram  
 

Once selected, the Siroky Nomogram window opens that contains the graphical representation of the Average and 
Maximum flow rates as developed by Siroky et al. 

NOTE: The Siroky Nomogram is valid for male adult patients only. 
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Figure 92: Siroky Nomogram 

 
From here you can compare the average and maximum flow rates for the specific test. The plotted circles on the graph 
represent where the patient lies on the curve.  Close the window to return to the UDS graph window. 

 LIVERPOOL NOMOGRAM 
The Liverpool Nomogram was developed to provide an accurate and 
reliable indication of normal Uroflow rates.vii You can compare a patient’s 
pre-therapy and post-therapy urinary flow rate with LABORIE’s software 
and the built-in Liverpool Nomograms. 
 
To view the Liverpool Nomogram: 

 Start the UDS software and click File > Open to open a saved 
Uroflow test. 

 Click Info > X-Y Plot > Liverpool Nomogram. 
 

Once you select the Liverpool Nomogram option, a window opens that 
contains the graphical representation of the Average and Maximum flow 
rates as developed by Siroky et al. 

NOTE: The Liverpool Nomogram is valid for male and female adult 
patients only. Depending on the sex of the patient, the resulting 
Nomogram window will appear for either the male or female averages. 

 

 
Figure 93: Liverpool Nomogram Window Compare the average and maximum flow rates for the specific test. The 

plotted circles on the graph represent where the patient lies on the curve. 
 
Once you have viewed the graph, click the X in the upper-right corner to 
exit and return to the UDS graph window. 
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7.6.6 EVENTS  
Add events throughout the test to record what occurs during the procedure.  Events are automatically stored and 
displayed once added during a procedure. The summary of these events is available for reviewing through the Info menu 
in the Event Summary window.  

Add events using the preconfigured Control Panel event buttons available by clicking the event button when the event 
occurs.  Alternatively, left-click the graph window and select Insert Event.  The Event Annotation window will load.  
Once selected an event marker will be shown on the Graph window. 

 ABOUT THE EVENT ANNOTATION WINDOW 
 

The Event Annotation window contains a list of events that can be added to the 
graph.   
 
• Access the Event Annotation window in two ways: 

o Click the Event button on the control panel. 
o Right-click anywhere on the graph and select the Insert Event option. 
 

• If an event is already listed, then double-click the name to add it to the graph. 
 
• To customize the event list: 

1. Click Event on the Control Panel. 
a. To delete an event from the list, select it and click the 

Remove button. 
b. To add a new event to the list, type it in the edit box and 

click the Add button. 
2. After all customizations are complete, click the Save button. 
3. Make sure the file name is correct and click Save. 
4. Click Close to close the list. 

 
• Click the Sort button to sort the list alphabetically. 

 
• Click the up and down arrows on the right-hand side to move an event up or 

down the list. 
 

 
Figure 94: Event Annotation 

Window 

 DELETING OR RENAMING EVENTS – QUICK METHOD 
To delete or rename an event on a graph, right-click on an event located on the graph and select the Delete or Rename 
Event option from the resulting menu as shown in Figure 95. 

  
Figure 95: Deleting and Renaming Events on the Graph 
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 PERMISSION TO VOID 
Add the Permission to Void item to the event list of the Annotation Window to facilitate marking of the event during 
testing. Mark the Permission to Void Event on the graph to find the Maximum Filling Detrusor Pressure (Max Pdet) between 
the start of a test and the moment the patient voids.   
 
With the Permission to Void event marker, the filling phase and the voiding phase segments will be included on the report 
when you select to print the study. 
 

NOTE: If a Permission to Void event is added after the end of a Uroflow segment (each stop is automatically marked 
as Ur on the graph to signal the end of a segment), a message will appear asking for confirmation to remove the previous 
Uroflow segment as shown in Figure 96 below.  

 
Figure 96: Aquarius Client Window – Removing Uroflow Segment 

Click Yes to remove the marker or click No to keep the marker in the same spot. 
 

 STRESS EVENTS 
 
The Stress Test and Stress Leak event buttons provide precise LPP (Leak Point Pressure) calculations which can be viewed 
in the Event Summary. 
 

• Remember to attach the leak point detector to the catheter that will be measuring the pressure before starting 
the test. 

• Click the Stress Test button in the Control Panel to start or stop the stress test calculation segment. 

• Click the Stress Leak button to manually add a stress leak during the stress test detection phase. 

• A Calculated LPP event is added to the graph when the stress test is stopped. This calculation is the change in 
Pves pressure from baseline (as found at Start Stress Test) to the point of leakage. 

• When a test is stopped, a message box appears with options to select and help differentiate between a cough 
leak and a valsalva leak (Figure 97). 

 

Figure 97: Stress Leak Message Box 
• If No is selected, then a “peak with No Leak” event is added at the peak pressure value within the Stress Test 

segment. 

• If Yes is selected, then a Calculated LPP event is also automatically added at the peak pressure value within the 
Stress Test segment along with the Stress Leak event. 
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To view the calculations, click Info > Event Summary. 
 

 

Figure 98: Event Summary Window – Stress Test Events 

Stress events can also be recorded using the Control Panel instead of the Annotation window.  Include Valsalva and 
Cough Leak Events in the Control Panel during configuration. Mark the events by clicking the assigned buttons during 
the test.  Refer to Figure 99 for an example of a control panel configured for Stress events. 

 

Figure 99: Control Panel Stress Events 

 AREA UNDER CURVE 
The Area Under Curve feature calculates the area under the curve above a certain threshold for specific graph segments.  
Calculations can be viewed in the Event Summary.  
 
Before using this feature, the Area Start and Area End events need to be configured for calculation start and end points. 
Area Start and Area End events configured using control panel buttons can only be used while a test is running, while the 
events added to the Event Annotation box can be used while a test is running or after a test is stopped or saved. 

To configure Area Start and Area End buttons in the control panel: 
 Click Options > Control Panel Settings to open the 

control panel configuration window.  
 

 In the Command box, configure the Area Start* and Area 
End buttons. 

* The Area Start button is set with the format AS:pressure 
channel:threshold value. In this example: AS:Pves:0 means that 
the area under the Pves curve above a threshold of 0 will be 
calculated (Figure 100). 

 Click OK to add the buttons to the control panel. 
Refer to the Control Panel Settings section on page 115 for more 
information on configuring the control panel. 

 
Figure 100: Command Box 
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To configure Area Start and Area End events in the Event Annotation box: 
 

 Select a test to run. 
 Click the Event button on the control panel to open the Event 

Annotation box. 
 Create the Area Start event by typing the format 
AS:pressure channel:threshold value. In this example 
AS:Pves:0 means that the area under the Pves curve 
above a threshold of 0 will be calculated (Figure 101). 

 Click Add. 

 

 
Figure 101: Event Annotation Window, 

“AS:”  
 Create the Area End event by typing AE: (make sure that a 

colon symbol [:]is typed after the AE). 
 Click Add. 
 Click Close to return to the test start window. 

Refer to the About the Event Annotation Window section on page 86 
for more information on the Event Annotation window. 
  

Figure 102: Event Annotation Window, 
“AE:” 

To calculate the Area Under Curve during a test: 
 Click Run and then click Zero All. 
 When applicable, click the Area Start button on the control panel to establish the starting point of area 

calculation. 
 When applicable, click the Area End button to establish the end point of area calculation. 
 Complete the test and click Info > Event Summary to review the Area Start and Area End values. 

To calculate the Area under Curve for a saved test or after a test is stopped: 
 When a test is stopped or a saved test is open, right click on the graph at the starting point of area calculation 

and select Insert Event. 
 Select the area start event named AS: in the list.  
 Click Annotate Event. 
 Move the cursor pointer to the end point of the calculation area and right-click on the graph. 
 Select Insert Event. 
 Select the area end event named AE: pressure channel:threshold value in the list. 
 Click Annotate Event.  The area calculated will be appended to the Area End Event Annotation in the format AE: 

Pves: xxxx where xxxx is the calculated area. 
 Click Info and select Event Summary to review the Area Start and Area End values. 
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 TRSS EVENTS 
Add TRSS (Tone, Reflex, Sensation, and Structure) events to tests that are stopped or saved. 
 

 Right-click the graph to add a TRSS event and select Insert TRSS Event.  
 Select the TRSS # (Figure 103). 

 
Figure 103: TRSS Events 

 
 Add TRSS events by left-clicking and dragging the cursor across to select the segment for TRSS calculation. 

Release the mouse button when area is selected. 

 
Figure 104: Select TRSS Range 
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 The TRSS Start and TRSS Stop events are added to the graph and the TRSS Event values are visible in the Event 
Summary window. 

  
Figure 105: Event Summary – TRSS Events 

 
 

 OPENING TIME EVENT 
The Opening Time event calculates the time between the initial rise in bladder pressure, Rise Pdet, and Uroflow Start.  
 

The mathematical definition for this is:  
 
Opening Time = Time at Flow Start – Time at Pdet rise 

 
The Rise Pdet event is automatically placed between the Permission To Void and Uroflow Start events.  The event is 
placed on the Pdet channel. Remember to verify the position of the event on the graph. It can be moved to another area 
of the graph if necessary. 

NOTE: that the physiological opening time may be approximately one second shorter than what is displayed. 
 

Once the Opening Time event is added to the graph, it automatically activates the calculations associated with the event 
and the results are visible in the test report.  Test reports, in the Filling phase Results section, will display the following 
information: 

• Maximal Cystometric capacity (in ml): the value from VH2O at Permission to Void  
• Incontinence during filling (in ml):  the value of the Volume Channel at Permission to Void 
• Bladder filling (Maximal cystometric capacity – Incontinence during filling) (in ml):  value from Bladder Volume 

math channel or equivalent calculation in report. 
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7.6.7 EVENT SUMMARY 
To view the Event Summary window: 
Click Info > Event Summary.  The events are listed in chronological order in the event summary as shown in Figure 106 
below.  

  
Figure 106: Event Summary Window 

 
In the Event Summary window double-click on an event to move to the point on the graph that corresponds to that event.  
The Event Summary window can be used to Annotate, Delete, and change the Font of events appearing within the on-
screen display.  The Event Summary window provides an overview of calculations gathered at the time the event was 
marked. 

 IMPORTANT: Always save the DTA file in order to keep the event annotation changes with the files. 
 

 CHANGING THE FONT 
To change the appearance of the Event Summary window contents, select the font type and size by clicking the Font menu. 
This opens a Font selection window; set font t preferences. This only applies to the on-screen display and not to what is 
printed on the hardcopy report. 
 

   ADD OR CHANGE EVENT ANNOTATION 
 Click on an event and click the Annotate! button. The Event Annotation window will load (Figure 107). 

 
Figure 107: Event Annotation Window 

 Enter the text into the Annotation field or select an annotation the list. 
 Click OK.  The Event Annotation window will close.  Always save the CFG file in order to keep the event 

annotation changes with the files. 

  DELETING EVENTS FROM THE EVENT SUMMARY 
 Highlight the event.  To highlight multiple events, hold down the Ctrl key while clicking on the events. 
 Click the Delete! button.  The Confirm Event Delete message box will display. 
 Click OK.  The events are deleted from the Event Summary. 
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 EVENT LINE COLORING 
To highlight an event placed on the graph, add a colored line to make it easily visible. 

 Open a test file if not already open. 
 Click Info > Event Summary to open the Event Summary window. 
 Click to select an event from the list, for example select the First Sensation event. 
 The selected event is automatically bolded on the graph (Figure 108).  Close the Event Summary window. 

 
Figure 108: Event Summary – Select Event 

 
 Right-click the event on the graph to open the context menu. 

 
Figure 109: Select Event – Context Menu 

 Select Change Event Color to open the color selection window. 
 Select a new color from the available color boxes, for example change from blue to orange, and click OK.  The 

event’s line marking will change to the newly selected color. 

 
Figure 110: Event Marker Color Changed 

 Continue to change colors as preferred.  
 

NOTE: If there are multiple instances of an event on the graph, the color change will be applied to all instances of the 
event. For example, if there are three Cough events on the graph and one is selected for color change, then the other two 
will also change color. 
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 SELECTING/UNSELECTING EVENTS FOR PRINTING 
The operator can select events and values for printing in the test results. To have all the events included on the test result 
printout click Select All!  All events will be selected as shown in the Printable column where all boxes will be checked.  To 
select specific events for inclusion click on check box in the Printable column.  To exclude all the events from the printout, 
click UnSelect All!.  Refer to the Printable column of Figure 106.  
 

7.6.8 VOIDING SUMMARY 
The Voiding Summary menu item applies only to tests involving Uroflow information like the Uroflowmetry and pressure-
flow procedures. The Summary compares a patient’s test results with normal values.  Statistical deviations are calculated 
using these standards and are intended strictly for comparison purposes and should not be used solely for diagnostic 
purposes. 

 IMPORTANT: Since this comparison is based on patient gender, the gender must be correctly entered in the Patient 
Information dialog box.  The software calculates the summary results only if the minimum voided volume is 55 ml. 

To access the Voiding Summary: 
Click Info from the menu bar and select Voiding Summary. 
 
* BOOI, BCI, and BE references index values (see page 196 for definitions) 
 

 
Figure 111: Voiding Summary Window 
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Voiding Summary Analysis 
The Voiding Summary printout supplies a comparison to the Nomogram tables. They are provided for both male and female 
patients on the same printout. The comparison is provided in a percent difference from the table value. Following is the 
mathematical formula used in the calculations: 
 

Peak Flow:  
( )

( ) %100
,

,
∗

−
SexVolumenPeakFlowMi

SexVolumenPeakFlowMiPeakFlow
 

 

Mean Flow:  
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,
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−
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Time To Peak Flow:  
( )

( ) %100
,

,
∗

−
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FlowTimeToPeakSexVolumexFlowMaxTimeOfToMa
 

 
These percent values are found in the patient statistics of the Voiding Summary printout. The M% represents the male 
values and the F% represents the female values. 
 

 WARNING: The comparison with normal parameters should not be used for diagnostic purposes. It is recommended 
to repeat the study if the total voided volume is inferior to 55 ml; normal parameters are not available below this volume. 
Statistic values cannot be given if the voided volume is less than 55 cc and more than 555 cc.  
 

NOTE: Parameters of urinary flow were analyzed from 150 curves from subjects between 20 and 40 years old. The 
minimum normal for a given volume appears to be the most practical value with which to compare patient flow rate. 

 UROFLOW OPTIONS DIALOGUE BOX 
The Uroflow Options dialog box is available from the Voiding Summary Menu.  Click the Options button to launch the 
dialogue box.  From the Uroflow Options Dialog Box you can: 

• Customize how the Voiding Summary is calculated. 
• Make changes to the channels and configuration parameters. 

 
Refer to the following diagram and its legend to change any parameters in the Uroflow Options Dialog Box. 

 
Figure 112: Uroflow Options Window 
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Number Description 

1 Default channels: Flow, Volume, and Pressure. 

2 Range: Default range is from start to end of test. 

3 
Threshold: The minimum flow rate value used in calculating the Voiding Summary. Anything below this 
threshold is considered noise or insignificant flow. The minimum flow rate value used in calculating the 
Voiding Summary. Anything below this threshold is considered noise or insignificant flow. 

4 Enable Artifact Recognition: Select check box to enable.   

5 Artifact Recognition Threshold: Indicates the maximum acceptable change in Flow (acceleration) that is 
physiologically possible. 

6 Auto Event Marking: Automatically adds events to graph. 

7 
 

Auto Recording: With Auto Recording on, tests are automatically started and stopped once the 
transducer senses fluid in the beaker. 

8 
 

Auto Voiding Summary: A Uroflow auto recording option to display Voiding Summary after a test is 
finished. Auto recording must be enabled for this to work. 

9 
Auto Patient Info Prompting: A Uroflow auto recording option to display the Patient Info window when a 
test is stopped. A Uroflow auto recording option to display the Patient Info window when a test is 
stopped. 

10 Auto Filing: An auto recording option to save a file when a test is stopped. 

11 Auto Printing: An auto recording option to print a file when a test is stopped. 

12 Auto Display Print Option: An auto printing option to display print option before auto printing. 

Table 23: Uroflow Options Window – Settings Description 

To change a Channel: 
 Click the dropdown menu of the channel to be changed and a channel list will appear. 
 Select the appropriate channel name.    

NOTE: Normally the default settings for threshold are not changed for performing Uroflowmetry on patients. Consult 
with your LABORIE representative for modifications to default settings. 
 
The calculating channels may be replaced with other channels if the units are consistent in definition.  Example: “Flow” 
may be replaced with another math channel depicting corrected flow rate. 

To change the Time Range: 
 Click Change.  The Uroflow Options window will appear for segment selection. 

 
Figure 113: Uroflow Options Window – Time Range Selection 

 Click and drag the mouse pointer across the graph window from the start to the end of the Uroflow segment.  A 
bold black line will run across the top of the box indicating the selection.  

 Release the mouse button and the start and end lines of the segment will be updated. 
 Click Confirm to save changes or click Cancel to cancel changes and return to the Uroflow Options window. 
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Artifact Recognition  
This refers to the detection of non-physiological transducer readings.  For example, if a patient kicks the transducer, the 
curve indicates a very high spike. The height of the spike is “unnaturally” high and therefore the UDS software recognizes 
the event as a deviation from what it considers a normal reading. 

 

To enable the software to recognize Artifacts: 
Select the Enable Artifact Recognition box and a checkmark will appear in the box indicating that the software will detect 
artifacts. 
 
The Threshold check box in the Artifact recognition box indicates the speed of flow.  The defaulted rate of flow is 45.0 
ml/s/s. That rate means that if the speed of flow accelerates more than 45.0 ml/s/s, it is considered an artifact. When an 
artifact is detected, the Voiding Summary calculation will ignore the next set of data. 
 

To change the Acceleration Rate Threshold for Artifact Recognition: 
 Double-click the Artifact Recognition Threshold box.  The value in the text box is highlighted. 
 Enter a new value. The software recognizes the new value in the Threshold text box as the maximum rate of flow 

over which it considers an artifact. 
 Click Confirm to save changes or click Cancel to cancel changes and return to the Voiding Summary window. 

 

Uroflow Auto Recording 
The Uroflow Auto Recording feature is used for Uroflow or Pressure-Flow studies. It will automatically start a procedure. 
 
This feature provides Auto Start, Auto Stop, and Auto Set Up of the next procedure. Selecting the Auto Recording option 
in the Uroflow Options window allows this feature. Once selected, choose other customizable auto options. The options 
are performed in the following order: 
 

Options Always 
On/Selectable 

Description 

Auto Beaker 
Detection 

Always On After selecting this procedure, it detects if a beaker is on the Uroflow 
transducer. If no beaker is put on, it will display the message Beaker 
lifted up in the title bar. 

Auto Set Zeroes Always On Once a beaker is detected for eight consecutive seconds, zeroes are 
automatically set. If the beaker is lifted up after zeroes are set, detection 
will restart. 

Auto Start Always On The test is automatically started if an increase in volume is detected 
after the beaker is settled. 

Auto Stop Always On The test is automatically stopped 50 seconds after flow stops. 

Auto Patient Info 
Prompting 

Selectable Automatically displays the Patient Info dialog box. 

Auto Calculation Always On Automatically calculates the Voiding Summary. 

Auto Voiding 
Summary 

Selectable Automatically displays the Voiding Summary window if Voiding 
Summary is valid. 

Auto Filing Selectable Automatically saves the test in the form YYMMDDxx.QTA 

Auto Printing Selectable Automatically selects the test for printing. 

Auto Display Print 
Option 

Selectable if Auto 
Printing on 

Automatically displays the Print Option dialog box for 
confirmation/customization. 

Auto Set up next test Always On Automatically sets up the next test. 

Table 24: Auto Recording Options 
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Pediatric Nomogram (Optional) 
The Pediatric Nomogramviii feature can be accessed from the Voiding Summary window. This is based on the work of Dr. 
Churchill at the Hospital for Sick Children in Toronto. The Nomogram is a plot of Peak Flow vs. Voided Volume and the 
center curve represents the Mean. The patient’s flow data is represented by a circled dot on the graph. As a result, a normal 
flow curve is age and gender related. 
 

NOTE: This feature is available only if the patient is between 3 to 16 years of age. 
 
To access the Pediatric Nomogram Feature: 

 Click Pediatric Nomogram in the Voiding Summary window.  The Pediatric Nomogram window will appear 
(Figure 114). 

 
Figure 114: Pediatric Nomogram Window 

 
 View data in the Pediatric Nomogram and adjust settings as necessary in the window’s toolbar.  

d. Change the font by using the Font menu. 
e. Change the scales by using the Options menu. 
f. Close the Pediatric Nomogram window by clicking Exit!. 
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7.6.9 UPP SUMMARY 
UPP start and stops are marked as events on the UDS screen.  Pass the pointer over a UPP start or stop event and a ToolTip 
will display the event names (Figure 115).  Reposition the event by clicking the line and moving it along the graph to a new 
location. 

 
Figure 115: UPP Test Window – Event Markings 

To open a UPP summary: 
Click Info from the menu bar and select UPP Summary.  The UPP Summary window will appear (Figure 116). Each column 
on the UPP Summary window represents a segment of the UPP test.  From Pull start to Pull stop is one UPP segment or Pull 
1.  Additional Pulls are recorded in their own sequentially named columns (Figure 116). 

 
Figure 116: UPP Summary Window 

The UPP Summary window contains the following information: 

• Length: Length of the urethra (functional length).  The UDS software calculates the urethral length by multiplying 
the withdrawal rate by the period of the functional segment of the graph.  

 IMPORTANT: The recommended withdrawal speed is approximately one millimeter per second. 
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• Start: Starting time of the pull 
• End: Terminating time of the pull 
• Peak Pclo: Maximum urethral closure pressure 
• Obstruction Zone Peak: Maximum pressure at observed obstruction (see page 101 for more information)  
• Length of the Continence Zone: Distance between the bladder neck and the highest pressure point in 

profile 
• Area of the Continence Zone: Area under the Length of Continence Zone 

For information on the Preview button and its function, refer to the Config menu, UPP Tab on page 70. 

To select and modify a segment for analysis: 
 Click the column heading (Pull 1, Pull 2, etc...) of a UPP pull.  The start and stop times will be highlighted in green, 

and the graph on screen will scroll to the end position of the selected UPP pull.  
 Click the Auto Detect button to automatically adjust the start and end range or manually move one of the UPP 

start or stop events on the UDS screen.  The events are updated on the screen and in the UPP Summary window. 

NOTE: Select up to eight segments for UPP calculation. 
 

To change the Puller Speed, Measuring Channel, and/or Threshold: 
1. Click the Configure button on the UPP Summary window.  The UPP Config box will appear. 
2. Click the text box of the data field to be changed and enter the new data. 
3. Click OK.  The data fields are updated and the UPP Config dialog box closes. 

Refer to the UPP Tab section in the Config Menu on page 70. 

 

To print the UPP Summary: 
1. Click File > Print Study. 
2. Select UPP Summary from the Preferences section on the left side of the window. 
3. Select UPP Sections from the Print Range section. 
4. Select the desired segments. 
5. Click OK to print. 

Refer to the Print Study section on page 58 for more information on printing options. 
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Obstruction Zone Peak 
Set the maximum pressure at an observed obstruction point. This setting will recalculate the peak pressure point. 
 

To set the UPP obstruction zone: 
  Right-click inside a UPP range on the graph and the context menu will appear. 
 Select UPP End Obstruction Zone from the context menu (Figure 117). 

 
Figure 117: Context Menu – Obstruction Zone 

 
 

 The UPP obstruction zone will be marked on the graph as an event annotation in the format UPPXeObstruction 
(where X represents the UPP segment number). The original peak pressure event is recalculated between this new 
event and the UPP stop event, which becomes the UPP peak pressure for Functional Zone. A new peak event is 
also added called Obstruction Zone Peak 1.  Refer to Figure 118. 
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Figure 118: Selecting Obstruction Zone 

 
 Both peak events are movable. “Obstruction Zone Peak” parameters are shown in the UPP Summary as well as 

printed on the UPP Summary report. 
 

Re-marking UPP Segments 
The UPP segments mark automatically when using the Start Pull and Stop Pull Control Panel buttons to perform the UPP 
test.  Each UPP performed with these Control Panel buttons creates three unique events on the graph named UPP Start X, 
UPP Peak X, and UPP Stop X (where X is the Pull #).  The first UPP pull will be assigned number 1 with each additional Pull 
assigned a sequential number.  UPP events for the first Pull will then be named UPP Start 1, UPP Peak 1, and UPP Stop 1 
automatically (Figure 119). 

 
Figure 119: Urethral Pressure Profile Test 

To re-mark the UPP Segments: 
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 Remove the UPP Segment that requires re-marking: 
a. Right-click on the UDS graph to open a context menu. 
b. Click the UPP Segments option from the context menu to view all the UPP Pulls marked on the graph 

(Figure 120).   

 

Figure 120: UPP Segments Menu 
c. Uncheck the UPP pull requiring re-marking and the event markings corresponding to that UPP pull will be 

removed from the graph.  Figure 121 shows the removal of event markings for UPP1. 
 

 
Figure 121:UPP Segment Window – Removing UPP Events 
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 Select the UPP segment for re-marking.  Left-click on the UDS Graph before the UPP pull requiring marking and 
drag the mouse to the end of the UPP pull to highlight the segment in black. 

 
Figure 122: Marking a UPP Segment 

 Right-click on the highlighted section of the graph to open the context menu.   
 Click UPP Segments in the context menu and select an unused UPP Segment.  UPP Start, UPP Peak, and UPP 

Stop events are added to the graph for that pull (Figure 124).  Figure 123 shows remarking of UPP 1.   

NOTE: Used segments are indicated by a check mark beside the segment name. 

 
Figure 123: Adding the UPP Segment 

 
Figure 124: UPP Events Added 

 
 

newly selected segment 
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 Verify the UPP Summary (found under the Info menu) is updated with the newly marked UPP pull information. 

 
Figure 125: UPP Summary – Updated Segmens 

7.6.10 BLADDER COMPLIANCE (OPTIONAL) 
Bladder Compliance is commonly calculated using events from the filling stage of a study. The Bladder Compliance 
feature is available once a CMG or Micturition test has been performed. The feature enables the selection of study segments 
for analysis using the Bladder Compliance Calculation.  The user can select marked events from any stage of the study. 
 
NOTE: Bladder Compliance calculation/configuration can only be performed with English language software. The 
calculation results are expressed in ml/cm H2O. 
 
Bladder compliance is calculated as: 

ΔVH20    change in bladder volume 
Δ Pdet            change in Detrusor pressure  

 
Segment selection for calculation of Bladder Compliance can be completed manually or automatically.  Manual selection 
must be completed through the Info menu.  Automatic Bladder Compliance settings are available in the Configuration 
window which can be accessed through the Info Menu or the Config Menu.  Refer to the Compliance Tab section on page 
76 for more information on the Configuration window.  Refer to subsections below for instructions on selecting segments 
for Bladder Compliance Calculation. 
 

 MANUAL BLADDER COMPLIANCE 
 
Click the Info Menu and select Bladder Compliance.  The Compliance Measurement Range window will appear.  Each 
compliance measurement is defined by a start and end segment. The segments are differentiated by color. 

 
Figure 126: Compliance Measurement Range Window 

= 
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To Manually Select a Segment for Analysis: 
 The Compliance Measurement Range widow facilitates the manual selection of segments for Bladder Compliance 

calculation.  Select a name assignment by checking one of the checkboxes from the segment list (ex. Segment 1). 
 Click and drag the pointer across the graph window from start to end of the desired segment.  A bold black line 

will run across the top of the box, indicating the selection. 
 Release the mouse button.  The "end" of the segment is selected. The time of the selection appears.  
 To modify the selected segment, reselect. 
 To keep the selection and return to the test click Confirm.  The Compliance Calculation is displayed as an event 

in the Event Summary  
 To undo changes, deselect any segments and click Cancel.  All changes are discarded, and the Compliance 

Measurement Range window will close. 
 To add additional segments for Bladder Compliance calculation, select a new segment name (ex. Segment 2) 

and repeat the procedure. 

   AUTO COMPLIANCE (OPTIONAL) 
The Auto Compliance feature automatically calculates bladder compliance segments and calculations instead of having to 
manually select the segments from the graph. Click the Configure button in the Compliance Measurement Range window 
to open the Configuration window to the Compliance tab.  The Configuration window can also be accessed from the Config 
menu, Config > Configuration window > Compliance tab; refer to the Compliance Tab section on page 76.  
 
The Compliance tab provides three Compliance Methods: Manual, Auto: Events, and Auto: Infusion / 100ml.    Refer to 
Figure 127 for a visual of the Compliance tab and its menus: 

 
Figure 127: Configuration Window - Compliance Tab  

Select Channels 
Specify Volume and Pressure Channels (Figure 128).  

 
Figure 128: Compliance Tab – Specify Channels 

NOTE: By default the change in volume is calculated from the VH20 channel and the change in pressure from the Pdet 
channel. 

Compliance 
Method 

Auto Compliance 
Calculation Method 

Selected Compliance 
Events 
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Select Auto Compliance Method 
• Manual – Selection of this option will grey out Auto Compliance Calculation Methods; manually select the 

segments for calculation as instructed in the Manual Bladder Compliance section on page 105.  
• Auto: Events – Selection of the Auto: Events option necessitates setup of the desired Auto Compliance 

Calculation Method. 
• Auto: Infusion/100mL – Selection of this option sets Infusion volumes of 100mL as the auto compliance 

calculation reference points. 
Refer to Figure 129. 

 
Figure 129: Compliance Tab – Compliance Method 

Select the Auto Compliance Calculation Method 
Auto compliance calculation methods allow the software to automatically create segments based on test events instead of 
requiring the user to manually select segments from the graph post study.  For the software to automatically create 
segments, the user must set calculation start and calculation end events.  The Auto Compliance Calculation Method 
menu allows the user to select the desired start point of the segments.  The following options are available: 

•  Incremental – compliance segments are created between events selected from the Selected Compliance 
Events listing on the right-hand side of the screen. 

• Average from 0 – compliance segments are created from time zero of the test to the events selected from 
the Selected Compliance Events listing on the right-hand side of the screen. 

• Average from PVR – compliance segments are created from the point where VH20 = PVR entered at the end 
of the pressure flow test (mL). 

• Average from Event – Compliance segments are created from the test event selected from the dropdown 
menu. 

Refer to Figure 130. 

 
Figure 130: Compliance Tab – Auto Compliance Calculation Method 

 

Select the Compliance Events. 
For use with Auto compliance methods only. Use the Select 
Compliance Events menu to select the calculation end events. Select 
the checkbox of the desired events (Figure 131).  
 

NOTE: Remember to save the configuration by clicking Save As 
then Save. 

 
Figure 131: Compliance Tab – Select 

Compliance Events 
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7.6.11 UPP 
This option contains optional software features such as Eberhard Curves and Pressure Transmission Ratio. 

 EBERHARD CURVES 
The Eberhard feature measures the static and stress UPP profile for female patients.  This feature in the UDS software is 
based on the work of J. Eberhard and P. Lienhard.ix A complete copy of this article is available upon request. 

To access the Eberhard Curves Feature: 
 Click Info > UPP. 
 Select Eberhard Curves.  The Eberhard Curve Options window will appear (Figure 132). 

 
Figure 132: Eberhard Curves Options Window 

 Select the Static and the Stress UPP portions of the graph. 
 Click OK.  The Eberhard window opens to display the curves along with Total Urethral Length, Pressures, 

Functional Urethral Length, and change information. 

Configure Static UPP: 
 Click the Configure button in the Static section of the Eberhard Curve Options window to open the Range 

Selection window. 
 Select the range for calculating the static UPP Segment by clicking on the graph at the starting point of the range, 

holding the left mouse button down, and then dragging the mouse across the graph until you reach the end of 
the segment. Once the end of the segment is reached release the mouse button (Figure 133). 

 
Figure 133: Select Range for Static UPP 
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 The segment will be marked by red lines to the left- and right-side along with a black line across the top to 
highlight the selected portion of the graph.  If the selected segment is incorrect, click Cancel and select a new 
segment. 

 Click Confirm to return to the Eberhard Curve Options window. 

Configure Stress UPP: 
 Click the Configure button in the Stress section of the Eberhard Curve Options window to open the Range 

Selection window. 
 Select the range representing the dynamic UPP Segment by clicking on the graph at the starting point of the 

range, holding the left mouse button down, and then dragging the mouse across the graph until you reach the 
end of the segment. Once the end of the segment is reached release the mouse button. 

 
Figure 134: Select Range for Stress UPP Window 

 The segment will be marked by red lines to the left- and right-side along with a black line across the top to 
highlight the selected portion of the graph.  If the selected segment is incorrect, click Cancel and select a new 
segment. 

 Click Confirm to return to the Eberhard Curve Options window. 
 

Access Eberhard window 
 From the Eberhard Curve Options window click OK, Info > UPP > Eberhardt Curve > OK.  The Eberhard 

window will open to display the curves along with Total Urethral Length, Pressures, Functional Urethral Length, 
and change information (Figure 135). 
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Figure 135: Eberhard Summary 
 

 Click Print! in the upper-left of the window to print a copy of the curve results. 
 Click Exit! to close the window. 

 PRESSURE TRANSMISSION RATIO  
The Pressure Transmission Ratio (PTR) feature is available after a test with Pves and Pura is completed (For example, a UPP 
test).  Pressure Transmission is a ratio of pressure that is “transmitted” from the bladder to the urethra during a cough.    
Pressure Transmission is calculated from the Pves and Pura channels.  

The PTR formula is: 
     ∆ Pura 

% PTR      =      X   100% 
∆ Pves  

Where: 
• ∆ Pura refers to the change “from baseline” in urethral pressure during a cough 
• ∆ Pves refers to the change “from baseline” in vesicle pressure during a cough 
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Methods for Calculating PTR 
In the Pressure Transmission window there are three methods provided for calculating PTR: Basic PTR, UPP Segments, 
Manual PTR.  To launch the Pressure Transmission window, click Info > UPP and select Pressure Transmission. 

Basic PTR: 
The Basic PTR feature is the simplest method to identify coughs because this feature allows you to perform calculations for 
all coughs during the test.  To configure Basic PTR follow the instructions provided below: 
 

  Click Info > UPP and select Pressure Transmission to launch the Pressure Transmission window (Figure 136). 

 
Figure 136: Pressure Transmission window  

 Select Basic PTR in the Pressure Transmission window and click OK.  The PTR Segment Selection box will 
appear (Figure 137).  

 
Figure 137: Basic PTR - PTR Segment Selection Box 

 Verify that the entire test is selected as a segment and click Confirm. 
NOTE:  If more than one cough point exists in a study, LABORIE recommends to select separate segments 
instead of the entire test.  Basic PTR allows the selection of up to three segments. 

 To modify selected segments, perform one of the following options in the PTR Segment Selection window then 
click Confirm: 

a. Click the Auto Segment Detection button to have the software modify the segment. 
b. Manually modify the segment by clicking and dragging the pointer across the graph window from the start 

to the end of the desired segment. 
 

The system will automatically examine the Pves channel for any cough with an increase in pressure greater than 20cm 
H2O(Cough threshold).  These events are automatically marked and the pressure transmission ratio is calculated.  Review 
the pressure transmission ration in the Event Summary. 
 
If more than one cough point exists in a study, LABORIE recommends use of the segment selection feature. This allows 
selection of up to three segments of the study to be calculated for PTR. 
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PTR on UPP Segments  
The PTR on UPP Segment feature is only available when UPP segments exist. Coughs will be calculated only for the UPP 
segments of the test. 
 
To access UPP Segments: 
The UPP Segment PTR feature is only available when UPP segments exist.  Refer to the UPP Summary section on page 99 
for information on UPP Segments.  Coughs will be calculated only for the UPP segments of the test.  To configure UPP 
Segments follow the instructions provided below: 
 

1. Click Info > UPP and select Pressure Transmission to launch the Pressure Transmission window (Figure 136). 
2. Click UPP Segments and then click OK.  The PTR Segment Selection window will appear displaying UPP 

segment(s). 
3. Select the segment check box. 

4. Modify segments by performing one of the following options: 

a. Click the Auto Segment Detection button to have the software modify the segment. The “end” of the 
segment will be selected. 

b. Modify any segments by clicking and dragging the pointer across the graph window.  Release the mouse 
button.  The segment times will be updated. 

5. Review selections.   
a. To remove changes, deselect any segment and click Cancel to return to the Pressure Transmission window.   
b. To keep changes click Confirm.  The pressure transmission ratio will be calculated and the user will be 

returned to the test.  To review data access the event summary. 

Manual PTR 
Manual PTR allows you to customize the cough point selection.  It also allows each Pura and Pves peak to be zoomed in 
and modified accordingly. This is the most accurate method of calculating PTR.  To configure Manual PTR follow the 
instructions provided below: 
 

1. Click Info > UPP and select Pressure Transmission to launch the Pressure Transmission window. 
2. Select Manual PTR from the Pressure Transmission window and click OK.  The Pressure Transmission window 

closes. 

2. Click on a peak in the Pves or Pura channel.  A window appears with a close-up view of the peak and the value 
of its Peak, Base, and Height.  The graphic representation will show a white bullet for start and end points on 
the graph.  

 
3. To adjust the Position of the Peak, Base, Height, and PTR in the window: 

a. Click the white bullet to the left of the cough that indicates the starting point of the peak.  Drag the bullet 
to the desired starting point.  The starting point of the cough is modified.  Repeat the same to change the 
end point of the cough to the right of the cough.  The Peak, Base, and Height automatically recalculate. 

b. Click Next to adjust start and end points of the peak for the other channel (Pves or Pura). 
c. Review edits and once confirmed click OK.  The window closes and the pressure transmission ratio is 

displayed as an event in the Evet Summary.  To review data, refer to the Event Summary. 
 

4. In the window described in step 2, click OK to manually select another cough point or click Cancel to return to the 
test. 

7.6.12 ARM 4&8 (OPTIONAL) 
Refer to the ARM 4 and ARM 8 Channel Test Results section on page 155. 
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 VIEW HOR. MENU 
The View Horizontal Menu provides resize options that will scale down or up the graphs shown in the scrolling graph section. 
The default zoom size is 1X or 100%. 
 

NOTE: You can also set the zoom level by clicking the pop-up list located on the lower-right side of the UDS screen.  

To modify zoom: 
 Click View Hor. from the menu bar.  The Zoom dropdown menu will appear. 
 Click one of the settings.  Refer to Table 25 to determine the appropriate scale.  The test will scale to the size 

selected. The selected setting is saved when the test is saved. 

Setting Display 

25% 1/4 of the default zoom size 

33% 1/3 of the default zoom size 

50% 1/2 of the default zoom size 

1X Default zoom size 

2X Double the default zoom size 

3X Triple the default zoom size 

4X Quadruple the default zoom size 

Full Screen Whole test compressed on single screen 

Full Screen On Stop Whole test compressed on single screen once Stop button is clicked. 

Custom 
 
 
 
 

Zoom Custom box for whole test on single screen OR 
customized zoom preference between 1 – 500 %:  
 

. 
Table 25: Horizontal Scaling 

 OPTIONS MENU 
The Options menu activates and accesses miscellaneous functions of the software. 

7.8.1 TEST RESTART 
The Test Restart feature restarts a procedure from the beginning of the test.  Sometimes when the patient coughs, 
sneezes, or kicks the transducer during a test, a re-evaluation is required. 

To restart a test procedure: 
• Click Options on the menu bar and select Test Restart. 

7.8.2 TEST PLAYBACK 
The Test Playback feature enables a pre-saved test to be viewed again like a recording.  After the test is complete, it may 
be viewed by using the playback feature.  The playback speed may be different from when it was recorded. 
Click Options and select Test Playback.  The test will play from the beginning of the test and runs until the procedure is 
over. 

• To Pause the test, click Stop. 
• To Resume playback, click Test Playback. 
• To exit the playback mode, click Options then select Test Playback. 
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7.8.3 UROFLOW AUTO START 
Another method of starting a test using the Goby™ is selecting the Uroflow Auto Start option. It enables the recording 
process as soon as the Urocap™ IV detects the first flow of data.  This selection is appropriate for Uroflowmetry studies in 
instances where the patient requires privacy before and during Micturition.  
 
To set up Auto Start for a Uroflow test: 

• Click Options from the menu bar and select Uroflow Auto Start. 

7.8.4 CURSOR VALUE INDICATOR 
The Cursor window displays the exact location of the mouse cursor and the values of each channel at that location. This 
feature is particularly useful for marking events and reviewing test data.  
 
 

To access the Cursor window: 
Click Options from the menu bar and select Cursor Value Indicator 
-or- Press the F9 key on the keyboard.  This will launch he Cursor 
window (Figure 138). 

 

 
Figure 138: Cursor Window 

 

To move the Cursor Window: 
 Click the title bar on the Cursor window. 
 Drag the window to the desired location on the screen. 
 Release the mouse button. 

 

To cancel the Cursor Option: 
• Click Options and select Cursor Value Indicator -or- Press 

the F9 key on the keyboard. 

 

7.8.5 DIGITAL VALUE INDICATOR 
The Digital Value window displays the data of channels with digital attributes. While all channels will print as curves, the 
screen can display a maximum of eight channels at one time. If more than eight channels are used, additional channels 
may be displayed as digital or overlay. Digital channels are displayed in the Digital window, while curves of overlay 
channels are displayed on the channels in which they overlay. 

To set the Digital Attributes of Channels: 
 Click Config > Set up/Modify. 
 Select the Display Digital attribute in the Display Attribute column. 
 If necessary, repeat for other channels. 
 Click OK. 

To switch the Digital Window On/Off: 
Click Options on the menu bar and select Digital Value Indicator or press F8 on the keyboard. 
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7.8.6 DISPLAY CONTROL PANEL 
The Display Control Panel menu items allows you to display or hide control panel buttons.  The default mode is to display 
control panel buttons. 
To remove the control panel function buttons, click Options > Display Control Panel and the buttons disappear (Figure 
139).  To restore control panel, click Options > Display Control Panel and the buttons will reappear. 
 

 
Figure 139: Scrolling Graph – Control Panel Hidden 

7.8.7 CONTROL PANEL SETTINGS 
The easy accessibility of the Control Panel buttons is a convenient feature of the UDS software. The Control Panel 
Settings dialog box allows the Control Panel to be configured with various function buttons, and modifies the definitions 
that are assigned to event-type buttons.  

There are seven Control Panel buttons on each row. The number of rows can be modified if desired. For a list of button 
labels and definitions, please refer to the last section in this chapter — Glossary of Control Panel Commands on page 
119. 

NOTE: There are seven buttons on each row; the last two buttons of the first and second rows are reserved for 
system use. You can program the rest of the buttons. 

 
To configure the Control Panel: 

The Control Panel provides quick access to events, tests and features during a study. There are five basic control panels 
already configured in the software.  Custom control panels can be configured if desired. There are seven buttons in each 
control panel row; the number of rows can be modified if desired.  Use the Command window to select the group of 
buttons available for procedures in the Control Panel. 

To configure the Control Panel: 
1. Click Options from the menu bar and select Control Panel Settings.  The Command window will appear 

displaying the first row of Control Panel buttons (Figure 140). 
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Figure 140: Command Window 
 

2. Change the Label, Definition, and command type. 
a. To change the Name of the function button, double-click the entry in the label column and enter a new 

name (entered text will be displayed on the Control Panel button in the UDS Client screen). 
b. Change the definition for the button by clicking the appropriate box under the Definition column.  Type 

the new definition into the field.   

 IMPORTANT:  The meaning of the definition depends on the type of Control Panel Button. 
c. Change the command type by clicking on the drop-down arrow of the appropriate combo box.  Select 

the appropriate function command type. 
 

3. Click the down arrow of the Current Row field to move to the second row of buttons.  Repeat configuration 
steps until Label, Definitions, and command type fields are set for all Control Panel buttons.  

4. Click OK when all buttons are configured. 

 IMPORTANT: The Control Panel Set last used before the UDS software closes is saved as the Default Control Panel 
set and is automatically loaded when the UDS Client is restarted. 
 
The Button Height slider can be used to adjust the size of the buttons in the Control Panel. Slide it to the right to increase 
the size of the button. 

 MULTIPLE CONTROL PANEL SETS AND HOT KEY CONFIGURATION 
Multiple Control Panel Sets can be set up in the UDS software.  This allows multiple users to create their own customized 
Control Panel that can be selected for use before beginning testing. Up to sixteen Control Panel Sets can be set up in 
addition to the Default Control Panel Set.   

To Configure New Control Panel Sets: 
 Click Options > Control Panel Settings. 
 Type in a new name in the Control Panel Set Name box.  A maximum of 15 characters (including spaces) can be 

used for the name.  To duplicate an existing configuration for customization, select the applicable control panel 
from the Control Panel Set Name box and enter a new name. 

 Customize the Control Panel buttons. 
 Click OK to save the Control Panel Set.  The new settings are saved and ready for use. 

To use another configured Control Panel Set: 
 Click Options > Control Panel Settings to launch the Control Panel Command box. 
 Click the drop-down button of the Control Panel Set Name box and select the appropriate name. 
 Click OK. 

 
In addition to Control Panel Configuration, the Hot Key feature allows the creation a shortcut key combinations for control 
panel buttons. 
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To configure the Hot Keys: 
1. Click Options > Control Panel Settings. 
2. Click the P button next to the control panel button (Figure 140). 
3. The Properties window will appear (Figure 141).  Select a key 

combination that will correspond to the control panel button. In our 
example, we will apply a shortcut key combination of CTRL+R to the 
First Sensation button. 

4. Click OK. 
Mark the event during a test using either the control panel button or the shortcut 
key.  
 

 
Figure 141: Properties Window 

 CONFIGURE BUTTON PROPERTIES 
To configure control button properties, click the P button next to a Control Panel button in the Command window (Figure 
85).  The Properties window will load. 

To Configure Sound: 
Each button can be configured to play a unique sound when clicked. 

NOTE: The sound card must be installed on the PC to use the Sound feature. 

Open the Properties window by clicking the P button next to a Control Panel button. In our example the First Sensation 
button will have a sound file attached to it. 
 

 Select the Play sound when button clicked option from the Sound section of the Properties window. 
 Click Browse to retrieve the sound file. 
 Select the file and click Open to attach the file to the control panel button. 
 Click OK to exit the screen. 

Control Panel 
Select Auto Load Control Panel Set Name from the Control Panel section of the Properties window (Figure 142).  Select 
an option from the dropdown menu.  This setting will cause a default control panel to launch each time the configured 
control panel button is clicked. 

 
Figure 142: Set Auto Load Control Panel Set Name – Properties Window 
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Add an Image to a Control Panel Button 
Add an image to a control panel button to make it easily distinguishable from other buttons. 
To add an image to a button: 

 Click Options > Control Panel Settings. 
 Click the P button next to the control panel button. In this example we will add an image of a Uroflowmeter to the 

Uroflow button: 

 

Figure 143: Uroflow Button Properties window 
 

 In the Properties window, click the Browse button in the Image section to select the image: 

 

Figure 144: Adding Image to Label – Properties Window  
 Once the image is selected, click Open to add the image.  The name of the image file will appear in the image 

field within the Properties window. 
 Click OK on the Properties window, and then click OK to close the Command window. 

 
The image will now appear in the button on the control panel as shown in Figure 145: 

 
Before     After 

Figure 145: Edited Uroflow Button 
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Customize Colors and Fonts 
Click the Button Color button in the Command window to open the Select Color window.  Choose the background color 
and font for individual Control Panel buttons as well as the color of the button names.  Once complete click OK to save 
changes.  The chosen colors and fonts will display on the main UDS screen. 

To select the color and/or the text font for the buttons: 
 Click inside the colored box under the Text or Button column for the Button Type.  The Color window will appear. 
 Select the colors for the button and/or text. 
 Click the F button under the Font column and select the new font from the resulting font selection window. 
 Click OK.   
 Standardize coloring and fonts of all Control Panel buttons in the Select Color window.  In the All Buttons section 

at the bottom of the window, select the button property to change.  Click the rectangle next to the property to 
select the color or font.  Click OK and exit the Command window.  The chosen colors will display in the main UDS 
screen. 

 

 GLOSSARY OF CONTROL PANEL COMMANDS 
 

Suggested Button Label Definition Type Comments 

First Sensation 
First Urge 
Capacity 
Valsalva 
Cough 
Area Start 
Area End 

First Sensation 
First Urge 
Capacity 
Valsalva 
Cough 
AS:Pves:0 
AE: 

Event 
 
 
Event - Unique 

Marks an event with the definition 
text as Event Annotation. 
An event that occurs only once and 
will replace any existing recorded 
event.  

Uroflow 
CMG 
UPP 
Micturition 

Full path of CFG file 
      Example: c:\cfg\ 

Config Opens a .cfg file. 

Slow Fill 
Medium Fill 
Fast Fill 
 
XXX ml/min 
+YY ml/min 
 
-ZZ ml/min 
 
Reverse Slow Fill 
Reverse Medium Fill 
Reverse Fast Fill 
 
Start Pump 
 
 
Resume Pump § 

SF 
MF 
FF 
 
SP=XXX (where XXX is in 
ml/min) 
SP+YY (where YY is the 
incremental rate) 
SP-ZZ (where ZZ is the 
decremental rate) 
 
 
RSF 
RMF 
RFF 
 
Pumprunstop 
 
 
PumpRunStopResume 

Pump Command 
 
 
 
 
 
 
 
 

Controls the pump fill rate. 
 
 
 
 
 
 
 
Controls the reverse pump fill rate† 
 
 
 
Dynamic button to start/stop pump 
at medium fill speed. 
 
Used with speed control buttons. 
After the Stop Pump button is 
clicked the Resume Pump button is 
enabled. 

Auto Start N/A Auto Start Sets up Uroflow Auto Start 

Set Zeroes N/A Set Zeroes Sets all channels to zero. For setting 
EMG channel to zero see page 130. 

Pura = Pves    or 
Pabd = Pves 

Channel X = Channel Y 
    Example: Pura = Pves 

Equalize Sets the left channel value to the 
right. 
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Suggested Button Label Definition Type Comments 

UPP Return 
UPP Pull 
UPP Stop 

IN (returns the puller as fast 
as possible; for positioning 
the puller) 
 
PU (pulls at default UPP 
speed; stops when it reaches 
the tip)  
 
ST (stops the pull) 

UPP Command* 

Refer to the UPP 
Puller manual for 
more 
information. 

Controls the UPP puller speed. 

Start IC02 
 
 
Stop IC02 

ICO2=40 (start CO2 infusion 
at 40 ml/min) 
 
ICO2=0 (stop CO2 infusion) 

IC02 Command 
 

Pumps gas to fill bladder with CO2. 

Patient Info N/A Patient Info Opens Patient Info window. 

Rest 
Slow Waves 
MSP 
Compliance 
Expulsion 
XXcc 

(rest) 
(waves) 
(max) 
(comp) 
(exp) 
(XXcc) 

ARM Controls Anorectal Manometry 
procedures.  Refer to the Anorectal 
Manometry (ARM) Feature section 
on page 138 for more information. 
 

Resting Profile 
Squeezing Profile 
Squeeze 5 cm 
Squeeze 4 cm 
Squeeze 3 cm 
Squeeze 2 cm 
Squeeze 1 cm 
Rest 5 cm 
Rest 4 cm 
Rest 3 cm 
Rest 2 cm 
Rest 1 cm 
10 cc 
20 cc 
30 cc 
40 cc 
50 cc 
60 cc 
70 cc 
80 cc 
90 cc 
100 cc 
110 cc 

RE 
SQP 
ST5 
ST4 
ST3 
ST2 
ST1 
RT5 
RT4 
RT3 
RT2 
RT1 
10cc 
20cc 
30cc 
40cc 
50cc 
60cc 
70cc 
80cc 
90cc 
100cc 
110cc 
NOTE: type as is; do not add 
a space between the number 
and “cc”. 

ARM 4&8 Controls Anorectal Manometry 
procedures performed with 4 or 8 
pressure circumferential catheters.  
Refer to the Anorectal Manometry 
(ARM) Feature section on page 
138 for more information. 
 

Single 
Burst 
Manual 
 
Peak Image 

Single Capture 
Burst Capture 
Manual Burst 
 
Peak Burst 

Image Event 
 
Image Event- 
Unique 
 
Peak Image Event 

Defines buttons for use with UDS 
Video Software. 
 
Please refer to your video system’s 
Owner’s Manual for more 
information. 

Initialize Default Values 
Load File 
Save File 

(vbninitialize) 
(vbnloadfile) 
(vbnsavefile) 

VBN 
 

Optional feature for bladder 
modeling. Controls the functions 
of the VBN feature.  
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Suggested Button Label Definition Type Comments 

Draw/Remove Calc Curves 
Interpretational Help 
Patient Info 
Global Values 
Bladder Settings 
Sphincter Settings 
Urethra Settings 
Select View 
Animation Control Box 
Change Aspect Ratio 
Curve Adjustments 
Other Options 
Transfer to VBN 
Close VBN Windows 

(vbndrawremovecurves) 
(vbninterpretationalhelp) 
(VBNPatientFile) 
(VBNGlobalValues) 
(VBNBladder) 
(VBNSphincter) 
(VBNUrethra) 
(vbnchangeview) 
(vbncontrolanimation) 
(vbnaspectratio) 
(vbncurveadjustments) 
(vbnotheroptions) 
(vbnimportfile) 
(vbnclose) 

Please refer to the 
VBN section in this 
manual for more 
information. 

 
 

Please refer to the i-LIST 
Manuals 
 

Pre-set definitions i-LIST Config 
 
 
i-LIST Event 
(optional) 
 
i-LIST Command 
 
 
i-LIST Image 
Event 
 
 
i-LIST Event 
Unique 

Configures to the i-LIST software. 
 
Save the event into the i-LIST 
software. 
 
Send Command to i-LIST 
 
Save the event into the i-LIST 
software. 
 
Save the event into the i-LIST 
software. 
 

Please refer to the Evox 
Owner’s Manual 

Pre-set definitions Evoked Potential 
 
 

N/A 

Plot Pre-set with the selections 
made when button is 
configured 

Plotƒ Click the plot button to open the 
Nomograms that are applicable to 
the test being performed. 

Stress Test Stress Test Stress Test 
Command 

For stress leak tests. Refer to the 
Stress Events section on page 87. 

Main Menu 
 

Main Load CP Sets the default control panel for 
each time the UDS software starts. 

Summ. Review PFReview Load CP View the summary results control 
panel to review the current test. 

Zoom 2x  
3x  
4x 

Zoom Zooms in on the highlighted area 
of the graph when clicked. 

No required button labels.  
Action is applicable to all 
button labels. 

Cancel Settings of any Button 
Label 

None Cancel the control panel button 
action by selecting None in the 
button type field of the control 
panel. 
 

 

*Additional UPP commands include: 
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• PU XX (pulls the UPP puller XX millimeters at the default UPP speed; for example, PU 15 will pull the UPP 
for 15 mm at the default speed) 

• PUH XX (pulls the UPP puller XX millimeters as fast as possible; used for positioning the UPP puller) 
• IN XX (returns the UPP puller XX millimeters as fast as possible; used for positioning the UPP puller) 

 
You can set the puller to automatically stop or pull at preset intervals with the click of a button. When a UPP Command 
is selected in the drop list and the definition is either PU or IN, a pop-up box appears and you can select the interval at 
which the puller will stop. 

  
 

Click OK to set the interval. 
† The Reverse Fill pump feature runs the pump in reverse and is used during ARM testing when you want to quickly fill 
and then drain the large balloon that is used to provoke sensation. (If you program your pump commands as ff, mf, and 
sf, then you can add the rff, rmf, and rsf. If you program the commands as fast fill, medium fill and slow fill, then you can 
program the reverse as reverse fast fill, reverse medium fill, and reverse slow fill. IMPORTANT! Reverse Fill is not a 
feature meant to drain the bladder! It is to be used only for the draining of the large balloon during ARM testing! 

ƒ To define the plots that will be displayed: 
 Select Plot from the drop list in the command window. 
 Click the plus (+) button to open the selection box. 

  

 Select All and click OK. 
 Type the word Plot under the Label column to name the button. 
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 Click OK to set the button on the control panel. 

NOTE: When the Resume Pump button is clicked it will restart the fill at the last used rate. 
Table 26: Control Panel Commands 

 

7.8.8 ENABLE BUTTON SOUNDS 
By default, button sounds and commands are audible in the software. To mute the sounds, click Options > Enable Button 
Sounds to deselect the option. Click Options > Enable Button Sounds to turn the sound on again if desired. 

7.8.9 FILE SAVING DIRECTORY 
Use the File Saving Directory option to select the storage directory/folder for saving the UDS data files. 

To change the Storage Directory: 
 Click Options on the menu bar and select File Saving 

Directory.  The Change Data Directory window will appear. 
 Click Browse and select a new directory. 
 Click OK to close the Browse for Folder window. 
 Click the Create Dir. button to set the new directory. 
 Click OK to close the Change Data Directory window. 

Refer to Figure 146. 
 

Figure 146: Change Data Directory 

7.8.10 EXPORT DATA  
The Export Data option enables curve data to be exported in a text file format and used in another software program. 
 

 Click Options from the menu bar. 
 Select Export Data.  The Export window will appear with the 

default export file name (xxxx.out) and the whole test 
selected. 

 To change the file name, enter a new name for the text file 
in the available field (Figure 147). 

 To change the export range, enter new start or end times in 
the available fields.   

Figure 147: Export Window 
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 Click Export.  The text file is created and is ready to be 
imported into another software program (Figure 148).  

 

  
Figure 148: Exported Data - Notepad 

7.8.11 EVENT DISPLAY OPTIONS 
The event display options allow you to customize how events and peaks￼. 

To change how events and peaks are marked on a curve: 
1. Click Options from the menu bar and select Event Display Options. 

2. The Event Display Options window will load (Figure 149).  Select preferred options and click OK.   

The Guideline option displays a dotted line.  
The Annotation Abbreviation option displays the first two letters of the Even Annotation. 
The Channel Values option displays the value of that event on each channel. 

 
Figure 149: Event Display Options window 

7.8.12 SELECTING BACKGROUND COLORS FOR EVENTS 
This feature only applies to events configured with auto start and stop.  The background of events’ graphic range in the 
test selected can be highlighted using the Select Background Color of Paired Events button available on the Event 
Display Options Menu (Figure 149).   
 

 Click the Select Background Color of Paired Events button (Figure 149) to open the Event Properties window. 
 In the Select Paired Event dropdown menu, choose the type of test and select Show region for this event (Figure 

150). 

 
 

Figure 150: Event Properties – Select Paired Event 
 Click the Select Color button to open the color selection screen. 
 Select the background color for automatic events in the study. 
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 Once the color is selected, click Close to exit Event Properties and then click OK to close the Event Display 
Options window.  During the next test the graph will display a colored background where the events occur 
(Figure 151). 

 

 
Figure 151: Auto Event Background Color 

7.8.13 AUTO MARK PEAKS 
The Mark Peaks feature automatically marks peak events for each channel once the test is complete. 

• Click Options > Auto Mark Peaks to enable or disable the feature. 

7.8.14 AUTO INFUSION EVENT  
An Auto Infusion Event may be used in the filling phase of CMG or pressure-flow tests.  It marks an event after every 100 ml 
of liquid is infused into the patient’s body.  
 
Click Options from the menu bar and select Auto Infusion Event to enable or disable the event.  The Auto Infusion Event 
can be configured prior to beginning testing or while a test is running. 
 
If events are displayed on the curve, the auto infusion event appears as a “VH” at the top of the curve. The Event Annotation 
in the Event Summary will read “VH2O = XXX ml”. 

To cancel the Auto Infusion Event option, click Options > Auto Infusion Event.  For more information on displaying 
events, refer to the Events  section on page 86. 

7.8.15 GRAPH CLIPPING 
The Graph Clipping option “clips” the top and bottom of a curve if it exceeds the display scales of a channel’s display area. 
By default, this option is disabled and the curves can exceed the display area of a channel. 
NOTE: The channel scale range determines the height of the curve. 

To enable the Graph Clipping option: 
1. Click Options from the menu bar. 
2. Select Graph Clipping.  The curves will appear flat if they exceeds the channel scale range. 

 
Click Options > Graph Clipping to cancel the Graph Clipping option. 

7.8.16 SMART TRACING 
This feature allows the curves to be displayed like inked display where repeated data is re-inked. Lines that have repeated 
data will be displayed in a darker color. This feature is useful when a long test is compressed into a smaller display area. 

7.8.17 RESIZE OVERFLOW SCREEN 
Maintains the graph lines in the graph channels. 

UPP Start     UPP Stop 
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7.8.18 IMAGE OVERLAY (OPTIONAL) 
This is an optional feature in the UDS software. With Overlay, also called Image Overlay, you can run a live video image that 
will display under the graph on the UDS screen. This is available with the Video option of the software. 

7.8.19 CHANGE INFUSION BAG 
Use this menu item to replace an infusion bag during a CMG or Micturition test.  
The system automatically detects when the infusion bag is empty or occluded and will display a message asking for 
directions to continue.  Refer to the example in Figure 152.  

 
Figure 152: Infusion Bag Alert 

To change the bag before the system provides the alert, select the Change Infusion Bag item under the Options menu. 

To manually change the infusion bag during a test: 
 Click Options > Change Infusion Bag.  The pump stops and the graph will continue to scroll. A message box appears 

asking you to change the infusion bag. 
 Click OK. 
 Replace the bag and reconnect the IV tubing. 
 Click OK to resume testing.  The pump will continue with its normal activity. 

7.8.20 AUDIO 
This option contains the Audio Settings and Event Playback features. 

Audio Settings (Optional Sound Feature) 
This menu item is present only when the sound feature is enabled. Use this menu item to change sound recording 
parameters.  To change the Sound Recording Parameters: 

 Click Options > Audio > Audio Settings. 
 Make changes. 
 Click OK. 

Event Playback (Optional Sound Feature) 
Use this menu item to turn on/off audio playback for sound events.  

7.8.21 VBN  
This option contains the VBN Settings and VBN Overlay features. 

VBN Settings 
If you have VBN enabled in the software, you can set the catheter size used so that the renderings in VBN are correct. 
 

 Click Options > VBN > VBN Settings to open the VBN settings window. 

  
Figure 153: VBN Dialog Window 

 
 Type the size of the catheter (between 0 and 15) and click OK. 

VBN – Normal Curve Overlay 
This is a normalized Flow curve that is overlaid on the patient’s Flow curve after a Uroflow or Pressure/Flow test. It provides 
a basis of comparison between the normal flow curve (for the patient’s gender and voided volume) and the patient’s actual 



LABORIE AQUARIUS XT/CT/LT/CTS Owner’s Manual   AQS-UM01   127 

flow curve. The match to the normal curve is visible in the shaded area under the curve (Figure 154).  The normal flow curve 
is recalculated if the gender entry is changed in the patient info screen. 

 

Figure 154: VBN Curve 

By default, the VBN curve is visible once selected from under the Options menu.  When VBN – Normal Curve Overlay is 
selected in the menu, a check mark will be displayed next to the item.  To hide the curve, click Options > VBN >VBN – 
Normal Curve Overlay.  The check mark will disappear.  

7.8.22 I-LIST (OPTIONAL – FOR I-LIST SOFTWARE USERS ONLY) 
The UDS Software will transfer the data to the i-LIST Message Queue. 
To transfer data to iList from the scrolling graph: 

 Right-click on the graph and select the Export to i-LIST menu item.  
 Click on the name of the event to export (Figure 156). 

 
Figure 155: Export to i-List – Context Menu 

 Save the test file. The UDS software will automatically transfer files to the i-LIST Server. 
 
To see if file transfer was successful: 

 Click Options > i-List > MSMQ Monitor. 
 Once the i-List MSMQ Monitor window is displayed, click Options > Enable MSMQ Logging. 
 A message of successful transfer and receipt is visible in the i-List MSMQ Monitor window (Figure 156). 
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Figure 156: iList MSMQ Monitor 

 PUMP MENU 
The Pump Menu provides access to configuration and filling controls.  

7.9.1 CONFIGURE PUMP 
Use the Configure Pump option to customize the pump options.  
 

 

The Prime rate feature runs the pump at the speed set in the prime box in the Configure Pump screen. The 
default speed is 150 ml/min. 

 
To configure the Pump: 

 Select Configure Pump from the Pump Menu.  The Configure Pump screen will appear. 
 Select Customizations.  Refer to Table 27 for descriptions of settings available. 

  

Feature Function 

Volume Channel Specifies the infusion volume channel 

Pressure Channel Specifies the channel used for pressure feedback 

Slow (rate speed) Determines the slow speed of the flow rate 

Medium (rate speed) Determines the medium speed of the flow rate 

Fast (rate speed) Determines the fast speed of the flow rate 

Prime (rate speed) Determines the prime speed of the flow rate 

Pressure Limit 
Stops the pump if the pressure channel exceeds this limit. CAUTION: Do not exceed 150 
cm H20. 

Pump Flow Limit Specifies the max pump flow rate during calibration.  NOTE: This setting cannot be 
changed manually in the UDS software. 

Volume Limit  Stops the pump if the volume channel exceeds this limit. 
CAUTION: Do not exceed 750 ml. 

Volume Warning Limit Displays a warning message when the infused volume reaches the specified limit. 

Auto Pump Option 
 Stop, Slow, Med, Fast 

This option starts the pump at the selected pump speed when the test starts. Choose 
Stop if you do not want to use this option. 

Auto Pump Event This option records events automatically when the pump runs or stops. This option is 
enabled by default. Deselect the box to disable the feature. 

Table 27: Pump Configuration Options 
 Select OK to accept changes or select Cancel to exit without saving changes. 

7.9.2 PRIME PUMP 
Priming the pump removes all the air bubbles from the tubing, which may cause incorrect pressure readings. 
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7.9.3 SLOW FILL 
Select this menu item to run the pump at the slow rate set in the Configure Pump window. 

7.9.4 MEDIUM FILL 
Select this menu item to run the pump at the medium rate set in the Configure Pump window. 

7.9.5 FAST FILL 
Select this menu item to run the pump at the fast rate set in the Configure Pump window. 

7.9.6 STOP PUMP 
Select this menu item to stop the pump. 

Volume Warning Limit 
The Volume Warning Limit is used in the pediatric “Uro Mode” which applies to patients under 16 years of age. This limit 
is the maximum amount of fluid that can be infused into the patient according to bladder capacity at a given age. 
 
The Volume Warning Limit is determined by Acceptable Total Bladder Capacity (ATBC.) 
ATBC = 16 x (Age of child in years) + 70 ml. 
 
The pump receives the information to calculate the ATBC from the data entered in the Patient Information dialog box. 
 
If the infused volume exceeds the limit specified in the Volume Warning Limit box, a message appears. 

 IMPORTANT: After the warning appears, the pump does not automatically stop. It must be manually stopped. 

 NOTE: The ATBC is calculated automatically and cannot be changed. 

 SERVERX MENU (OPTIONAL) 
The SERVERX Menu provides access to ServerX features and system connection controls. 

7.10.1 RESET CONNECTION 
The Reset Connection feature resets the connection to the hardware. It should not be used during the test. It is intended 
for use only by qualified technical service personnel. 

7.10.2 SHOW SERVERX WINDOW 
The Show ServerX Window feature is to be used only by qualified technical service personnel. 

7.10.3 CHOOSE BLUETOOTH 
Use this menu item to select which AQUARIUS® system is connected to the software. The software will automatically 
connect to the same AQUARIUS® system when it is run the next time. 
 
To select the system for connection: 

 Select Server X > Choose Bluetooth.  The Select a Bluetooth Server window will open and search for all 
Bluetooth devices within range. 

 Select the name of the AQUARIUS® system from the list. 
 Enter the PIN number LMTUDS94BT (all capital letters) if prompted. 
 Click OK. 
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7.10.4 CONNECTION TYPE 
Select the connection type option that matches the connection set up in the touchscreen settings, USB or Bluetooth (Figure 
157).  If the connection type is changed, then it must be changed in the touchscreen module software too. 

 
Figure 157: ServerX – Connection Type 

 

When a connection is changed (such as switching from USB to Bluetooth and vice versa, exit then restart the 
software to enable the change. 

 VIDEO 
Starts the video functions of the UDS software. Refer to the Saturn Owner’s Manual for more information. 

 SET ZEROES! MENU 
Set Zeroes is a menu located on the menu bar at the top of the screen. It is recommended that all transducers be zeroed 
before performing a test: 
 “Zero pressure is the value recorded when a transducer is open to the environment when disconnected from any tubes or 
catheters, or when the open end of a connected, fluid-filled tube is at the same vertical level as the transducer.  Only then 
can a ‘set zero’ or ‘balance’ be performed.”x  
 

NOTE: The EMG channel must always be set to zero through this menu.  
 
It is recommended to zero all transducers before performing a test. 

To Set Zeroes before performing a test: 
• Select SET ZEROES! from the Menu Bar in the Goby Software window.  

The Set Zeroes window will launch (Figure 158). 
o To set all transducers to zero, click All. 
o To zero a single transducer, click the button labeled with the 

transducer/channel name. 
o To set transducers to a specific value, click the Advanced button 

in the Set Zeroes Menu. Then click the option next to the 
transducer requiring the change. Use the keypad at the bottom 
of the window to set the specific value and click Apply.  

NOTE: The Advanced button is only available when the test is stopped. 

 
Figure 158: Set Zeros 

Window 

 TRANSDUCER TYPE 
Select the type of transducer used with the system before a test starts to ensure proper data recording.  Ensure the system 
has been calibrated to the transducer type selected. 

 
Figure 159: Transducer Type Menu 

Use one type of transducer with the Roam™ DX; select either air-charged or water for all tests. 

NOTE: A “transducer type” event will be added to the start of the graph when Run is clicked. 
 



LABORIE AQUARIUS XT/CT/LT/CTS Owner’s Manual   AQS-UM01   131 

8 VBN FEATURE 
VBN is an optional feature. Feature availability is dependent on system setup.  Contact your LABORIE representative or call 
customer service to request this optional feature.   
 
VBN is a mathematical model of the lower urinary tract and is based on the research and standards set by the members of 
the International Continence Society. VBN is a powerful and non-invasive tool to predict the aftereffects of surgery and/or 
prescribed treatment.  The features available are dependent upon the VBN options installed on your system. 

 NORMAL CURVE OVERLAY 
Calculate the normal flow (Q) curve to compare against the patient’s actual flow (Q) Pves curve by overlaying the normal 
curve over the patients curve. 

 Click File > Open to open any Pressure/Flow .dta file or any file that has a Flow/Q channel. 
 Click Options >VBN – Normal Curve Overlay.  When VBN – Normal Curve Overlay is selected in the menu, it 

will have a checkmark next to it.  
 Once Normal Curve Overlay has been selected, a blue curve representing the normal flow for the sex of the 

patient will be laid on top of the patient’s actual flow curve. 
 Press F9 to enable the Cursor box.  Move the mouse over the blue calculated curve and the patient’s actual 

measured curve to observe the difference between the patient’s flow and the normal flow.   
 Left click the bottom of the Flow Channel box (below the ml/s text) to change the channel label to the normal 

flow channel (CALQ). The label will become blue and say CALQ with a peak flow measurement in ml/s. This peak 
flow should be the value of the highest point on the normal flow curve.   

 Left click the box again to change the flow channel box from CALQ back to Flow. 
 Playback the test with the Normal Curve Overlay enabled to watch as the overlay is drawn. 
 Click Options >VBN – Normal Curve Overlay while it is selected to disable the overlaid curve. 

 VBN FULL AND VBN ANIMATION 
Use the VBN Animation features to display a simulated model of the human bladder or display an animation of what the 
bladder might do with normal pressure and flow based on such factors as sex, catheter size (if any), and other forces. The 
control panel buttons associated with VBN are already loaded into the system.  
 
VBN Full and VBN Animation Only versions have similar functionality except the VBN Animation version does not include 
the graph windows.  Any functionality requiring a graph window is therefore not used in the VBN Animation version of the 
software. 

To access the Control Panel: 
 Click Options > Control Panel Definition.  
 Select VBN from the Control Panel Set Name dropdown menu. 
 Click OK. 
 Click the Transfer to VBN button on the control panel to open the VBN control panel. 

 

8.2.1 VBN CONTROL PANEL 
When the VBN control panel loads, three rows of buttons will be displayed.  The subsections below outline the functions 
on buttons available in the VBN Control Panel 

Initialize Default Values 
Click this button to open VBN windows and controls including controls to initialize VBN related variables to predefined 
default values.  The controls available depend on the saved configuration of the VBN Control panel.  If no customized 
layouts have been saved a default layout will launch (Figure 160).  



LABORIE AQUARIUS XT/CT/LT/CTS Owner’s Manual   AQS-UM01   132 

 
Figure 160: VBN Windows 

Load File 
Click this button to load a previous saved file in CAS format, which is the file format VBN uses to store tests. 

Save File 
Click this button to save the current VBN test in CAS format.  VBN test can be retrieved using the Load File button. 

Transfer to VBN 
Use this button to import DTA files to the VBN component of the program. 
Opened a pressure-flow DTA file from within the UDS software (File >Open) and press Transfer to VBN to import this test 
data to the VBN component of the program. 

Draw/Remove Calculated Curves 
Click this button to switch the display of the calculated pressure and flow curves on any open curve windows. 

Interpretational Help 
The Interpretational Help window is an important window in VBN.  
 
It is responsible for controlling VBN’s automatic interpretation features.  With this 
feature, the software will automatically try and fit the calculated pressure and flow 
curves over the measured calculated pressure and flow curves by adjusting 
different VBN variables.  It will then generate one or more solutions where the 
curves fit.   
 
Select the Together button and the software will begin the process of trying to fit 
the curves. You can observe the calculations on any open graph or animation 
windows while the computer is trying different combinations of variables.  Once the 
process is complete, a results window will appear showing any solutions. 
 
If any solutions were discovered, the Solution value will change to 1.  If more than 
one solution was discovered, use the -1 and +1 buttons to navigate between the 
different solutions. 
 
Refer to Figure 161. 

 
Figure 161: Interpretational Help 
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Patient Info 
Click the Patient Info button to input or review patient information for the current 
test (Figure 162). 
 
Adjust the gender of the patient by clicking the Mr. or Mrs. button.  The equations 
used by VBN during its calculations are dependent on the sex of the patient, so this 
must be correctly entered before using the VBN function. 

 
Figure 162: Patient File Window  

Global Values 
The Global Values window can be left open while you are performing other VBN 
features (Figure 163).  
 
Use this window to observe measured values (for example, Volume Voided) to the 
values computed by the VBN software.  This is especially useful when used in 
combination with the Interpretational Help feature, as you can compare how close 
the calculated values are to the original values for each solution. 

 
Figure 163: Global Values 

Window 
 

Bladder 
Click this button to open the Bladder window (Figure 164).  
 
Adjust variables that affect the bladder such as Initial Volume, Detrusor Force, and 
so on.  Some of these values will be automatically adjusted when using the 
Interpretational Help feature to discover solutions.  From the Bladder window you 
can also input the initial volume inside the bladder, which has a significant effect on 
the calculations. 
 
The following Settings are available in the Bladder window: 

• Detrusor Force:  A higher detrusor force will decrease the time it takes 
the patient to void, providing they are able to void at all. 

• Initial Volume: The size of the bladder in the Animation window will 
change depending on the “Initial Volume”.  A greater initial volume 
also means it will take longer for the patient to void. 

• Time Of Break and Quality:  The patient should not be able to 
continue voiding much longer than the value (in seconds) of the “Time 
of Break” setting.  How long the patient can continue voiding past this 
point depends on the “Quality setting”. 

• Neck/Detrusor Coupling:  No observable effect for animation. 

 
Figure 164: Bladder Window 

 

Sphincter 
Click this button to open the Sphincter window. 
Use this to adjust variables that affect the Sphincter.  Some of these values are 
automatically adjusted when using the Interpretational Help feature to discover 
solutions. 
 
The following Settings are available in the Sphincter window: 

 

 
Figure 165: Sphincter window 
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• Pre excitation: For strong enough values, the voiding does not 
depend on it. For insufficient value the function of the sphincter is 
impaired, so continence is not achieved. 

• Opening Time:  The area of the urethra that the sphincter force effects 
will not open until this amount of time has passed.  You will notice that 
Subsonic and Sonic forces will be in this area until the sphincter has 
opened. 

• Excitation:  Can influence how long it takes the patient to void, but it 
also depends on other settings. 

 

Urethra 
Click this button to open the Urethra window. 
Use this feature to adjust variables that affect the Urethra.  Some of these values are 
automatically adjusted when using the Interpretational Help feature to discover 
solutions.  From the Urethra window select the size (in French units) of the catheter 
that is inserted into the urethra.  This has a great impact on the calculations. 
 
The following Settings are available in the Urethra window: 

• Neck Disease:  A very low setting (for example: 0.1) will increase the 
time it takes the patient to void.  You can observe the sonic/subsonic 
forces being located near the neck. No effect if greater than 0.2. 

• Neck Pressure (Male Only):  Increasing this value increases the 
pressure on the neck, which will increase the time it takes the patient to 
void. 

• Prostrate Pressure (Male Only): Increasing this value increases the 
pressure from the prostate, which will increase the time it takes the 
patient to void. 

• Ura Comp. (Female Only):  Increasing this value will increase the time 
it takes the patient to void. 

• Urethra Area (Female Only):  Has an effect on the size of the 
Urethra.  Will also affect the time it takes the patient to void. 

• Probe:  Sets the size of the probe (if any) inserted into the patient’s 
urethra.  A red bar will be visible in the animation window.  A probe will 
greatly increase the amount of time it takes the patient to void. 

 
Figure 166: Urethra Window 

 

Select View 
Click this button to open the Select a View window (Figure 167).  

 
Figure 167: Select a View Window 

This window provides access to Normal, Separate P and Q, and Animation data 
representations.  

• Select the Normal button to open the Graph in its normal format 
(Figure 168). 

• Select the Separate P and Q button to open a graph window that 
separates the pressure curves and the flow curves onto two different 
graphs (Figure 169).  

• Select Animation to open the animation window (Figure 170). 

NOTE: If using the Animation only version of VBN, the first two buttons will not 
be available. 

 
Figure 168: Normal 
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These Normal and Separate P and Q graphing windows display several measured 
and calculated curves.  Each curve has a corresponding label that matches its color.  
In both graphs, the top-most graph always displays curves relating to the Detrusor 
and Sphincter forces.   
 
In the Separate P and Q window, the pressure and flow curves are separated into 
two different graphs.  Use the scrollbar to view the different graphs. 

 
Figure 169: Separate P and Q 

 

Animation Window 
The Animation window displays a simulated model of the bladder for the current 
patient (Figure 170). 
 
Adjustments to variables such as prostate pressure, size of catheter, initial 
volume, and the sex of the patient can be directly observed in this window.  
 
When you are playing back an animation, this window displays the current flow 
rate, and the time that has elapsed at that stage of the animation.  During an 
animation playback, the size of the bladder should gradually decrease provided 
the patient would be able to void during this simulation.  The Sonic and 
Supersonic forces inside the urethra are also highlighted during the animation 
playback. 

 
Figure 170:  Animation window 

Animation Control Box 
Click this button to open the Animation Control Box (Figure 171).   
 
Use the buttons on this window to control animation playback.  Select the Stop 
button to reset the animation to the beginning stage, then select the Play button 
to begin playback.  During the animation, use the Pause button to pause the 
playback. 
 

 
 

 
Figure 171: Animation Control Box 
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Aspect Ratio 
Click this button to open the Aspect Ratio window (Figure 172).  
  
Use the controls in the Aspect Ratio window to adjust the aspect ratio of the X-
axis and Y-axis on the graph windows.  Use these controls to adjust the aspect 
ratio if the graph curves are out of range and going outside the bounds of the 
graph.  This window also provides controls to set the excitation to either begin at 
0 seconds or 40 seconds. 
 

 
Figure 172: Aspect Ratio Window 

 

Curve Adjustments 
Click this button to open the Curve Adjustments window. Use this window, in combination with the Normal Graph 
window, to adjust the curves.  Refer to Figure 173. 
 
Under the Curve to Adjust Option select the curve to manipulate.  Select a curve from the Curve To Adjust section and 
click the Delete button to delete an entire curve from the graph. Select the Undo Delete button to undo a previous 
deletion.  To draw a curve directly on the graph, select the desired curve from the Curve Adjustments window, then click 
the normal graph window to draw a line from the beginning of the graph desired end point.  To erase portions of the 
curve on the VBN graph, right click on the new endpoint of the curve.  The curve will be erased from the end of the 
graph to the point selected.    
 
Use the arrows in the Move Curve section to move the selected curve in the selected direction. This will show the effect 
that the abdominal pressure has on them.  
 
The Affinity option allows you to multiply all the y-values of a selected curve by the amount entered to the field.   
 
The Measured global values will be different based on the initial volume of the bladder.  The other parameters take 
their standard value.  While changing values in the windows the values in the Global Values window will change to 
reflect the other changes made. 
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Figure 173: Curve Adjustments Window 

Other Options 
Click this button to open the Other Options window (Figure 174). 
Enable or disable laws used during VBN’s calculations.  Some of these laws 
affect which calculations are used during Interpretational help. 
From this window adjust the thickness of curves being displayed on the graph 
windows.  Use the Save and Restore buttons to save the current window 
layout or to restore a previously saved window layout. 

 
Figure 174: Other Options Window  

Close VBN Windows 
Select this button to close all VBN related windows.  This is useful when you are done using VBN but wish to continue using 
another part of the UDS software. 
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9 ANORECTAL MANOMETRY (ARM) FEATURE 
ARM is an optional feature.  Availability is dependent on system setup.  Contact your LABORIE representative or call 
customer service to request this optional feature. 
 
The LABORIE Anorectal Manometry (ARM) feature is used to quantify the performance of the Anorectal mechanism.  
Anorectal function testing can provide useful information regarding the pathophysiology of disorders that affect continence 
and defecation or those that cause anorectal pain. 

 INTENDED USE 
LABORIE ARM system is intended to measure the physical parameters such as pressures and EMG of the terminal end of 
the digestive tract as it relates to Urodynamics, Incontinence, and the Pelvic Floor. 

 TARGET POPULATION 
The major application of ARM is to aid in the diagnosis of anorectal disorders and for evaluating abnormalities of the 
sphincteric mechanism.  ARM has shown applicability in men, women, and children in the diagnosis of the following 
conditions or instances: 
 

• Fecal Incontinencexi,xii,xiii 
• Separating out the various types including:  
• Pudendal nerve neuropathyxiv  
• Sphincter lesionsxii  
• Overflow incontinencexii  
• Can occur in diabetes mellitusxv 
• Constipationix,x,xi 
• Chronic or otherwise xviiixvi,xvii,  
• Pre- and post-operative care* for any procedure involving the sphincter apparatusxi,xii 
• Fissure and fistula repair 
• Colon-anal anastomoses 
• Pouch operation 
• Sphincter tightening 
• Functional obstructive difficulties in defecation includingxii : 
• Paradoxical contraction of puborectalis muscle 
• Anismus 
• Spastic pelvic floor syndrome 
• Megarectum 
• Rectal inertia 
• Internal rectal prolapse 
• Assessing patients prior to and to facilitate biofeedback training of the evacuation and continence 

mechanismsxi 
• Bowel symptoms resulting from systemic neurological disorders, such as multiple sclerosixix and 

cerebrovascular accidentsxx  
• Congenital anomalies such as Hirschprung’s diseasexxi and imperforated anusxxii 
• Encoporesisxxiii 
• Collagen vascular disease (such as scleroderma)xxiv 
• Trauma (accidental, obstetrical, or surgical injury)xxv 
• Functional anorectal painxi,xxvi 

 CONTRAINDICATIONS 
The ARM system is contraindicated for any patient with one or more of the following conditions: 
 

• Uncooperative patient 
• Gastrointestinal (GI) bleeding 
• Comatose 
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 WARNING: Anorectal manometry should be performed with great care, especially in the early post-operative period 
following rectal surgery, or in those young and old patients who may not express or feel internal sensation during the 
examination, as these individuals may be at risk of bowel perforation. Great care should also be taken for those who have 
undergone surgery and/or radiotherapy due to rectal cancer at any timexxvii xxviii  xxix xxx xxxi (Appendix B – I: 16-20).   Park et al. 
(2008) recommend meticulous digital rectal examination preceding ARM for the detection of unsuspected anorectal 
abnormal lesions, and is necessary for patients with a history of rectal surgery. In addition, measuring maximum tolerable 
volume in the postoperative period should be omitted.  
 

 WARNING: Per the above warning, certain individuals may be at higher risk of bowel perforation during anorectal 
manometry, which may require surgical correction.  Serious complications may occur in any surgery, which should be 
considered and communicated, to the patient, when assessing suitability for anorectal manometry testing.   
 

 SYSTEM STARTUP SEQUENCE 
Power up the ARM enabled system in this sequence: 

 Aquarius system tower 

 Printer and Monitor 

 PC 

 UDS software 
Failure to power up in this sequence could result in devices not being properly recognized.  

 

 USING ARM WITH AIR-CHARGED CATHETERS 
Use the T-DOC Air-Charged ARM Catheter for ARM studies including Expulsion testing. Do NOT fill the sensory balloon 
beyond 450 c’s for any given test. Do not exceed 300cc for pediatric patients.  DO NOT put traction on or pull the T-DOC 
Air-Charged ARM Catheter out of the patient while the balloon is filled because the balloon may pull off from the catheter. 

Equipment for ARM Testing 

Required Equipment Optional Accessories 

• ARM 4 channel air- charged radial catheter with rectal 
balloon (CAT003 (4-Pressure)) 

• Syringe, provided by site 

• Four or eight pressure transducers/cables 

• AIO PC or laptop 

• Starter kit, pump tubing, catheters, beaker etc. (Will 
vary according to system setup) 

• Software CD containing ARM software and owner’s 
manuals 

• EMG unit and surface electrodes [CAB155, CAB154 or CAB153 
(EMG cable) with ELE200 or ELE428 or ELE370&ELE365 (EMG 
electrodes)] 

• UPP Puller 

Table 28: ARM Feature –Equipment for Air-Charged Catheters Setup 
 
Contact your LABORIE representative to order replacement accessories. 
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9.5.1 CATHETER AND TRANSDUCER SETUP AND CONNECTION 
 To set up the Roam™ DX, the EMG, and the pump tubing on the AQUARIUS, refer to the Software and 

Equipment Setup section on page 18. 
 Make sure all transducers are in the OPEN position. 

             
Figure 175: Transducer Cable – Open Position 

 Each directional sensor is identified by color.  This color corresponds to the transducer/cable connection for ease 
of identification.  Connect the color-coded transducer cables to the air-charged catheter by following the 
configuration shown in Figure 176. 

 
 

  Yellow P1 cable to POSTERIOR (yellow) catheter port  

  Blue P2 cable to the RIGHT (blue) catheter port 

  Green P3 cable to ANTERIOR (green) catheter port  

  Orange P4 cable to LEFT or (orange) catheter port 

Figure 176: Air-Charged Abdominal Catheter – Connections 
 

NOTE: The black line on the catheter indicates the “posterior” orientation. This line should be directly in line with 
the patient’s spine during insertion. If the patient is on their left side, the line will be facing their back.   
 

 Gently squeeze then release each directional sensor to remove air. NOTE: This is not the large rectal balloon, but 
rather the four small directional sensors located directly beneath the rectal balloon. 

 Click Set Zeros on the software control panel. 
 Switch the transducer to the CHARGE position (Figure 177). 

Yellow 
(Posterior) 

Blue  
(Right) 

Green 
(Anterior) 

Orange  
(Left) 

Stopcock 
Stylet  
Wire 

(optional) 

Rectal Balloon 
(Deflates in less 

than 10 sec.) 

Directional 
Sensors 

Depth Markings from 
2 cm to 20 cm 

Catheter Length 60cm 

Color band on catheter indicates 
respective sensor position.  Solid 
black line on catheter identifies 

posterior (yellow) sensor. 
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Figure 177: Transducer Cables – Charge Position 

 USING ARM WITH FLUID-FILLED SYSTEMS 
Required Equipment Optional Accessories 

For a Fluid-filled Gravity Feed System: 
• ARM 4 or 8 channel water-perfused catheter with 

balloon [CAT006 (4-Pressure) CAT008 (8-Pressure)] 
• Pressure cartridge* (DIS125) 
• Measurement tubing (TUB101 or TUB102) 
• Pressure cuff (DIS302) 
• Syringe, supplied by the site 
• IV BAG 
• IV line 
• AIO PC or laptop computer 
• Equipment with built-in pump 
• Four or eight pressure transducers and cables 
• Starter kit (pressure cartridges, stopcocks, tubing, 

pump tubing, catheters, beaker etc. Will vary 
according to system setup)  
 
*Depending on the system, use a Nova dome (DIS103) 
instead of a pressure cartridge (DIS125). 

For a Fluid-filled with Constant Pressure Pump System: 

• Syringe, supplied by site 
• 1 L Distilled water, supplied by site 
• 3-way stopcock (DIS431) 
• Pressure cartridge (DIS125 or DIS103) 
• Luer Lock Plug (DIS104) 
• Measurement tubing (TUB101 or TUB102) 
• ARM 4 or 8 channel water-perfused catheter with 

balloon CAT006 
• (4-Pressure) CAT008 (8-pressure) 
• AIO PC or laptop computer 
• Equipment with built-in pump 
• Four or eight pressure transducers and cables 
• Starter kit (pressure cartridges, stopcocks, tubing, 

pump tubing, catheters, beaker etc. Will vary 
according to system setup)  
 

• EMG unit and surface electrodes [CAB155, CAB154 or 
CAB153 (EMG cable) with ELE200 or ELE428 or 
ELE370&ELE365 (EMG electrodes)] 

• UPP Silent Drive Mechanical Puller (UPP1001) 
 

Table 29: ARM Feature - Equipment for Fluid-Filled Systems 
Contact your LABORIE representative for ordering replacement accessories. 
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9.6.1 TRANSDUCER SETUP AND CONNECTION 
 FLUID-FILLED TRANSDUCER SETUP USING GRAVITY SYSTEM 

The Gravity Feed System is comprised of three subsets of equipment setups: IV bags, the pressure transducers, and the 
catheter. 

The IV Bags 
 Place 4 cuffed (if measuring 4 pressures) or 8 cuffed (if measuring 8 pressures*) saline or sterile water IV bags at 

the top of the IV pole. 
 Connect an IV line to each saline bag.  

 IMPORTANT: Keep the roller clamps closed when puncturing the bags. 

 Pump each pressure cuff to a minimum of 300 mmHg. 
 Prime each IV line.  

 
Figure 178: IV Bag Setup for 4 Pressures 

 
Pressure Transducer Setup Using Transducer Cartridges 
Refer to the Consumables and Transducer Setup section on page 25. 
 

Fluid-filled Catheter Setup with Gravity System 
Connect each catheter port to its corresponding pressure measurement tubing.  For example, connect P1 on the catheter 
to the measurement tubing coming from the P1 transducer. 

 Open the drip on each IV line to 1 drop every 2-3 seconds to keep line flushed.   
 Hold the tip of the catheter level with the pressure transducer plate.  Click Set Zeroes.  

Refer to the Figure 179 below for a diagram of the fluid filled catheter channels from the distal end.  The P1 channel is in 
line with the blue indicator line. 

 
 

Figure 179: Fluid-filled catheter – Distal View of Channels. 
 

Roller Clamps 

P1 
P2 

P3 
P4 

Pressure Cuffs filled 
to 300 mmHg 

Infusion Tubing 

Saline Bag 

Blue Line 

P1 

P2 

P3 

P4 
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EMG Setup 
Refer to the EMG Setup section on page 28. 

Pump Tubing Setup (optional) 
Refer to the Pump Setup section on page 24. 

 USING ARM WITH ELECTRONIC CATHETERS 
Standard Equipment Optional Accessories 

• ARM 4 or 8 channel radial catheter [CAT928 (4-
Pressure) or CAT916 (8-Pressure)] 

• Rectal Balloon (CAT752) 

• Syringe, supplied by site  

• Surgical thread to attach balloon, supplied by site 

• AIO PC or laptop computer 

• Equipment with built-in pump 

• Four or eight pressure transducers/cables 

• Starter kit, pump tubing, catheters, beaker etc. (Will 
vary according to system setup)  

  

• EMG unit  and surface electrodes [CAB155, CAB154 or 
CAB153 (EMG cable) with ELE200 or ELE428 or 
ELE370&ELE365 (EMG electrodes)] 

• UPP Silent Drive Mechanical Puller (UPP1001) 

• Desktop printer with USB printer cable 

• USB Serial Converter (Direct cable option only) 

• RS-232 null modem cable (Direct cable option only) 
  

Table 30: ARM Feature - Equipment for Electronic Catheters Setup 

9.7.1 CATHETER SETUP 
 Connect the cables to the electronic catheters with Lemo cables; connect the S1 cable to P1, the S2 cable to P2, 

the S3 cable to P3 and the S4 cable to P4 until all connections are set.  Refer to Figure 180 below showing cable 
and catheter connections:  

    
Figure 180: Electronic Catheter – Distal View of Connections  

 
 Place the electronic catheter in a shallow water dish being careful not to submerge the electronic housing of the 

catheter. 
 Allow the catheter to sit in water for a minimum of 5 minutes, as the electronic sensors must stabilize prior to use. 
 Hold the sensors just below the water surface and click Set Zeros. 
 Let the catheters remain in the pan of water until ready for placement. 

EMG Setup 
Refer to the EMG Setup section on page 28. 

Pump Tubing Setup (optional) 
Refer to the Pump Setup section on page 24. 

P1 

P2 

P3 

P4 

S1 

S2 

S3 

S4 
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 PERFORMING TESTS WITH THE ARM SYSTEM 
 IMPORTANT: 

 Notes Regarding Testing Procedures 
• Prior to catheter insertion, the rectal ampulla must be empty of all fecal debris. Some doctors recommend 

that patients with constipation use an enema before coming in for the test. 
• Place the patient in a left-lateral position with knees and hips flexed in or as close to a 90-degree position as 

possible. Above all, the patient must be resting comfortably and be willing and able to cooperate. 
• Only 4-channel and 8-channel radial catheters are acceptable for use with the ARM software. If using linear 

catheters, then adjustments must be made to the software. Contact your LABORIE representative for more 
information. 

Common Test Configurations 
Test Name Channel Title Scale Math Definition Data Rate Display 

Attribute 
ARM4 P1 (or Posterior) 

P2 (or Right) 
P3 (or Anterior) 
P4 (or Left) 
Math1 (Average) 

150mmHg 
150mmHg 
150mmHg 
150mmHg 
150mmHg 

Null 
Null 
Null 
Null 
(P1+P2+P3+P4)/4    or 
(Posterior+Right+Anterior+ Left)/4 

10points/s 
10points/s 
10points/s 
10points/s 
10points/s 
 

Curve 
Curve 
Curve 
Curve 
Curve 
 

ARM8 P1 (or Posterior) 
P2 (or Right Posterior) 
P3 (or Right) 
P4 (or Right Anterior) 
P5 (or Anterior) 
P6 (or Left Anterior) 
P7 (or Left) 
P8 (or Left Posterior) 
Math1 

150mmHg 
150mmHg 
150mmHg 
150mmHg 
150mmHg 
150mmHg 
150mmHg 
150mmHg 
150mmHg 

Null 
Null 
Null 
Null 
Null 
Null 
Null 
Null 
(P1+P2+P3+P4+P5+P6+P7+P8)/8 
etc 

10points/s 
10points/s 
10points/s 
10points/s 
10points/s 
10points/s 
10points/s 
10points/s 
10points/s 
 

Curve 
Curve 
Curve 
Curve 
Curve 
Curve 
Curve 
Curve 
Curve 
 

ARM4 with EMG ARM4 configuration plus: 
EMG 

-300uV to 
+300uV 

Null 
 

100points/s 
 

Curve, 
mirrored, 
and filled 

ARM8 with EMG ARM8 configuration plus: 
EMG 

-300uV to 
+300uV 

Null 
 

100points/s Curve, 
mirrored, 
and filled 

ARM4 using 
Integrated 
LABORIE pump 
 

ARM4 configuration plus: 
IH2O 
VH2O 

 
150mL/min 
600mL 

 
Null 
Null 

 
10points/s 
10points/s 

 
Digital 
Digital 

ARM8 using 
Integrated 
pump 

ARM8 configuration plus: 
IH2O 
VH2O 

 
150mL/min 
600mL 

 
Null 
Null 

 
10points/s 
10points/s 

 
Digital 
Digital 

Table 31: ARM – Common Test Configurations 
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9.8.1 PERFORMING ARM TESTS WITH A RADIAL CATHETER 
Eight different tests can be performed with LABORIE’s ARM software: 
 
Pressure Profiles using Control Panel Buttons 

i) Resting Profile 

ii) Squeezing Profile 

iii) Pushing Profile (optional) 

Pressure Profiles using Study Configurations 

iv) Stationary Rest and Stationary Squeeze 

v) Stationary Rest, Stationary Squeeze, and Stationary Push 

Filling and Expulsion Studies 

vi) RAIR (Rectoanal Inhibitory Reflex) 

vii) Rectal Volume/Rectal Sensation 

viii) Expulsion 

9.8.2 STARTING THE ARM SOFTWARE 
The buttons and commands to run the ARM software are preloaded into the UDS software.  
To access the ARM commands in the UDS software: 

 Click Options > Control Panel Settings.  The Command window will be displayed. 
 Click the Control Panel Set Name list and select ARM 4&8.  
 Click OK.  The Control Panel will display the buttons associated with ARM testing (Figure 181). 

NOTE: The control panel for your software may have a different appearance than the examples shown here (such as 
colors, button size, etc.) To change the appearance of the control panel buttons, click the Button Color button in the 
Command window and make selections for appearance. 

 

Figure 181: ARM Control Panel 
 Click the ARM button to display the testing configuration. 

9.8.3 PRESSURE PROFILES USING CONTROL PANEL BUTTONS 
 PROFILES SETUP 

 Gently insert the well-lubricated catheter 6cm beyond the anal verge with Channel 1 (S1) in the appropriate dorsal 
position. Use the markings on the catheter as a guide.  

 If using a mechanical puller, attach the distal (furthest) end of the catheter to the puller using the puller guides.  
Take note of UPP control buttons on the control panel for use with the mechanical UPP Puller (Figure 182). 

 
Figure 182: UPP Controls on the Control Panel  

NOTE: The resting profile can be performed without the use of a puller. In this case, manually withdraw the catheter 
at an approximate speed of 1mm/s to ensure pressures are properly correlated to catheter position. 

 Refer to the instructions for the profile type required. 
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 RESTING PROFILE 
The resting profile provides a baseline with which all pressures will be compared against during ARM testing.  It is imperative 
that the patient be able to relax during testing in order to allow the recording of true resting pressures.  Refer to figure x 
for sample data of a resting profile: 

 

Figure 183: Sample Data of a Resting Profile 
Follow the instructions provided to find the resting pressure profile: 
 

 Insert the catheter and prepare a mechanical puller as described in the Pressure Profiles using Control Panel 
Buttons 

 Profiles Setup section on page 145. 
 Allow the patient to relax for several minutes with the catheters inserted and positioned for the test.  Allow as 

much time as necessary. 

NOTE: The patient must remain as relaxed as possible throughout the procedure and should not move, talk, or cough 
during the withdrawal of the catheter. 
 

 Click Resting on the Control Panel to mark the start of the resting profile. 
 Click Pull on the Control Panel (Figure 182).  The puller will slowly begin to remove the catheter at a set rate of 

1mm/s. 

NOTE: Do not use the puller controls if manually withdrawing the catheter.  Withdraw the catheter very slowly; it 
should take about 60seconds to go from 6cm to 0cm (1mm/s) or to when you can just observe the sensors. Do not 
completely remove the catheter from the body. 

 
 Click the Stop Pull button to stop the puller when the sensors have passed the anal verge (Figure 182).  
 Click Resting again on the control panel to mark the end of the resting profile. 

NOTE: The Resting Profile test should be performed at least twice to confirm a pressure pattern. 

 To perform a second resting profile, remove the catheter from the puller guides and manually re-insert the 
catheter to the initial starting position 6cm beyond the anal verge.  Click Return on the control panel to setup the 
puller for the next profile (Figure 182). 

IMPORTANT: The Puller must NOT be used for catheter reinsertion; doing so may result in injuries to the patient.  Use 
the RETURN button on the control panel only to reposition the puller guide close to the tip of the puller. 

 Attach the distal (furthest) end of the catheter to the puller using the puller guides and repeat the above steps to 
perform a second resting profile. 

 Re-insert the catheter to proceed to the Squeezing Profile.  If testing is complete, carefully remove the catheter. 
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 SQUEEZING PROFILE 
 Insert the catheter and prepare a mechanical puller as described in the Pressure Profiles using Control Panel 

Buttons 
 Profiles Setup section on page 145. 
 Ask the patient to squeeze during the entire length of the catheter withdrawal. 
 Click Squeezing on the Control Panel to mark the start of the squeezing profile.  
 Click Pull on the Control Panel to start the pulling of the catheter (Figure 182).  

NOTE: You do not need to use the puller controls if you are manually withdrawing the catheter. 
 

 Click Stop Pull to stop the puller when the sensors have passed the anal verge (Figure 182). 
 Click Squeezing on the Control Panel to mark the end of the test. 

NOTE: The Squeezing Profile test should be performed at least twice to confirm a pressure pattern. 

 To perform a second squeezing profile, remove the catheter from the puller guides and manually re-insert the 
catheter to the initial starting position 6cm beyond the anal verge.  Click Return on the control panel to setup the 
puller for the next profile (Figure 182). 

 IMPORTANT: The Puller must NOT be used for catheter reinsertion; doing so may result in injuries to the patient.  Use 
the RETURN button on the control panel only to reposition the puller guide close to the tip of the puller. 

 Attach the distal (furthest) end of the catheter to the puller using the puller guides and repeat the above steps to 
perform a second resting profile. 

 Re-insert the catheter to proceed to the Squeezing Profile or Stationary Rest Profile.  If testing is complete, 
carefully remove the catheter. 

Refer to Figure 184 for sample data of a squeezing profile: 

 

Figure 184: Sample data of a Squeezing Profile 

 PUSHING PROFILE 
 Insert the catheter and prepare a mechanical puller as described in the Pressure Profiles using Control Panel 

Buttons 
 Profiles Setup section on page 145. 
 Ask the patient to push during the entire length of the catheter withdrawal. 
 Click Pushing on the Control Panel to mark the start of the pushing profile. 
 Click Pull on the Control Panel; the puller will slowly begin to remove the catheter at a set rate of 1mm/s. 

 NOTE: Do not need to use the puller controls if manually withdrawing the catheter.  Withdraw the catheter very 
slowly; it should take about 60seconds to go from 6cm to 0cm (1mm/s) or to when you can just observe the sensors. Do not 
completely remove the catheter from the body. 

 Click the Stop Pull button to stop the puller when the sensors have passed the anal verge.  
 Click Pushing again on the control panel to mark the end of the resting profile. 
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 NOTE: The Pushing Profile test should be performed at least twice to confirm a pressure pattern. 

 To perform a second pushing profile, remove the catheter from the puller guides and manually re-insert the 
catheter to the initial starting position 6cm beyond the anal verge. Click Return on the control panel to setup the 
puller for the next profile. 

 IMPORTANT: The Puller must NOT be used for catheter reinsertion; doing so may result in injuries to the patient.  Use 
the RETURN button on the control panel only to reposition the puller guide close to the tip of the puller. 

 Attach the distal (furthest) end of the catheter to the puller using the puller guides and repeat the above steps to 
perform a second resting profile. 

 Re-insert the catheter to proceed to the Squeezing Profile or Stationary Rest Profile.  If testing is complete, 
carefully remove the catheter. 

9.8.4 PRESSURE PROFILES USING STUDY CONFIGURATION 
Refer to the figure below for Control Panel Buttons applicable to Rest, Squeeze, Push, Studies: 

 
Figure 185: ARM Control Panel – Study Buttons 

 STATIONARY REST AND SQUEEZE STUDY 
The Stationary Rest and Squeeze Study are typically performed together; however, they can be performed as separate 
studies.  Gently insert the well-lubricated catheter 6 *cm beyond the anal verge with Channel 1 (S1) in the appropriate and 
preferred dorsal position. Use the markings on the catheter as a guide. 

Setup for Stationary Rest and Squeeze Study at 6 cm  
To complete the studies at 5 cm, use the default buttons available. To start the Stationary Rest and Squeeze study at 6cm 
beyond the anal verge follow the steps below to configure control panel buttons before starting the test: 
 

 Click Options from the menu bar and select Control Panel Definition.  The Command window will appear 
displaying the first row of Control Panel buttons. 

 Click the down arrow next to Current Row title and scroll down to a row that has blank button spaces. If needed 
add an entirely new row of buttons by changing the number in the box next to Number of Rows. 

 Create a button for 6 cm Rest 
a. Under the Label column, type 6 cm Rest. 
b. Under the Definition column type SR6. 
c. Click the dropdown menu on the third column and select ARM. 

 Locate another free button space to create a 6 cm Squeeze button. 
a. Under the Label column type 6 cm Squeeze. 
b. Under the Definition column, type ST6. 
c. Click the dropdown menu on the third column and select ARM.  

 Open the Properties window for each new button by clicking the PLUS (+) button . 
 Select Automatically insert STOP event after and enter a value in seconds. The default value is 10 seconds. 
 To add shading between start and stop events, select show region for the ARM event, and click the Select Color 

box to choose the color.  Click OK to save changes and close the ARM Event Properties window (Figure 186). 
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Figure 186: ARM Event Properties Window 
 Click OK.  The two new control panel buttons will appear on the control panel.  

Performing the Stationary Rest and Squeeze Study 
 Allow the patient to relax for several minutes, with the catheter inserted, in order to record true resting pressures. 
 Ask the patient to relax and click the 5 cm Rest button to mark the start of the 5 cm resting period.  If starting the 

test at 6 cm beyond the anal verge then click the 6 cm Rest button instead.  The control panel button will start 
flashing and a shaded area will scroll across the graph.  After 10 seconds, the software will automatically mark the 
end of the resting period. The control panel button will no longer flash and the shading will stop. 

 Ask the patient to squeeze as hard as they can for 10 seconds. At the start of the squeeze click the 5 cm Squeeze 
button, or the 6 cm Squeeze button if starting at 6 cm beyond anal verge, and ask the patient to hold the 
squeeze for as long as the shading appears on the graph.  After 10 seconds, the software will automatically mark 
the end of the squeeze period. The control panel button will no longer flash and the shading will stop. The 
patient should stop squeezing at this time. 

 Click the Pull 1 cm button on the control panel to withdraw the catheter 1 cm.  Alternatively, manually pull the 
catheter out 1 cm.  The catheter tip should now be 4 cm (or 5cm) from the anal verge.   

 Allow the patient to rest for at least 30 seconds before starting the next Resting segment. 
 Continue the testing by performing a Rest segment, a Squeeze segment, then withdrawing the catheter by 1 cm.  

Repeat this process, proceeding through the steps in 1 cm increments as programmed on the control panel. 
Complete a Rest segment and a Squeeze segment at 5cm (where applicable), 4 cm, 3 cm, 2cm, and 1 cm 
positions.  Allow the patient to rest for at least 30 seconds after withdrawing the catheter per increment. 

 Once the Stationary Rest and Squeeze Study is complete, leave the catheter inserted to proceed to another ARM 
study (such as RAIR or Rectal Volume).  The catheter will require repositioning depending on the next study 
performed.  If testing is complete, carefully withdraw the catheter from the patient.  

 
Refer to Figure 187 for sample data of a Stationary Rest and Squeeze Study.  This example measures pressure beginning at 
4cm from the anal verge.  Alternating color patterns highlight the Rest segments and Squeeze segments. 

 
Figure 187: Stationary Rest and Squeeze - Sample Data 
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9.8.5 STATIONARY REST, SQUEEZE, PUSH STUDY 
Gently insert the well-lubricated catheter 6 *cm beyond the anal verge with Channel 1 (S1) in the appropriate and preferred 
dorsal position. Use the markings on the catheter as a guide.  

Setup for Stationary Rest and Squeeze Study at 6 cm 
To complete the study at 5 cm, use the default buttons available.  To start the Stationary Rest, Squeeze, Push Study at 6cm 
beyond the anal verge follow the steps provided below before starting the test: 

 Click Options from the menu bar and select Control Panel Definition.  The Command window will appear 
displaying the first row of Control Panel buttons. 

 Click the down arrow next to Current Row and scroll down to a row that has blank button spaces. If required, add 
an entirely new row of buttons by changing the number in the box next to Number of Rows. 

 Create a button for 6 cm Rest. 
a. Under the Label column, type 6 cm Rest. 
b. Under the Definition column type SR6. 
c. Click the pull down arrow on the third column and select ARM. 

 Locate another free button and create a 6 cm Squeeze button. 
a. Under the Label column type 6 cm Squeeze. 
b. Under the Definition column, type ST6. 
c. Click the pull down arrow on the third column and select ARM.  

 Locate another free button and create a 6 cm Push button. 
a. Under the Label column type 6 cm Push. 
b. Under the Definition column, type ST6. 
c. Click the pull down arrow on the third column and select ARM 

 Open the Properties window for each button by clicking the PLUS (+) button. 
 Select Automatically insert STOP event after and enter a value in seconds. The default value is 10 seconds. 
 To add shading between the start and stop events, select show region for the ARM event, and click the Select 

Color box to choose the color (Figure 186).  Click OK to save changes. 
 Click OK.  The two new control panel buttons will appear on the control panel (Figure 188). 

 
Figure 188: Command Window – Rest, Squeeze, and Push Events 

Running the Stationary Rest, Squeeze, Push Study  
 Allow the patient to relax for several minutes, with the catheter inserted, in order to record true resting pressures. 
 Ask the patient to relax and click the 5 cm Rest button to mark the start of the 5 cm resting period. If starting the 

test at 6 cm beyond the anal verge, then start with the 6 cm Rest button instead.  The control panel button will 
start flashing and a shaded area will scroll across the graph. After 10 seconds, the software will automatically mark 
the end of the resting period. The control panel button will no longer flash and the shading will stop. 

 Ask the patient to squeeze as hard as they can for 10 seconds. At the start of the squeeze click the 5 cm Squeeze 
button, or 6 cm Squeeze if starting at 6 cm beyond anal verge, and ask the patient to hold the squeeze for as 
long as the shading appears on the graph.  After 10 seconds, the software will automatically mark the end of the 
squeeze period. The control panel button will no longer flash and the shading will stop. The patient should stop 
squeezing at this time. 
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 Ask the patient to push to mimic an attempt to defecate. At the start of the push click the 5 cm Push button or 6 
cm Push if starting at 6 cm beyond anal verge.  The software will automatically mark the end of the push period. 
The control panel button will no longer flash and the shading will stop. The patient should stop pushing at this 
time. 

 Click the Pull 1 cm button on the control panel to withdraw the catheter 1 cm.  Alternatively, manually withdraw 
the catheter out 1 cm. The catheter tip should now be 4 cm (or 5cm) from the anal verge. 

 Allow the patient to rest for at least 30 seconds. 
 Continue the testing by performing a Rest segment, a Squeeze segment, a Push segment, then withdrawing the 

catheter by 1 cm.  Repeat this process, proceeding through the steps in 1 cm increments as programmed on the 
control panel. Complete a Rest segment, a Squeeze segment, and a Push segment at 5cm (where applicable), 4 
cm, 3 cm, 2cm, and 1 cm positions.  Allow the patient to rest for at least 30 seconds after withdrawing the catheter 
per increment. 

 Once the Stationary Rest, Squeeze, Push study is complete, leave the catheter inserted if proceeding to another 
study (such as RAIR or Rectal Volume).  The required catheter position will depend upon the next test performed.  
If ARM testing is complete, carefully withdraw the catheter from the patient.  

 
Refer to Figure 189 for Sample data of a Stationary Rest, Squeeze, Push Study: 

 
Figure 189: Sample data of a Stationary Rest, Squeeze, and Push Study.  
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9.8.6 FILLING AND EXPUSION STUDIES 
Refer to Figure 190 for buttons used during the RAIR, Volume, and Expulsion studies. 
 

 
Figure 190: ARM Control Panel – RAIR, Volume, and Expulsion Buttons 

 RAIR (RECTOANAL INHIBITORY REFLEX) 
There are two different techniques to perform the RAIR study using the software’s control panel functions.   
RAIR Setup 

 Connect a 60 cc air-filled syringe to the ARM catheter’s filling port. 

NOTE: The balloon must be completely empty upon insertion 
 Gently insert a well-lubricated catheter into the patient. The catheter should be inserted to the point of highest 

resting pressure [HPZ] as previously recorded, or at approximately 3 cm.  For example, if the HPZ was recorded at 
2 cm, then place the catheter to the 2 cm marker. 

RAIR - Technique #1: 
 Once Setup is complete, click the 10 cc button on the control panel to mark the start of the event. 
 Inject 10 cc of air into the balloon and withdraw the 10 cc of air immediately. NOTE: The air should be withdrawn 

within 5 seconds of being introduced. 

 Click 10 cc again to mark the event stop.  A popup window will appear, select whether RAIR is present or absent 
from the dropdown menu (Figure 191). 

 
Figure 191: RAIR Absent or Present 

 
 If RAIR is not present, repeat these steps using greater increments of air such as 20cc, 30cc, and so on. 
 Leave the catheter in if proceeding to Rectal Volume testing. Alternatively, carefully remove the catheter if testing 

is complete. 
Refer to figure x below for sample results of a RAIR study: 

 
Figure 192: Sample results for a RAIR Study 
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RAIR - Technique #2: 
 

 Once setup is complete, click RAIR on the control panel to launch the RAIR Test window. 
 Select the volume at which the test will be performed from the RAIR Test window (). 

 
Figure 193: RAIR Test Window – Volume 

 

 Inject 10 cc of air into the balloon and withdraw the 10 cc of air immediately.  

NOTE: The air should be withdrawn within 5 seconds of being introduced. 
 

 Click RAIR again to mark the stop event. A popup window will appear, select whether RAIR is present or absent 
from the dropdown menu (Figure 191). 

 If RAIR is not present, repeat these steps using greater increments of air such as 20cc, 30cc, and so on. 
 Leave the catheter inserted if proceeding to Rectal Volume testing. Alternatively, carefully remove the catheter if 

testing is complete. 

RAIR Study Sample 
Refer to Figure 194 below for sample results of a RAIR study: 
 

 
Figure 194: Sample results for a RAIR Study 
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 RECTAL VOLUME USING FLUID AND A SYRINGE 
If filling the rectal balloon manually with a syringe, use the software sensation buttons to prompt input of volumes observed 
at each sensation.  Sensations include first sensation, urge, and max tolerance volumes. 

Anorectal Summary - Volumes 
 Fill a 60cc Luer lock syringe with lukewarm water and attach it to the catheter’s filling port. 
 Gently insert a well-lubricated catheter into the patient. The catheter should be inserted well beyond the anal 

verge (approximately 6 cm beyond the anus) where the area of highest pressure was previously recorded. The 
balloon will be positioned inside the rectum. 

NOTE: The catheter should have a balloon fastened at the tip; the balloon must be completely empty upon insertion. 

 Gradually fill the rectal balloon with fluid. 

NOTE: If you release your grip on the syringe plunger, some of the infused fluid will go back into the syringe. Please 
keep a careful note of the volume within the syringe. 

 When the patient feels the first sensation of fullness, click First Sensation on the control panel and then enter the 
infused volume when prompted. 

 Continue gradually filling the rectal balloon. 
 When the patient feels an urge, click Urge on the control panel and then enter the infused volume when 

prompted. 
 Continue gradually filling the rectal balloon 
 When the patient states they cannot hold any more, stop the pump and click Max Tolerance on the Control 

Panel and then enter the infused volume when prompted. 
 Leave the catheter in if proceeding to the Expulsion study. If proceeding to the Expulsion Testing, do not deflate 

the balloon,  Turn the stopcock to the OFF position to prepare for Expulsion Testing. Alternatively, if testing is 
complete draw back on the syringe to empty the balloon then carefully withdraw the catheter from the patient. 

Rectal Volume using Fluid and the Integrated LABORIE Pump 
 Setup the Pump Tubing with an IV bag of room temperature water. Connect the pump tubing to the catheter’s 

filling port.  
 Gently insert a well-lubricated catheter into the patient. The catheter should be inserted so the rectal balloon is in 

the rectum. The catheter should be inserted well beyond the anal verge (approximately 6 cm beyond the anus) 
where the area of highest pressure was previously recorded. The balloon will be positioned inside the rectum. 

NOTE: The catheter should have a balloon fastened at the tip; the balloon must be completely empty upon insertion. 
 

 Use the software controls to run the pump. 
 Gradually fill rectal balloon with fluid. 
 When the patient feels the first sensation of fullness, click First Sensation on the control panel. 
 Continue gradually filling the rectal balloon. 
 When the patient feels an urge, click Urge on the control panel. 
 Continue gradually filling the rectal balloon 
 When the patient states they cannot hold any more, stop the pump and click Max Tolerance on the Control 

Panel.  
 Leave the catheter inserted if proceeding to the Expulsion study. If proceeding to the Expulsion Testing, do not 
deflate the balloon.  Turn the stopcock to the OFF position.  Alternatively, if testing is complete use the reversible 
pump feature to remove fluid from the rectal balloon then carefully withdraw the catheter from the patient. 
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 EXPULSION TEST 

NOTE: Position the patient in the left lateral decubitus position or move to a seated position over a commode chair to 
expel balloon. 

 If the catheter balloon has not already been filled during Rectal Sensation testing, then fill the rectal balloon using 
a syringe to a standardized volume for the expulsion test (50mL recommended). 

 Click Expulsion to start the test. 
 Ensure that the patient is comfortable and then ask the patient to expel the balloon.  
 After approximately 1 minute, click on Expulsion again to end the test.  
 Enter the result, whether the patient expelled the balloon or not, and what fluid volume was used. 

NOTE: If the VH2O channel is not specified in the test's Configuration file, enter the volume and response in the 
resulting message box. If the VH2O channel is added and specified in the test's Configuration file, the volume will be 
automatically read from the specified VH2O channel and the response will be displayed in the resulting message box. 

 
Figure 195: Expulsion Test Window – Volume and Result 

 If patient did not expel the balloon, remove some volume from the catheter and have patient try again to expel 
the balloon.  Testing will end when the catheter is expelled. If the patient is unable to expel the balloon even 
when all the volume is removed, carefully withdraw the catheter. 

 

 ARM 4 AND ARM 8 CHANNEL TEST RESULTS 
Once a test is performed, view the results for interpretation, analysis, and printing.  The following summaries are available 
for ARM4 and ARM8:  
 

Anorectal Summary   This summary provides a summary of all Anorectal Manometry tests performed  
 Utilize this summary to preview and select data prior to report generation. 

ARM Resting Profile  Summary of pressure data for one resting profile. Also contains summary of 
pushing data.  3D profile generation. 

ARM Squeezing Profile   Summary of pressure data for one squeezing profile. 3D profile generation. 
ARM Stationary Rest (1)  
 

 Summary of pressure data for each stationary rest position (6 cm, 5 cm, 4 cm, 
3cm, 2 cm, and 1 cm).  Refers to the first set of stationary rest pressure data. 

ARM Stationary Rest (2)  
 

 Summary of pressure data for each stationary rest position (6 cm, 5 cm, 4 cm, 
3cm, 2 cm, and 1 cm).  Refers to the first set of rest pressure data and allows user 
to view two positions simultaneously. 

ARM Stationary Squeeze (1)   Summary of pressure data for each stationary squeeze position (6 cm, 5 cm, 4 
cm, 3cm, 2 cm, and 1 cm).  Refers to the first set of stationary squeeze pressure 
data. 

ARM Stationary Squeeze (2)  Summary of pressure data for each stationary squeeze position (6 cm, 5 cm, 4 
cm, 3cm, 2 cm, and 1 cm).  Refers to the first set of squeeze pressure data and 
allows user to view two positions simultaneously. 

ARM Push Profile  Summary of pressure data for one pushing profile.  3D profile generation. 
Table 32: ARM 4 and ARM 8 Test Result Summaries 

9.9.1 ANORECTAL SUMMARY 
To access the Anorectal Summary window: 

 Click Info > ARM 4 & 8. 
 Select Anorectal Summary.  The Anorectal Summary window will appear. 
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 PROFILE TAB 

 

 

ARM Profile Summary 
• Rest / Squeeze Length to Max Pressure (cm): Distance in centimeters from position of start of test until 

max pressure is reached. 
• Rest / Squeeze Anal Canal Length (cm): Total length in centimeters of anal canal (the total distance 

between start and stop of test). 
• Rest / Squeeze Max Pressure (mmHg): Maximum rest and squeeze pressures (mean, min, max, etc) in 

mmHg. 
• Rest / Squeeze HPZ (High Pressure Zone): Sphincter length in centimeters where the pressure is greater 

than the (Max Pressure*2/3) of the segment. 
• Rest / Squeeze HPZ (High Pressure Zone) Area: The sum of the area underneath the pressure curve 

where the pressure is greater than the (Max Pressure*2/3) of the segment (the Area of the HPZ is 
calculated in cm*mmHg). 

• Mean Pressure = Average pressure in entire high-pressure zone (from START to STOP). 
• Anal Canal Length: Length of anal canal in centimeters. 
• Anal Canal Mean Pressure: Average Pressure in the Anal Canal Length zone. 
• Anal Canal Area: Anal Canal Mean Pressure multiplied by the Anal Canal Length  (Area in the Anal Canal 

Length zone) 

NOTE: NOTE REGARDING CALCULATIONS: 

 The Mean value is the total sum of the calculated values of each channel divided by the number of channels used in the 
test. 

o Formula: Mean = SUM (Yn) ÷ Total number of channels used in test 
Where: Yn is the calculated value of the channel; n represents the channel number (which can be from 1 to 8). 

 
 

 The SD (standard deviation) is the square root of the sum of the calculated value of each channel minus the mean value, 
squared, and then divided by the total number of channels minus 1.  
 

o Formula : SD = � SUM (Yn−Mean)2 

(total number of channels used in test −1)
  

 Where: Yn is the calculated value of the channel; n represents the channel number (which can be from 1 to 8); and Mean 
is the value from the Mean column. 

Enter the Threshold 
value. Default value is 

0 (zero). 

Select the Add to Report box 
to add that section’s data to 
the final report (and will also 

be transferred to i-LIST™ 
Office Reporter. 
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 STATIONARY TAB 
Refer to the Figure 196 below for a visual of the Stationary Tab in the Anorectal Summary window.  The Stationary Summary 
Circle Diagram, Pressure Variation, Stationary Resting Summary, Stationary Squeezing Summary, and Stationary Pushing 
Summary options are available from the Stationary Tab. 
 

 
Figure 196: Anorectal Summary Window – Stationary Tab 

Stationary Summary Circle Diagram: 
• Outside Circle Values: Maximum Squeeze values at that position (mmHg). 
• Inside Circle Values: Maximum Rest values at that position (mmHg). 
• Highest Peak Rest Pressure: Maximum value in average channel for Peak Resting pressure. 
• Highest Peak Squeeze Pressure: Maximum value in average channel for Peak Squeeze pressure. 
• Highest Peak Squeeze Increase Pressure: Maximum value in average channel for Peak Increase pressure. 
• Rest Anal Canal Length (cm): Displays the length of the anal canal. If the value at the start of the 

measurement is greater than the ACL Threshold then then 1 cm is added to the Rest Anal Canal Length. 
• Squeeze Anal Canal Length (cm): Displays the length of the anal canal. If the value at the start of the 

measurement is greater than the ACL Threshold then then 1 cm is added to the Squeeze Anal Canal Length. 

Pressure Variation:  
• Pressure Variation dropdown: detects the presence or calculates the values associated with slow and ultra-

slow waves.  The dropdon menu provides various status options for the presence of slow and ultra-slow 
waves. Click the Select Region button and select the region on the graph where slow waves exist. 

• Average Amplitude: The average pressure value in mmHg of the selected region. 
• Average Frequency: The frequency in cycles/min of the pressure waves. 

Stationary Resting Summary:  
Displays all values relevant to Rest data dependent on position and specific sensor/lumen. 

• Rest Mean Pressure: Average pressure during the Stationary Resting period. 
• Rest Duration: Total time from Start to Stop of the Stationary Resting period. 
• Rest HPZ (High Pressure Zone): The sum of the area underneath the pressure curve where the pressure is 

greater than the (Max Pressure*2/3) of the segment during the Stationary Resting period. 
• Rest Peak: Peak pressure of the Stationary Resting period 
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Stationary Squeezing Summary:  
Displays all values relevant to Squeeze data dependent on position and specific sensor/lumen. 

• Area: Total area underneath the curve in min*mmHg. 
• Peak: Maximum squeeze pressure in mmHg. 
• FRI (Fatigue Rate Index): Value in minutes used to correlate to the fatigue rate of the sphincter. Calculated 

as the difference between max squeeze and max resting pressure (mmHg) divided by the slope of a line of 
best fit of the squeeze curve (mmHg / min). 

Stationary Pushing Summary:  
Displays all values relevant to Pushing data dependent on position and specific sensor/lumen. 

• Push Mean Pressure: Average pressure during the Stationary Pushing period.  
• Push Peak: Peak pressure of the Stationary Pushing period 

 

 RECTAL VOLUME TAB 
Refer to the Figure 197 below for a visual of the Stationary Tab in the Anorectal Summary window.   

 
Figure 197: Anorectal Summary – Rectal Volume Tab 

Select the Add to Report box to add that section’s data to the final report.  The data will also be transferred to i-LIST™ 
Office Reporter where applicable. 
 
The following data options are found in the Rectal Volume Tab: 

• First Sensation: The value in ml where the patient first felt rectal distention. 
• Urge: The value in ml where the patient first felt the urge to defecate. 
• Max Tolerance: The value in ml where the patient felt they could not tolerate further rectal distention. 
• Compliance: (ONLY possible when Rectum Pressure is measured and is only available on select systems; to 

activate this, first map the “rectal pressure” row in the channel mapping section). Compliance, in mmHg, is 
the average change in pressure (mmHg)) as a result of a change in volume (ml) from first sensation to max 
tolerance. NOTE: compliance measurements are not possible with T-DOC air-charged catheters. 
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 RAIR TAB 
Refer to the Figure 198 below for a visual of the Stationary Tab in the Anorectal Summary window.   

 
Figure 198: Anorectal Summary Window - RAIR Tab 

The Rectoanal Inhibitory Reflex Summary, Simple vs. Detailed RAIR, Excitation, and Inhibition options are available in the 
RAIR Tab. 
Select the Add to Report box to RAIR data to the final report.  The data will also be transferred to i-LIST™ Office Reporter 
where applicable. 

Rectoanal Inhibitory Reflex Summary 
• RAIR: allows user to select whether RAIR is present or absent at given volume. 
• Volume: Allows user to select which RAIR test to view and print with report. 

Simple vs. Detailed RAIR: 
• Simple RAIR: RAIR test used to only detect whether RAIR is present or absent. 
• Detailed RAIR: Includes simple RAIR with the detailed data below. 
• Reference Resting Pressure: Pressure in mmHg at which the RAIR test starts. 

Excitation:  
• Linear Change: Increase in Pressure in % (based on using the Reference Resting Pressure as 100%) during the 

initial rise in pressure associated with RAIR test. 
• Latency: Time taken for the excitation response to occur post event initiation. 

Inhibition: 
• Linear Change: Decrease in Pressure in % (based on using the Reference Resting Pressure as 100%) during 

the main drop or pressure inhibition associated with RAIR test. 
• Latency: Time taken for the inhibition response to occur post event initiation. 

 
Pop-up window to input RAIR Present/Absent after test: Select whether the RAIR Present/Absent pop-up window is 
displayed after a test. 
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 EXPULSION TAB 
Refer to the Figure 198 below for a visual of the Stationary Tab in the Anorectal Summary window. 

 
Figure 199: Anorectal Summary – Expulsion Tab 

The following features are available in the Expulsion Tab: 
• Volume: Select the catheter volume, in ml, at which the expulsion test was performed. 
• Result: Select whether the balloon was expelled or not expelled by the patient. 

Select the Add to Report box to add that section’s data to the final report (and will also be transferred to i-LIST™ Office 
Reporter. 

9.9.2 ARM RESTING, SQUEEZING, OR PUSHING PRESSURE PROFILE SUMMARIES 
 Click Info > ARM 4&8. 
 Select Resting Profile, Squeezing Profile, or Pushing Profile.  The corresponding ARM profile window will 

display the pressure summary only. 

NOTE:  
In the following diagrams: 
1 = Buttons to close the window or print the summary.  
2 = Summary of the pressure profile. For resting profile, each pressure displayed is the pressure average over 5 mm; for 
squeezing and pushing profile, display of pressure summary for each position. 
3 = Average pressure curve.  

NOTE: For information on activating 3D plot imaging, contact your LABORIE representative. 
 

a. The ARM Resting Profile example displays a pressure summary for the first resting profile. To view results 
for a second profile, open the Events Summary (Info > Events Summary) and delete the events marking 
the first profile.  Refer to ARM Stationary Resting Profile Summary window in Figure 200. 

 
 

Figure 200: ARM Resting Profile 4 channel ARM Example 
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b. Refer to ARM Stationary Squeeze Profile Summary window in Figure 201. 

 
 

Figure 201: ARM Squeezing Profile Example 
  

c. Refer to ARM Stationary Pushing Profile Summary window in Figure 202. 

 
 

Figure 202: ARM Pushing Profile Example 
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9.9.3 ARM STATIONARY RESTING, SQUEEZING, OR PUSHING SUMMARIES 
 Click Info > ARM 4&8. 
 Select ARM Stationary Rest, ARM Stationary Squeeze, or ARM Stationary Push.  The corresponding ARM 

profile window will display the summary. 

NOTE: 
In the following diagrams: 
1 = Buttons to close the window or print the summary.  
2 = Summary of the pressure profile. Entries are divided by seconds and display a pressure summary for each position. 
3 = Average pressure curve.  

NOTE: For information on activating 3D plot imaging, contact your LABORIE representative. 
a. Refer to ARM Stationary Rest Summary Window in Figure 203. 

 

 
Figure 203: ARM Stationary Rest Summary Window 

 
b. Refer to ARM Stationary Squeeze Summary window in Figure 204. 

 

Figure 204: ARM Stationary Squeeze Summary Window 
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c. Refer to ARM Stationary Push Summary window in Figure 205. 

 

Figure 205: ARM Stationary Push Summary Window 

 PRINTING ARM TEST RESULTS 
9.10.1 PRINTING TEST RESULTS THROUGH THE UDS SOFTWARE 
Ensure that a test file is open in the UDS software.  By default, if you have performed a specific test, such as RAIR, the 
software will suggest printing the associated RAIR Summary. If you have not performed a certain test, the associated print 
option will be inaccessible. 
 
To access the UDS Software Print Options window, click File > Print.  The Print Options dialog box will appear.  Refer to 
the following figure (Figure 206).  Select the summaries for inclusion in the printout and click OK. 

  
Figure 206: Print Options Window – ARM Section 

 
For an overview of the ARM summaries listed on the Print Options window, refer to the Anorectal Summary section on page 
155.   
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9.10.2 PRINTING TEST RESULTS THROUGH I-LIST OFFICE REPORTER 
Once a test is run and complete, click the Reporter button on the UDS software control panel to open and print reports 
generated with the test data. 
 

 
 

To print the report, click the Print icon  on the toolbar in the i-LIST Office Reporter software. 

NOTE: To print a saved test file, open the test file in the File > Open window of the UDS software and then click the 
Reporter button on the control panel to open the i-LIST Office Reporter software. 

9.10.3 COMPREHENSIVE ARM REPORTS 
A complete study report is available through the i-LIST Office Reporter application. Select the ARM Report – 
Comprehensive option in the reports(s) listing to obtain this type of report.  This report contains items such as: 

• Narrative-style summary of tests 
• Graphs of test results 
• Tables listing average values 
• A graph printout of the test with event plots 
• EMG assessment graph 
• Pudendal nerve latency information 
• Ultrasound images 
• Answers to any questionnaires administered before the test 

 CUSTOMIZING THE ARM TEST 
If modifying or creating a new test, click Config > Setup/Modify to open the Configuration window. 

9.11.1 PART 1: SET CHANNELS FOR ARM STUDIES 
 Navigate to the Channel Settings Tab. 
 Configure four or eight pressure channels.   
 Configure one Math Channel as the average of all pressure channels.  Pressure units are cmH2O, mmHg, or 

mmHg’. By default Pressure Channels are displayed in mmHg’. See following page for details of how to calibrate 
and use each unit of measure. 

2. Configure EMG Channel(s) (optional). 
3. Configure IH2O and VH2O (optional). 
4. All other settings can remain as the default settings. 
5. Click Apply and continue with setting up the ARM tab. 
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ARM Study Units 
The following Arm Study units may be used for calibration: 

• cmH2O: Calibrate pressure transducers in cmH2O and display data in cmH2O. 
• mmHg: Calibrate pressure transducers in mmHg using a cmH2O to mmHg conversion. Data is displayed in 

mmHg. 
NOTE: 100mmHg = 136cmH2O 

• mmHg’: Calibrate pressure transducers in cmH2O and display data in mmHg using the software conversion 
unit mmHg’. 

9.11.2 PART 2: SET UP ARM TAB 
Navigate to the ARM Tab and select the channels that correspond to the ARM measurements recorded through testing. 
This tab is used to generate test result summaries, so the selections made here are important for accurate reporting (Figure 
207). 

 
Figure 207: Example ARM Configuration for Four Pressures 

Enable Reverse Pump for Balloon Filling 
If using the pump, select the Enable Reverse Pump option in the ARM Tab to activate the reverse pump button on the 
control panel.  The reverse pump button can be configured in the Control Panel Settings dialog box. Refer to the Glossary 
of ARM 4&8 Control Panel Commands on page 169 for button configuration options. Once the reverse pump button on 
the control panel is clicked, a warning message will appear requesting confirmation to continue (Figure 208).  

 
Figure 208: Reverse Pump Warning Message – Button Enabled and Clicked 

Click Yes to continue or No to cancel.  The reverse pump action is intended only for deflating the rectal balloon before 
catheter removal. Do not run the reverse pump feature for any other actions.  A Start Infusion and Stop Infusion event 
will be added to the graph when reverse pump is started and stopped.   

If the Enable Revers Pump options is not activated in the ARM Tab and the control panel button is clicked, an error message 
will appear: 

 
Figure 209: Revers Pump Error Message – Button Clicked, Not Enabled 
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9.11.3 PART 3: CONFIGURE THE CONTROL PANEL FOR ARM STUDIES 
1. Click Options from the menu bar. 

2. Select Control Panel Settings.  The Command box will appear displaying the first row of Control Panel buttons. 

3. Click the arrow next to the Control Panel Set Name and select ARM 4&8. 

   

Figure 210: Control Panel Command Window - Selection for ARM 

NOTE: The last two buttons of the first and second rows are reserved for system use. You can program the rest as 
needed. 

ARM Properties 
Each ARM button has a start and a stop event. Some of the ARM buttons can be configured to stop automatically after a 
specified time and to shade regions between start and stop events. 

 Open the Properties window by clicking the PLUS (+) button next to an ARM Control Panel button.  
 Select Automatically insert STOP event after and enter a value in seconds. The default value is 10 seconds. 
 To add shading between start and stop events, select show region for the ARM event, and click the Select Color 

box to choose the color. 

 

Figure 211: ARM Control Panel Buttons Properties Setup 
 Click OK to save changes. 
 Once saved, continue with the setup of the puller buttons (if you are using the Puller) or continue with the start of 

the ARM test.  
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9.11.4 CREATE CONTROL BUTTONS FOR THE MECHANICAL UPP PULLER (OPTIONAL) 
Program control panel buttons to use the LABORIE Mechanical UPP Puller (UPP1001) and Controller (UPP1000 during the 
ARM test. 
 

 If there are no free button spaces under the ARM Control Panel Set Name, add a row of buttons by increasing the 
number in the Number of Rows box.  

 Select the down arrow next to Current row field to navigate to the newly created row. 
 Create a Pull button.  The Pull button will pull the catheter at a specified rate once configured. 

a. Select the Label box and type Pull.  
b. In the Definition box, type PU. 
c. On the same row, in the third box, select UPP Command from the dropdown menu. 

d. On the same row, cclick the PLUS button   to set a fixed distance for stopping the puller. 
 Create the Pull 1 cm button.  Move to the next line and type Pull 1 cm in the Label box, type PU 10 in the 

Definition box, and then select UPP Command in the listing. This button will command the puller to withdraw the 
catheter 1 centimeter (10mm) when clicked. 

 Create the Stop Pull button.  Move to the next line and type Stop Pull for the label, ST for the definition and then 
select UPP Command in the listing. This button will stop catheter withdrawal. 

 Create the Return button.  Move to the next line and type Return for the label, IN for the definition, and then 
select UPP Command. This button will move the puller guide forward.   

 Refer to Figure 212 for an example of completed setup. 

  

Figure 212: Control Panel Command Window – ARM 4& 8 UPP Commands 
6. Click OK. 
7. Continue with the setup of the sensation events. 

9.11.5 CREATE FIRST SENSATION, URGE, AND MAX TOLERANCE EVENTS 
If filling the rectal balloon manually with a syringe, the user must enter volumes at first sensation, urge, and max tolerance.    
To setup Sensation buttons to trigger the volume input request, click Info > ARM 4&8 > Anorectal Summary and select 
the Rectal Volume tab.  Select the Input volume immediately after inserting events option (Figure 213) and click OK.  Click 
Config > Save As and assign a name to the file to make this a default setting.  A message box will appear asking for input 
volume when First Sensation, Urge, or Max Tolerance events are selected.  
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Figure 213: Anorectal Summary – Rectal Volume Tab – Volume Input Setting 

 
When using the integrated pump, the volumes will be marked automatically with the sensation buttons.  Ensure to specify 
the VH20 channel in the test’s Configuration file then, follow the instructions below to enter sensations during an ARM test.     

 Click the ARM button on the Control Panel. 
8. Click Run and let the test run for a few moments  
9. Click the buttons labelled First Sensation, Urge, and Max Tolerance. 
10. Click Stop. 
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9.11.6 GLOSSARY OF ARM 4&8 CONTROL PANEL COMMANDS 
Suggested Button Label Definition Type 

First Sensation 
First Urge 
Max Tolerance 

First Sensation 
Urge 
Maximum Tolerance 

Event 
Marks an event with the definition text as Event 
Annotation. 

ARM 4 Radial 
ARM 8 Radial 

Full path of CFG file 
Example: c:\cfg\ 

Config 
Opens a .cfg file. 

Set Zeroes N/A Set Zeroes 
Sets all channels to zero. 

Return IN (returns the puller as fast as possible; for 
positioning the puller) 

UPP Command (Controls the puller speed) 
IN XX (returns the puller XX millimeters as fast as 
possible; used for positioning the  puller) 
 

Pull PU (pulls at default Puller speed; stops when it 
reaches the tip) 

PU  (pulls the puller as fast as possible; used for 
positioning the puller) 
 

Pull X cm PU XX PU XX (pulls the puller XX millimeters at the 
default speed; for example PU 15 will pull the 
Puller for 15 mm at the default speed) 

Stop Pull ST (stops the pull)  
Patient Info N/A Patient Info 

Opens Patient Info window. 
Resting 
Squeezing 
Pushing 
6 cm Push 
5 cm Push 
4 cm Push 
3 cm Push 
2 cm Push 
1 cm Push 
6 cm Squeeze 
5 cm Squeeze 
4 cm Squeeze 
3 cm Squeeze 
2 cm Squeeze 
1 cm Squeeze 
6 cm Rest 
5 cm Rest 
4 cm Rest 
3 cm Rest 
2 cm Rest 
1 cm Rest 
10 cc 
20 cc 
30 cc 
40 cc 
50 cc 
60 cc 
70 cc 
80 cc 
90 cc 
100 cc 
110 cc 
RAIR 
Expulsion 
Pushing 

RE (event for Resting Profile) 
SQP (event for Squeezing Profile) 
PUSH (event for Pushing Profile) 
SP6 (events for Stationary Study) 
SP5  
SP4 
SP3 
SP2 
SP1 
ST6 
ST5 (events for Stationary Study) 
ST4 
ST3 
ST2 
ST1 
SR6 
SR5 (events for Stationary Study) 
SR4 
SR3 
SR2 
SR1 
10cc (events for RAIR studies) 
20cc 
30cc 
40cc 
50cc 
60cc 
70cc 
80cc 
90 cc 
100cc  
110cc 
RAIR 
E 
PUSH 

ARM 
Controls Anorectal Manometry procedures 
performed with 4 or 8 pressure circumferential 
catheters.  
 

Slow Fill 
Medium Fill 
Fast Fill 
XXX ml/min 
+YY ml/min 
-ZZ ml/min 
 

SF 
MF 
FF 
SP=XXX (where XXX is in ml/min) 
SP+YY (where YY is the incremental rate) 
SP-ZZ (where ZZ is the decremental rate) 

Pump Command 
Controls the pump fill rate. 
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Suggested Button Label Definition Type 

Reverse Slow Fill 
Reverse Medium Fill 
Reverse Fast Fill 

RSF 
RMF 
RFF 

Controls the reverse pump fill rate† 

 

† The Reverse Fill pump feature runs the LABORIE pump in reverse direction and can be used during ARM tests to quickly 
fill and then drain the large balloon used for evoking responses based on the sensation of rectum filling. Depending on the 
software version you are running, if you program your pump commands as ff, mf, and sf, then you can add the rff, rmf, and 
rsf. If you program the commands as fast fill, medium fill and slow fill, then you can program the reverse as reverse fast fill, 
reverse medium fill, and reverse slow fill.  

 IMPORTANT: Reverse Fill is not a feature meant to drain the bladder during Urodynamics testing! It is to be used 
only to drain the large balloon during ARM testing! 

Table 33: ARM 4&8 Control Panel Commands 
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10 RUN UDS TESTS WITH AQUARIUS 
 UROFLOW TESTS 

A Uroflow test is a measurement of the rate at which urine flows out of the body. It can be performed using the UDS 
software’s auto-recording method, or it can be performed with manual control of the software. 

10.1.1 UROCAP™ V SETUP FOR UROFLOW TEST 
 Gather the supplies needed for a Uroflow test.  Ensure the battery of the Urocap™ IV is fully charged 
 Carefully place the Urocap™ V on the floor or on an approved Uroflow transducer stand. Positions a graduated 

beaker on top of the Urocap™ V. 
 Place the funnel on the plastic frame of the commode chair and position both over the Urocap™ V and beaker.  

Ensure that the beaker and the funnel are aligned but not touching.  
 Ensure that the computer is turned on, the device is connected, and the printer is turned on. 
 Start the UDS software and click the Uroflow button on the control panel corresponding to the Urocap™ V. 
 Once the Uroflow test enters the pretest screen, enter Patient Information. 

NOTE: The Uroflow button is a customizable button and may be renamed.  The connection icon next to the devices 
used during the study will not be visible for the length of the study. 

10.1.2 RUN A UROFLOW TEST USING A UROCAP™ V 
 RUN A UROFLOW TEST: AUTO METHOD 

 Click the Uroflow button on the control panel.  Ensure the button is configured to the appropriate configuration 
(CFG) file for a Uroflow test with the auto-recording option enabled. 

 Tap on the Urocap™ V to make sure it is responding. 
 The program will automatically begin to process the data when the transducer detects the start of flow. 

Alternatively, click the Run button to start the test. 
 Instruct the patient to void.  If possible, leave the room to allow patient privacy. 

 CAUTION: Do not touch the beaker during voiding. 
 The graph will stop automatically 50 seconds after voiding has ended. 
 If desired, straight catheterize the patient or use a bladder scanner to obtain post-void residual measurement.  

When the Uroflow Summary screen appears enter the PVR value and click OK. 
 Click the Save button on the control panel to save the file or click Reporter to save, view, and print a test report 

in iList. 
 Empty the beaker and thoroughly wash for reuse. 

 RUN A UROFLOW TEST: MANUAL METHOD 
 Click the Uroflow button.  Ensure the button is configured to the appropriate CFG file for a Uroflow test. 
 Tap on the Urocap™ V to make sure it is responding. 
 Click Set Zeroes on the control panel and click Run to start the test. 
 Instruct the patient to void. If possible, leave the room to allow patient privacy. 

 CAUTION: Do not touch the beaker during voiding. 
 When voiding is complete, click the Stop button. 
 If desired, straight catheterize patient or use a bladder scanner to obtain post-void residual measurement. 
 Click Summ. Review button on the control panel to view the Uroflow summary results. Then click Return to Test 

to continue.  Type the post-void residual volume in the PVR box and click OK. 
 Click the Save button on the control panel to save the file or click Reporter to save, view, and print a test report 

in iList. 
 When the Save Test File box appears click the Save button in the box. 
 Empty the beaker and thoroughly wash for reuse. 
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10.1.3 SPINNING DISK FLOW TRANSDUCER SETUP 
 Gather the supplies needed for a Uroflow test.  Ensure the Spinning Disk Flow Transducer is plugged into a wall 

outlet.   
 Ensure that the computer is turned on, the device is connected, and the printer is turned on. 
 Start the UDS software and click the Uroflow button on the control panel corresponding to the Urocap™ V. 
 Once the Uroflow test enters the pretest screen, enter Patient Information. 

NOTE: The Uroflow button is a customizable button and may be renamed.  The connection icon next to the devices 
used during the study will not be visible for the length of the study. 

10.1.4 RUN A UROFLOW TEST USING A SPINNING DISK FLOW TRANSDUCER 
 Select the appropriate configuration (CFG) file for a Uroflow test.  To use automated features ensure auto-

recording options are enabled. 
 Confirm that the top right button of the Control Panel is green and displays “Run.” 
 Confirm that the LED light on the Spinning Disk’s control box is green and blinking. 
 Instruct the patient to void.  If possible, leave the room to allow patient privacy.  The program will automatically 

begin to process the data when the Spinning Disk Flow Transducer detects the start of flow. Alternatively, click 
the Run button to start the test. 

 The graph will stop automatically 50 seconds after voiding has ended.  Alternatively, select the Stop button to 
stop the study. 

 If desired, straight catheterize patient or use a bladder scanner to obtain post-void residual measurement. 
 Click Summ. Review button on the control panel to view the Uroflow summary results.  If automatic features are 

enabled the Uroflow Summary screen will appear automatically.  Enter the PVR value and click OK. 
 Click the Save button in the control panel to save the file or click Reporter to view and print a test report. 
 Empty the beaker and thoroughly wash for reuse. 

 CMG TEST OR MICTURITION (PRESSURE/FLOW) 
The purpose of running a CMG test is to determine whether the bladder and its surrounding tissues are functioning 
correctly. The CMG test involves filling the bladder and determining the Detrusor pressure Pdet = Pves – Pabd (the 
difference between the pressure inside the bladder (Pves) and the pressure inside the abdomen (Pabd)). 

• Calibrate all transducers before running the test. 

• Operators should be knowledgeable and qualified in applying the appropriate aseptic technique during the 
intended use of the device. 

10.2.1 RUN A CMG/MICTURITION TEST WITH AIR-CHARGED CATHETERS 
1. Gather supplies needed for testing (catheters, beaker, commode chair, funnel, cable transducers, etc.). 
2. Turn on and connect all equipment required for the study. 

a. Turn on the computer and the printer.  Start the software. 
b. Ensure the Roam™ DX and Urocap™ V are connected to the software and at full battery. 
c. Connect the transducer cables to the Roam™ DX and the catheters to the transducer cables.  Connect 

the primed infusion line to the filling lumen on the vesical catheter.  Ensure the compressible portion of 
the Infusion Pump Tubing is inserted through the pump. 

3. Click the CMG/PF button on the control panel and enter the patient’s information if necessary. 
4. Check that the chargers of the transducer cables are in the OPEN position. 
5. Click the Zero All button on the control panel. 
6. Position the patient in the supine or lithotomy position with legs in stirrups for catheter insertion. 
7. Insert the Air-Charged Catheters into the patient. 

NOTE: Bladder catheter placement for women is 8-10 cm for single sensor and 12-14 cm.  For men insert Bladder 
catheters 8cm plus penile length. Place the abdominal catheter rectally 10 -15cm, past any stool, along the anterior wall of 
the rectum.   

 IMPORTANT: These are approximate guidelines.  Ensure that the catheter sensor is fully inserted into the bladder 
without over insertion. 

8. Prepare the patients skin and apply EMG patches; the patient’s skin should be clean, dry, and free of hair. Ensure 
electrodes are snapped onto the 3 EMG leads.  Place two electrodes peri-anally at the 10 o’clock and 2 or 3 
o’clock positions.  Place the third electrode on a bony prominence such as the patient’s hip bone or knee. 
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9. Switch the transducers to the CHARGE position to record true internal pressures.  When recording two pressures 
during a CMG or Pressure/Flow test, Pves and Pabd should be fairly equal and Pdet should be at or near zero. 

10. Ask the patient to cough to confirm catheter positioning. When recording two pressures at the same time, the 
cough will show equal deflection on both channels. 

NOTE: If Pabd is higher than Pves, try repositioning the Pabd catheter. If repositioning does not work, ask the patient 
to cough to confirm that both pressures are reacting appropriately. 

11. Select the applicable calibration file for a CMG/Micturition test then click the Run button on the control panel. 
12. Click the Start Pump button to start the pump and begin filling the bladder. 
13. Mark relevant events using buttons available in the control panel (for example: First Sensation, First Desire and so 

on).  Encourage the patient to give feedback on sensation or urge. 
14. Click Stop Pump to stop infusing when the patient is full and click Capacity on the control panel to mark the 

event.  
15. Click the Permit to Void button and ask the patient to void through the commode chair into the Urocap™ 

V beaker (with catheters in place). 
16. Click the Stop button when finished and then click the Save button on the control panel to save the test file. 
17. Print the results of the test if desired. 
18. Remove the catheters, EMG patches, and pump tubing and dispose in accordance to hospital/clinic procedures. 
19. Empty and thoroughly wash the beaker for reuse. 

 

10.2.2 RUN A CMG / MICTURITION TEST USING FLUID-FILLED CATHETERS 
1. Gather supplies needed for testing (catheters, beaker, commode chair, funnel, transducers, etc.). 
2. Turn on and connect all equipment required for the study. 

a. Turn on the computer and the printer.  Start the UDS120 GOBY software. 
b. Ensure the Roam™ DX and Urocap™ V are connected to the software and at full battery. 
c. Prime the transducers pressure cartridges, measurement tubing, and pump tubing.   
d. Click the CMG/Micturition button on the control panel.  Ensure all the pressure transducers are 

responding. Press the 100 mm Hg button on the pressure transducer cartridge and tap the beaker on the 
Uroflow transducer. NOTE: 100 mm Hg = 136 cm H20. 

3. Position patient in the supine or lithotomy position with legs in stirrups for catheter insertion. 
4. To zero the transducers, first adjust the pressure cartridges to the height of the patient’s bladder.  Turn the stop 

cocks “OFF” to the cartridges, remove the stopper caps, and select Set Zeroes on the Control Panel.  Replace 
the stopper caps and turn the three-way stop cocks “OFF” to the syringe. 

5. Set up and prime the catheters in accordance with device specific instructions for use. 
6. Insert the Bladder and Abdominal Catheters.  Tape catheters as close to the insertion site as possible. 
7. Connect the pressure measurement lines and pump tubing to the appropriate catheter ports and cables. 
8. Prepare the patients skin and apply EMG patches; the patient’s skin should be clean, dry, and free of hair. Ensure 

electrodes are snapped onto the 3 EMG leads.  Place two electrodes peri-anally at the 10 o’clock and 2 or 3 
o’clock positions.  Place the third electrode on a bony prominence such as the patient’s hip bone or knee. 

9. Ask the patient to cough in order to verify that the channels are responding. 
10. Select the Calibration file for the CMG/Micturition test and then click the Run button on the control panel.   
11. Click the Start Pump button to start the pump and begin filling the bladder. 
12. Mark relevant events using the buttons available on the control panel (for example: First Sensation, First Desire 

and so on).  Encourage the patient to give feedback on sensation or urge. 
13. Click Stop Pump to stop infusing when the patient is full and click Capacity on the control panel to mark the 

event. 
14. Click the Permit to Void button and ask the patient to void through the commode chair (with catheters in place) 

into the Urocap™ V beaker. 
15. Click the Stop button when finished and then click the Save button on the control panel to save the test file. 
16. Print the results of the test if desired.  
17. Remove the catheters, EMG patches, and pump tubing and dispose in accordance to hospital/clinic procedures. 
18. Empty then thoroughly wash the beaker for reuse. 
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 UPP TESTS 
A UPP test is used to measure the length of the urethra and to measure the pressure within the urethra.  An optional UPP 
Puller may be used in conjunction with the UDS Software to run a UPP test. To setup the UPP stand refer to the Assemble 
the Puller Stand (Optional) section on page 21. 

 IMPORTANT: The UPP puller is intended for catheter withdrawal only! 
• Calibrate all transducers before running the test. 
• Operators should be knowledgeable and qualified in applying the appropriate aseptic technique during 

the intended use of the device. 

10.3.1 RUN A UPP TEST USING AIR-CHARGED CATHETERS 
 Gather supplies needed for testing (catheters, cable transducers, pump tubing, etc.). 
 Turn on and connect all equipment required for the study. 

a. Turn on the computer and the printer.  Start the software. 
b. Ensure the Roam™ DX and the UPP puller are connected to the software and at full battery. 
c. Connect the transducer cables to the Roam™ DX and the catheters to the transducer cables.  Connect 

the primed infusion line to the filling lumen on the vesical catheter.  Ensure the compressible portion of 
the Infusion Pump Tubing is inserted through the pump. 

 Click the UPP button on the Control Panel. 
 If the UPP button is not visible click Options > Control Panel Settings and select the PressureFlowUPP control 

panel set.   

NOTE: The connection icon next to the devices used during the study will not be visible for the length of the study. 
 Check that the chargers of the transducer cables are in the OPEN position. 
 Click the Zero All button on the control panel. 
 Invite the patient to take the test.  Enter Patient Information. 
 Position the patient in the supine or lithotomy position with legs in stirrups for catheter insertion. 
 Insert a triple-lumen catheter into the patient’s bladder. 

NOTE: Bladder catheter placement for women is 8-10 cm for single sensor and 12-14 cm.  For men insert Bladder catheters 
8cm plus penile length. Place the abdominal catheter rectally 10 -15cm, past any stool, along the anterior wall of the rectum.   

IMPORTANT: These are approximate guidelines.  Ensure that the catheter sensor is fully inserted into the bladder without 
over insertion. 

 Switch the transducers to the CHARGE position to record true internal pressures. 
 Click Run on the Control Panel. 
 If required, infuse the desired volume into the bladder using the pump. 
 Once ready, stop the pump. 
 Click Start Pull (or press F6 on the keyboard) and the UPP puller will begin to remove the catheter from the 
patient’s bladder at the preset speed.  

NOTE: If you do not have a UPP puller, pull the catheter out manually at a slow and steady rate.  Watch the cm markers 
on the catheter; it should take a count of 10 to go from one marker to the next [pulling at 1mm/sec].  When the Pura and 
Pclo curves rise, Pves should remain stable indicating that the sensor is traveling through the urethra. 

 When the Pura sensor on the catheter has been pulled out from the urethra, Pura returns to 0, select Stop Pull (or 
press F6). 

 Select the Return button to set up the UPP for the next catheter pull.  Reinsert the catheter. 

NOTE: The catheter must be reinserted manually, not using the UPP puller. 
 Click the Stop button when finished and then click the Save button to save the test file. 
 Print the results of the test if desired. 
 Remove the catheters, EMG patches, and pump tubing and dispose in accordance to hospital/clinic procedures. 
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10.3.2 RUN A UPP TEST USING WATER-FILLED CATHETERS 
 Gather supplies needed for testing (catheters, transducers, pump tubing, etc.). 
 Turn on and connect all equipment required for the study. 

e. Turn on the computer and the printer.  Start the UDS120 GOBY software. 
f. Ensure the Roam™ DX and UPP Puller are connected to the software and at full battery. 
g. Prime the transducers pressure cartridges, measurement tubing, and pump tubing.  Click the UPP button 

on the Control Panel.  If the UPP button is not visible click Options > Control Panel Settings and select 
the PressureFlowUPP control panel set.   

h. Ensure all the pressure transducers are responding. Press the 100 mm Hg button on the pressure 
transducer cartridge and tap the beaker on the Uroflow transducer. NOTE: 100 mm Hg = 136 cm H20. 

NOTE: The connection icon next to the devices used during the study will not be visible for the length of the study. 
 Position patient in the supine or lithotomy position with legs in stirrups for catheter insertion. 
 To zero the transducers, first adjust the pressure cartridges to the height of the patient’s bladder.  Turn the stop 

cocks “OFF” to the cartridges, remove the stopper caps, and select Set Zeroes on the Control Panel.  Replace 
the stopper caps and turn the three-way stop cocks “OFF” to the syringe.  Set the zeroes with the perfusion line 
dripping at 1 drop every 2 to 3 seconds 

 Set up and prime the catheter in accordance with device specific instructions for use. 
 Invite the patient to take the test.  Enter Patient Information. 
 Position the patient in the supine or lithotomy position with legs in stirrups for catheter insertion. 
 Insert a triple-lumen catheter into the patient’s bladder. 
 Click Run on the Control Panel. 
 If required, infuse the desired volume into the bladder using either the pump or the Infusion Transducer. 
 Once ready, stop the pump or close the roller valve on the infusion line. i.e. stop the pump line and not the UPP 
drip line. 

NOTE: If you do not have a UPP puller, pull the catheter out manually at a slow and steady rate.  Watch the cm markers 
on the catheter; it should take a count of 10 to go from one marker to the next [pulling at 1mm/sec].  When the Pura and 
Pclo curves rise, Pves should remain stable indicating that the sensor is traveling through the urethra. 

 When the Pura sensor on the catheter has been pulled out from the urethra, Pura returns to 0, select Stop Pull (or 
press F6). 

 Select the Return button to set up the UPP for the next catheter pull.  Reinsert the catheter. 
 Click the Stop button when finished and then click the Save button to save the test file. 
 Print the results of the test if desired. 
 Remove the catheters, EMG patches, pressure tubing, transducer cartridges and pump tubing and dispose in 
accordance to hospital/clinic procedures. 
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11 TROUBLESHOOT AND SERVICE 
If problems continue, contact LABORIE’s Service team at 1-800-333-1039 or email service@laborie.com. 
Follow the instructions provided in the table below for troubleshooting steps. 

Symptom(s) Possible Cause(s) Check/Corrective Action(s) 

ALL DEVICES 

No response from the 
devices? 

No power on electrical 
outlet? 

Plug the system into a known working electrical outlet. 

Damaged power cord? Unplug the system and contact LABORIE for a replacement 
power cord. 

Power cord is not 
connected properly? 

Ensure the power cord is secure at the base of system and at 
the electrical outlet. 

Devices are not connected 
in software? 

Connect the devices to the system.  Refer to the Using the 
Module Touchscreen on page 34. 

Wrong connection type? Make sure the correct connection type (either Bluetooth or 
USB) is selected under the Connection Type sub-menu. Refer 
to the Connection Type section on page 130. 

Computer or Printer 
cannot power on? 

No power on electrical 
outlet? 
Damaged power cord? 
Power cord not connected 
properly? 

Ensure electrical outlet is working, power cords are not 
damaged, and all power cords are secure at both ends. 

USB power is 
connected but the 
orange Battery LED 
displaying on the 
device.  There is no 
icon on the screen 
and no response from 
keyboard? 

Battery is empty?  Wait (up to 30 minutes) until the battery is charged enough for 
wake-up. 

No external power is 
connected and cannot 
wake-up ROAM™ 
using OK button or 
Bluetooth 
connection? 

Battery voltage is below 
wake-up level? 

Wait (up to 30 minutes) until the battery is charged enough for 
wake-up. 

Device displays partial 
charge when the 
battery is fully 
charged (i.e. was left 
in charger for more 
than 5 hours)? 

Need to restart? Restart entire system. 

EMG 

EMG reading is too 
high/low? 
  

EMG channel scale is not 
optimized? 

Adjust the scale by clicking on the scale values and typing in 
new values. 

Electrodes are wet or 
generally not sticking? 

Shave the area if necessary and wipe dry.  Apply a good 
amount of tape to keep moisture out. 

Detached electrode? Re-attach electrode. 

mailto:service@laborie.com
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Symptom(s) Possible Cause(s) Check/Corrective Action(s) 

Water/urine leaked all 
over the electrodes? 

Dry the area with a towel and replace the electrodes. 

No spike response in 
EMG and baseline is 
flat? 

Electrodes are not picking 
up the proper muscle 
group? 

Move either one or both measuring electrodes (the ones 
attached to the red leads) closer together. 
 

EMG response is too 
high and the channel 
is saturated? 
 

Electrodes are not picking 
up the proper muscle 
group? 

Move either one or both measuring electrodes (the ones 
attached to the red leads) a little farther apart. 

PRESSURES 

Pressure not 
responding? 

Position of catheters? Check position and adjust as necessary. 

Catheters are not securely 
connected to the cables? 

Check connections and adjust as necessary. 

Zeroes are not set 
properly? 

Reset zeroes. 

Catheter is kinked? Replace catheter if necessary. 

Using water-based 
disposables? 

Flush lines and reset zeroes.  Make sure all stopcocks are in 
the correct position.  Refer to the Consumables and 
Transducer Setup on page 25. 

PUMP 

Pump not running? Pump is not Calibrated? Calibrate Pump. 

Pump pressure limit 
reached? 

Reset P1 (Pves) to zero. Check for kinks in the bladder catheter. 

Volume limit exceeded? Reset VH2O Channel to Zero and try again. 

Pump calibration 
incorrect? 

Recalibrate the pump. 

 Pump rate set at 1ml/min? Close UDS software and wait one minute. Then, restart the 
software. 

Pediatric pump 
settings incorrect? 

Pediatric pump settings 
switch to adult pump 
settings? 

Follow the steps provided below to set up pump speeds for 
pediatric patients, 

 Open a Cystometry test (or any test file using a pump).  
 Enter patient information for pediatric patient.  Enter 

Height and Weight to view the calculated MPUR.  
Select the Use MPUR for pump speeds option under 
the Fill Rate section. 

 Click Save. 
 Click Yes. 
 Click Run and then click Start Pump on the control 

panel.  
 Click Info then click Patient information. 
 Click OK. 
 Re-select Use MPUR for pump speeds.  Click OK to 

load the correct MPUR speeds for the test.  
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Symptom(s) Possible Cause(s) Check/Corrective Action(s) 

UROCAP™ V 

Uroflowmeter signal 
shows vibration 
and/or spike patterns? 
 

Plastic beaker is touching 
the flow funnel? 

Reposition the Uroflowmeter and re-check. 

Patient touched the 
Uroflowmeter with their 
feet? 

Ask patient to remain calm during procedure.  Refer to Uroflow 
Options Dialogue Box, Artifact Recognition section on page 97 
for information on filtering non physiological spikes. 

Floor is unsteady? Move to a more solid foundation. 

Incorrect flow or 
volume readings? 

Beaker is not properly 
seated on Uroflowmeter 
dish? 

Adjust the beaker position. 

 

Funnel is touching the 
beaker? 

Adjust the commode chair or the Uroflowmeter. 

Incorrect beaker in use? Use beakers supplied by LABORIE ONLY. 

Error message on 
screen reads: 
“Calibration 
Failure…(Flow out of 
range.)” 

Water poured quickly into 
beaker? 

Pour water slowly and at a steady rate. 

More than 500mL poured 
into beaker? 

500mL of water must be poured into the beaker. 

Error message on 
screen reads: 
“Calibration 
Failure…(Volume 
delta out of range.)” 
 

Less than 500mL of water 
poured into beaker? 

500mL of water must be poured into the beaker. 

BLUETOOTH CONNECTION 

Unable to connect via 
Bluetooth? 

Connection broken? Reduce the distance between the device and the computer. 
The maximum distance between the processor and the 
computer can be up to 10 meters (33 feet).  Remove any 
physical barriers like walls, posts, doors, or people. 

Unable to connect 
devices to Bluetooth 
at first setup? 

Connection broken? Reconnect devices: 
 Click the Bluetooth button on the device to “wake up” 

the device and re-establish a connection. 
 Wait 5 minutes. 
 If the button press does not re-establish a connection, 

then press the system reset button on the tower to 
restart the entire system. 

 Once restarted wait for all connections to reset. 

Unable to connect to 
PC via touchscreen? 

Connection broken? Reconnect devices in the touchscreen: 
 First disconnect all Bluetooth devices via the 

touchscreen. 
 Restart the software and establish a connection to the 

PC.  Refer to the Connect the PC/Laptop to the System 
section on page 39.  

 Reconnect all Bluetooth devices via the touchscreen.  
Refer  
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Symptom(s) Possible Cause(s) Check/Corrective Action(s) 

EVENTS 

A “transducer 
change” event is 
marked on the graph? 

Cable 
connected/disconnected 
from device? 

This action is marked on the graph to help distinguish it from 
an actual signal received during testing. It is also marked when 
the ROAM™ DX device goes through an auto-recovery 
process. 

SOFTWARE ERROR MESSAGES - iList Reporter 

Error message: “Error 
Code: 66a (Can't 
install KB2160841)” 
appears? 

.NET Framework file 
needs repair. 

To repair .NET Framework File: 
 Click Start > Control Panel > and double-click Add or 

Remove Programs.   Alternatively, click Start > Control 
Panel > Programs > Programs and Features. 

 In the resulting list, right-click the Microsoft .NET 
Framework 4 Client Profile file and select Change or 
select Uninstall/Change. 

 Select to Repair the file and wait for the repair to 
complete before continuing. 

 Restart the computer. 

UDS report not 
transferring to i-LIST 
Office Reporter? 

Make sure i-LIST 
MsgQListener is running. 
 

To Check MsgQListener: 
 Close all open programs. 
 Make sure i-LIST Message Queue Listener is running by 

clicking Start > Programs > Laborie > i-LIST 
MsgQListener. 

 Restart the computer and attempt to send a report to i-
LIST Office Reporter. If unsuccessful try the solution 
below. 

Install Windows Updates 
 

To Install Windows Updates: 
 Close all open programs. 
 Click Start > Control Panel and double-click Windows 

Updates -OR- Click Start > All Programs > Windows 
Updates. If there are updates waiting for installation, 
install them and then restart the computer. 

 Once restarted, attempt to send a report to i-LIST 
Office Reporter. If unsuccessful try the following 
solution to repair the .NET file. 

Repair .NET Framework 
File 
 

To repair .NET Framework: 
 Click Start > Control Panel > and double-click Add or 

Remove Programs.  Alternatively, click Start > Control 
Panel > Programs > Programs and Features. 

 In the resulting list, right-click the Microsoft .NET 
Framework 4 Client Profile file and select Change OR 
select Uninstall/Change 

 Select to Repair the file and wait for the repair to 
complete. 

 Restart the computer and continue with sending a UDS 
report to i-LIST Office Reporter. 

http://social.answers.microsoft.com/Forums/en-US/vistawu/thread/11b6b2c5-e780-4343-9de5-ffa4619f45c4?outputAs=rss
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Symptom(s) Possible Cause(s) Check/Corrective Action(s) 

Error message appears after system restart stating 
devices not found: 

 

Do not click anywhere on the screen. Wait for message to 
disappear. Once message is gone continue with regular use. 

PC  
 

PC does not power 
on? 

Power interruption due to 
power outage? 

After power interruption follow the steps below: 
 Unplug the power cable from the power brick. 
 Press and hold the power button on the computer for 5 

seconds. 
 Wait for the lights over the power brick to switch-off. 
 Plug the power cable back into the power brick. 
 Press the power button on the computer to switch the 

PC on again. 

PRINTER 

Printer LED does not 
light up? 

Printer power cable 
unplugged? 

Plug in the printer power cable and try again. 

Printer is not turned on? Turn on the printer by pressing the printer power button. 

Printer Error LED on 
steady or flashing? 

Printer paper is out? Load the printer paper. 

Printer cover is open? Close the cover of the printer. 

Printer is out of ink? Replace the printer cartridges. 

Printer paper is jammed or 
mis-fed? 

Correct paper problem then, press paper feed button. 

BUBBLE DETECTOR 

Red light on sensor lit 
even though bubbles 
are not visible 

Pump tubing is not 
inserted securely? 

Make sure the pump tubing is placed securely into the groove 
on the sensor.  
 
 
 
 
 



LABORIE AQUARIUS XT/CT/LT/CTS Owner’s Manual   AQS-UM01   181 

Symptom(s) Possible Cause(s) Check/Corrective Action(s) 

CONTROL PANEL 

Script buttons 
(Uroflow Summary, 
Summary Review, 
etc…) stopped 
working? 

Program file for formatting 
buttons is not set 
properly? 

The program used for 
formatting script buttons must 
use the AutoHotKey.ahk 
format. To verify the program 
is correct follow these steps: 
 

 Go to C:\UDS120 and 
open the HK folder. 

 Make sure the file 
format icons are set to 
the AutoHotKey 
application as shown 
to the right: 

 If the icons are not set 
to the AutoHotKey 
application, for 
example they are in 
the Notepad format 
(as seen to the right) 
then you must change 
it to the AutoHotKey 
application: 

 

 Right-click on any line 
and select Properties.  
In the Opens with 
section click the 
Change button and 
select the 
AutoHotKey Unicode 
application in the 
resulting window and 
then click OK: 

 
 

. 
 

. 
 

. 

 The Opens with section will display the AutoHotKey 
application. 

 Click OK. 
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Symptom(s) Possible Cause(s) Check/Corrective Action(s) 

TOUCHSCREEN 

Touchscreen on tower 
frozen? 

Need to reset? Press the reset button on the Central Hub Computer (CHC) for 
5 seconds to reset the system: 

  . 

Table 34: Troubleshooting  

NOTE: The Laborie Aquarius LT, CT, CTS and XT are designed to be used as stand-alone cart systems, with the only 
mains power supply connection going through the LABORIE medical-grade power supply (LIT) in the base of the cart. Do 
not connect it to any other devices unless the whole system is outside the patient environment or the other device has its 
own medical grade power supply. 

12    END-USER SOFTWARE LICENSE AGREEMENT 
Find licenses and terms for LABORIE products and services in the following locations: 
 

End User License Agreement: http://www.laborie.com/eula/ 
 
Terms and Conditions: http:// http://www.laborie.com/terms-and-conditions/ 

  

http://www.laborie.com/eula/
http://www.laborie.com/terms-and-conditions/
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13    APPENDIX 
APPENDIX A. SYSTEM SPECIFICATIONS 
EQUIPMENT SPECIFICATIONS 
For proper operation, the device requires mains power 110 VAC or 240 VAC. 
 

AQUARIUS® Carts AQUARIUS® CT CART: SINGLE DISPLAY 
L = 36” (90.0cm) 
W = 26” (66.0cm) 
H = 60-71” (153.0-180cm)  

AQUARIUS® XT TOWER 
L = 24” (60.0cm) 
W = 26” (66.0cm) 
H = 48” (120.0cm) 

AQUARIUS® XT PC CART: DUAL DISPLAY 
L = 36” (90.0cm) 
W = 34.5” (88.0cm)* 
H = 60-71” (153.0-180cm) 
*operational width described - can pivot to pass through doors. 

AQUARIUS® LT 
L = 32” (81.0cm) 
W = 26” (66.0cm) 
H = 48” (120.0cm) 

AQUARIUS® CTS 
L = 36” (90.0cm) 
W = 26” (66.0cm) 
H = 65” (165.0cm) 

Operating Conditions Temperatures: 15°C to 35°C  
Humidity: 20% to 80% relative humidity 
Pressure: 700 hPa to 1014 hPa (up to 2000 m) 

Transport and Storage Conditions Temperature: -29°C to 60°C 
Humidity: uncontrolled to 85% relative humidity 

Pump Hub 
P/N: PMP1000 

Output Channels: 2 Infusion / 1 Bubble/1 USB type A/ 1 USB type B 
 

  Roam™ DX 
P/N: RMX1000 
 

Dimensions: 5.5”(14cm) L X 3.6”(9.3cm) W X 1.6”(3.9) H 
Weight: 0.60 lbs (0.27kg) 
Pressure Range: -50 to +350 cmH20; EMG Range: 0 to 1000uV 
Output Channels: 4 Pressure / 1 EMG / 1 Pressure/EMG 
Sampling Rate (each channel): Pressure= 50Hz max.; EMG=5000Hz max. / 10 – 
100 Hz (increments of 10Hz) 

Urocap™ V 
P/N: TRA1002 

Dimensions: 6.3”(16.0cm) L X 6.3”(16.0cm) W X 2.6”(6.6cm) H 
Weight: 0.95lbs (0.43kg) 
Flow Range:  0 to 50mL/s; Volume Range: 0 to 1000mL 
Output Channels: Flow; Volume 
Sampling Rate: Flow=100Hz max.; Volume=100Hz max. 

UPP (arm and stand) 
P/N: UPP1001 and UPP1000 

Dimensions: 23.5”(59.7cm) L X 23.5”(59.7cm) W X 35.6”(90.4cm) H  
Arm extension: 30 » (76cm) 
Luxo: Extension 36.0” (91.5cm) / Weight: 3.3 lbs. (1.5kg) 
Speed: 0 to 3 mm/s 

Maximum load for printer shelf and 
workstation shelf 

22 Lbs. (10kg) 

Spinning Disk Flow Transducer  Width*: 16” (400mm) 
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P/N: 9034K0103  Depth*: 19” (485mm) 
Height*: 29-36” (735-925mm) 
Weight*: Less than 7.61 lbs (Less than 3.5 kg) 
Cable length*: 122" (310cm) 
Number of Channels: 1 
Power Supply: Power consumption: max 1.0A; Input: 24 V DC/1.0 A; Output: 
Tacho 
Accuracy: Refer to the Accuracy of the main device. 
Storage / Transportation: 

• Temperature -40° to +70°C (-40° to 158°F) 
• Humidity 10% to 100%rh (including condensation) 
• Atmospheric pressure 700 Pa to 1060 Pa 

Operating Conditions: 
• Temperature +10° to +40°C (50° to 104°F) 
• Humidity 30% to 75% 
• Atmospheric pressure 700 Pa to 1060 Pa 

Jug Volumes: Steel jug 1.5L; White jug 1L 
 
*values include the stand 

Table 35: AQUARIUS® Specifications 

T-DOC Air-Charged Catheters Conditions 

Operating Conditions: 15°C (59°F) to 40 °C (104°F) 

Storage Temperature: -25°C (-13°F) to +50°C (122°F) 

Anorectal Manometry (ARM) 

Test Capabilities Stationary Rest & Squeeze  
Pushing 
Rectal Volumes 
Rectoanal Inhibitory Reflex (RAIR) 
Balloon Expulsion 

Calculations Rectal Compliance (mL/mmHg) 
RAIR Inhibition and Excitation Characteristics 
Resting, Average and Max Pressures (mmHg) 
Fatigue Rate Index (min) 
Anal Canal Length (cm) or High Pressure Zone (cm) 
Ultra Slow Wave Analysis 
Pressure Area Functions 

Catheters  
 

T-DOC Air-Charged -> 4 channel radial 
Unisensor Electronic -> 4 channel radial -> 8 channel radial 
MUI Water Perfused -> 4 channel radial -> 8 channel radial 
Rectal pressure measurement available for specific options 

Accuracy 
 

Pressure: +/- 5%   
EMG: +/- 6%   
Volume using infusion transducer: +/- 10% 

Table 36: ARM Capabilities and Accessories 

CLASSIFICATIONS  
Classifications 
 

Class I Type BF Applied Part 
 
Mode of Operation: Continuous 
Equipment not suitable for use in the presence of a Flammable Anesthetic 
Mixture with Air or Oxygen or Nitrous Oxide. 

Table 37: AQUARIUS® Classifications  
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Spinning Disk Flow Transducer 

Classifications Degree of protection against electric shock: 
Type BF (Body Floating): Applied part provides a specific degree of protection 
against electric shock, particularly in regard to the amount of current leakage 
that is allowed. 
The applied part is mechanically isolated (floating). 

Not intended for direct cardiac application. 

Degree of protection against harmful ingress of water: IP33 

Degree of safety in presence of inflammable anesthetics: The device is not 
intended for use with anesthetic gases mixed with air, oxygen or nitrous oxide. 
Danger of electrical ignition. 
 
Mode of operation: Continuous / intermittent operation. 

Table 38: Spinning Disk Flow Transducer Classifications 
 

TYPE BF APPLIED PARTS 
• EMG/CMG 
• Pressure transducers 
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APPENDIX B. SYMBOLS AND LABELING 

 
Authorized Representative in 

the European Community 
(5.1.2)1: 

Indicates the manufacturer’s 
device representative in the 

European Community. 

 
SGS certification - certified to 

U.S. and Canadian safety 
standards. 

 
Date of Manufacture (5.1.3) 1: 

Indicates the date of device 
manufacture. 

 
Manufacturer (5.1.1)1: 

Indicates the device 
manufacturer. 

 
Consult Instructions for Use 

(5.4.3)1: 

Manufacturer recommends 
consultation of Instructions 

for Use. 

 
Read Operator’s Manual 

(M002)4: 

Indicates user must refer to 
Owner’s/Operator’s Manual. 

 
Lot - Batch Code (5.1.5) 1: 

Indicates the batch or lot 
code for identification and 

tracking purposes. 

 
Catalogue Number (5.1.6)1: 

Indicates the device model or 
catalogue number. 

 
Serial Number (5.1.7)1: 

Indicates unique device serial 
number for device 

traceability. 

 
Type BF Applied Part (Table D.1, 

20) 2: 

Identifies a type BF applied part 
complying with IEC 60601-1. 

 
Use-by Date (5.1.4)1: 

Indicates date after which use 
is prohibited. 

 
Sterile (5.2.1)1: 

Indicates a sterile device. 

 
Sterilized Using Ethylene 

Oxide (5.2.4) 1: 

Indicates method of 
sterilization used as ethylene 

oxide. 

 
Sterilized Using Irradiation 

(5.2.4)1: 

Indicates method of 
sterilization used as 

irradiation. 

 
Alternating Current (Table 

D.1, 1)2: 

Indicates use of Alternating 
Current. 

 
Direct Current 

(Table D.1, 1) 2: 

Indicates use of Direct Current. 

 
Non-ionizing 

Electromagnetic Radiation 
(5140) 5: 

Radio Frequency (RF) 
Transmitting Device 

Indicates presence of RF 
transmitters. 

 
Keep Dry (5.3.4)1 

Indicates a device requiring 
protection from moisture. 

 
Do Not Re-Use (5.4.2) 1: 

Medical device intended for 
single use, on a single 
patient, during a single 

procedure. 

 
Safety Label, No Pushing 

(P017) 3: 

To prohibit pushing against a 
specified device. 

 
Safety Label, No Sitting 

(P018)3: 

Indicates sitting on the 
identified surface is 

prohibited. 

 
Humidity Limitation (5.3.8) 1: 

Indicates the humidity range to 
which the medical device can be 

safely exposed. 

 
Temperature Limit (5.3.7) 1: 

Indicates the temperature 
limit to which the medical 

device can be safely 
exposed. 

 
Atmospheric Pressure 

Limitation (5.3.9) 1: 

Indicates the atmospheric 
pressure range to which the 
medical device can be safely 

exposed. 

 
Protective Earth, Grounding  

(Table D.1, 7)2: 

Identifies any terminal 
intended for connection 
to an external conductor 

for protection against 
electric shock in case of a 
fault, or the terminal of 

protective earth 
electrode. 

 
Not for general waste. This 
product is designated for 
separate collection at an 

appropriate collection facility 
in accordance with WEE 
Directive. Dispose of in 

accordance to local 
regulations. 

  
General Battery (5001B) 4: 

Identifies a device related to 
the power supply by battery. 

 
 

General Warning Sign (W001) 3 

Indicates a general warning. 

 
Safety Label, Safe working 

Load 10kg 

 

 
Safety Label, Safe Working 

Load 1kg 

 
System Safe Working Load 

 
Device Stop/Reset button: 
Press and hold for 3 seconds 
to reset. Press and hold for 5 
seconds or longer to bring to 

sleep. 

 
Direction of Pump Flow 

 
GS1 DataMatrix for Unique 

Identification 
(01) Global Trade Item Number 

(11) Date of Manufacture 

(21) Serial Number 

 
Importer (3725) 4: 

Indicates the entity that 
imports the medical device. 

 

1. EN ISO 15223-1 Medical Devices – Symbols to be used with medical device, labels, labelling and information to be supplied – Part 1: General Requirements. 
2. CAN/CSA-C22.2 No. 60601-1:14 Medical electrical equipment – Part 1: General requirements for basic safety and essential performance. 
3. BS EN ISO:2012+A6:2016 Graphic symbols – Safety colours and safety signs – Registered safety signs (ISO 7010:2011). 
4. ISO 7000:2014 – Graphic Symbols for Use on Equipment – Registered Symbols. 
5. IEC 60417 – Graphic Symbols for Use on Equipment. 

NOTE: Sterility symbols are applicable to consumbale devices only.  Refer to consumable device instructions for use for complete symbol and instructional overview. 

Table 39: Symbols Glossary 

https://en.wikipedia.org/wiki/File:WEEE_symbol_vectors.svg
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PRODUCT LABELS 
• Device label can be found on the cart leg: 
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APPENDIX C. ELECTROMAGNETIC COMPATIBILITY (EMC) 
This equipment has been tested and found to comply with the limits for: 

IEC 60601-1-2:2014 (Ed4.0) Medical electrical equipment – Part 1-2: General requirements for basic safety and 
essential performance – Collateral standard: Electromagnetic compatibility – 
Requirements and tests 

IEC 61000-3-2:2009  Limits for harmonic current emissions (equipment input current =16 A per phase) 

IEC 61000-3-3:2013 Limits – Limitation of voltage changes, voltage fluctuations and flicker in public low-
voltage supply systems, for equipment with rated current =16 A per phase and not 
subject to conditional connection 

IEC 61000-4-2:2008 Testing and measurement techniques –Electrostatic discharge immunity test 

IEC 61000-4-3:2010 Testing and measurement techniques – Radiated, radio-frequency, electromagnetic 
field immunity test.  Ed 3.2. 

IEC 61000-4-4:2012 Testing and measurement techniques – Electrical fast transient/burst immunity test 

IEC 61000-4-5:2005 Testing and measurement techniques - Surge immunity test 

IEC 61000-4-6:2003+A1:2004+A2:2006 Testing and measurement techniques – Immunity to conducted disturbances, induced 
by radio-frequency fields 

IEC 61000-4-8:2009 Testing and measurement techniques – Power frequency magnetic field immunity test 

 
IEC 61000-4-11:2004 

Testing and measurement techniques – Voltage dips, short interruptions and voltage 
variations immunity tests 

CISPR 11:2010 Industrial, scientific and medical (ISM) radio-frequency equipment – Electromagnetic 
disturbance characteristics – Limits and methods of measurement 

CISPR 22:2008 Information technology equipment – Radio disturbance characteristics – Limits and 
methods of measurement 

 
To prevent Bluetooth disconnection, limit the wireless interference from other devices or equipment, like microwaves, Wi-Fi, cordless/wireless technology 
at 2.4 GHz. 
1. These limits are designed to provide reasonable protection against harmful electromagnetic or other interference in most installations. However, 

there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful electromagnetic or other 
interference, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or 
more of the following measures: 

• Reorient or relocate AQUARIUS® unit. 
• Increase the separation between AQUARIUS® unit and the affected equipment.  
• Connect the non-medical system equipment into an outlet on a circuit different from that to which the AQUARIUS® unit is connected. 
• Consult the dealer or experienced technical personnel for help. 

WARNING! Changes or modifications not expressly approved by LABORIE could void the user’s authority to operate the equipment. 
 
2. This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful 

interference and (2) this device must accept any interference received, including interference that may cause undesired operation.  
3. This device contains: FCC ID: PVH0946 IC: 5325A-0946. 

Table 40: Electromagnetic Compatibility 
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IEC 60601-1-2:2014 Table 1 Requirements 

The Aquarius Urodynamic Analyzer System is intended for use in the electromagnetic environment specified below. 
The customer or the user of the Aquarius Urodynamic Analyzer 
System should assure that it is used in such an environment. 

Emissions Test Compliance Electromagnetic Environment – Guidance 

 
RF Emissions 

CISPR 11 

 
Group 1 

The Aquarius Urodynamic Analyzer System uses RF energy only for 
its internal function. 
Therefore, its RF emissions are very low and are not likely to cause 
any interference in nearby electronic equipment. 

RF Emissions 
CISPR 11 Class A The Aquarius Urodynamic Analyzer System is suitable for use in all 

establishments other than domestic, and may be used in domestic 
establishments and those directly connected to the public low-voltage 
power supply network that supplies buildings used for domestic 
purposes, provided the following warning is heeded: 

Warning: This equipment/system is intended for use by healthcare 
professionals only. This equipment/system may cause radio 
interference or may disrupt the operation of nearby equipment. It may 
be necessary to take mitigation measures, such as re- orienting or 
relocating the Aquarius Urodynamic Analyzer System or shielding the 
location. 

Harmonic Emissions 
IEC 61000-3-2 Class A 

 

Voltage Fluctuations/ 
Flicker Emissions IEC 

61000-3-3 

 

Complies 

Table 41: Electronic Emissions 
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IEC 60601-1-2:2014 Table 2 Requirements: 

The Aquarius Urodynamic Analyzer System is intended for use in the electromagnetic environment specified below. 
The customer or the user of the Aquarius Urodynamic Analyzer System should assure that it is used 

in such an environment. 

Immunity Test IEC 60601 
Test Level Compliance Level Electromagnetic Environment 

– Guidance 

 
Electrostatic 

Discharge (ESD) 
IEC 61000-4-2 

 

±8 kV Contact 
±2kV, ±4kV, ±8 kV  

and ±15kV Air 

 

±8 kV Contact 
±15 kV Air 

Floors should be wood, concrete or ceramic 
tile. If floors are covered with synthetic 
material, the relative humidity should be at 
least 30%. 

 
Electrical Fast 
Transient/Burst 
IEC 61000-4-4 

 
±2 kV for power supply 

lines 

 
±2 kV for power supply 

lines 

 
Mains power quality should be that of a 
typical commercial or hospital environment. 

 
Surge 

IEC 61000-4-5 

 
±1 kV line(s) to line(s) 
±2 kV line(s) to earth 

 
±1 kV line(s) to line(s) 
±2 kV line(s) to earth 

Mains power quality should be that of a 
typical commercial or hospital environment. 

 
Voltage Dips, 

short interruptions 
and voltage 
variations on 
power supply 

input lines 
 

IEC 61000-4-11 

0% UT 
(100 % dip in UT) 
for 0,5 cycle at 

0°, 45°, 90°, 
135°, 180°, 225°, 

270°, 315° 
 

70% UT 

(30% dip in UT) 
for 25 cycles 

 
0% UT 

(100% dip in UT) 
for 5 seconds 

 

<5% UT 
(>95 % dip in UT) 

for 0,5 cycle 
 

40% UT 

(60% dip in UT) 
for 5 cycles 

 
70% UT 

(30% dip in UT) 
for 25 cycles 

 
<5% UT 

(>95% dip in UT) 
for 5 sec 

 
Mains power quality should be that of a 
typical commercial or hospital environment. If 
the user of the Aquarius Urodynamic 
Analyzer System requires continued 
operation during power mains interruptions, it 
is recommended that the Aquarius 
Urodynamic Analyzer System be powered 
from an uninterruptible power supply or a 
battery. 

 
Power Frequency 

Magnetic Field 
(50/60 Hz) 

IEC 61000-4-8 

 
30 A/m 

 
30 A/m Power frequency magnetic fields should be at 

levels characteristic of a typical location in a 
typical commercial or hospital environment. 

NOTE UT is the a.c. mains voltage prior to application of the test level. 

 
Table 42: Electromagnetic Immunity  



LABORIE AQUARIUS XT/CT/LT/CTS Owner’s Manual   AQS-UM01   191 

IEC 60601-1-2:2014 Table 4 Requirements: 

The Aquarius Urodynamic Analyzer System is intended for use in the electromagnetic environment specified below. 
The customer or the user of the Aquarius Urodynamic Analyzer System should assure that 

it is used in such an environment. 

Immunity Test IEC 60601 
Test Level 

Compliance 
Level Electromagnetic Environment – Guidance 

Conducted 
RF IEC 
61000-4-6 

3 Vrms 
150 kHz to 80 MHz 
6Vrms for ISM 
bands. 

3 Vrms  
Portable and mobile RF communications equipment should be used no closer 
to any part of the Aquarius Urodynamic Analyzer System including cables, 
than the recommended separation distance calculated from the equation 
applicable to the frequency of the transmitter. 

   Recommended separation distance 

 
 

 

 

𝑑𝑑 = 1.17 �𝑝𝑝 150kHz to 80Hz 
𝑑𝑑 = 1.17 �𝑝𝑝 80 MHz to 800 MHz 

 
 

𝑑𝑑 = 2.3 �𝑝𝑝  800 MHz to 2.7 GHz 

 
Radiated RF 

IEC 61000-4-3 

 
3 V/m 
80 MHz to 2,5 GHz 
 
27 V/m 
385 MHz 
 
28 V/m 
450 MHz 
 
9 V/m 
710/745/78 
 
0 MHz 
28 V/m 
 
810/870/93 
0 MHz 
 
28 V/m 
1720/1845/ 
1970 MHz 
 
28 V/m 
2450 MHz 
 
9 V/m 
5240/5500/ 
5785 MHz 

 
3 V/m 

 
Field strengths from fixed RF transmitters, as determined by an 
electromagnetic site surveya should be less than the compliance level in each 
frequency rangeb 

 
Interference may occur in the vicinity of known RF transmitting devices and 
equipment marked with the following symbol: 

 

NOTE 1 At 80 MHz and 800 MHz, the higher frequency range applies. 
 

NOTE 2 These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and reflection from structures, 
objects and people. 

a) Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and land mobile radios, amateur radio, AM 
and FM radio broadcast and TV broadcast cannot be predicted theoretically with accuracy. To assess the electromagnetic environment due to fixed 
RF transmitters, an electromagnetic site survey should be considered. If the measured field strength in the location in which the Aquarius 
Urodynamic Analyzer System is used exceeds the applicable RF compliance level above, the Aquarius Urodynamic Analyzer System should be 
observed to verify normal operation. If abnormal performance is observed, additional measures may be necessary, such as re-orienting or 
relocating the Aquarius Urodynamic Analyzer System 
 

b) Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3 V/m. 

Table 43: Electromagnetic Immunity – Radio Frequency Communications 
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IEC 60601-1-2:20014 Table 6 Requirements: 

Recommended separation distances between 
portable and mobile RF communications equipment and the Aquarius Urodynamic Analyzer System 

The Aquarius Urodynamic Analyzer System is intended for use in an electromagnetic environment in which radiated RF disturbances are 
controlled. The customer or the user of the Aquarius Urodynamic Analyzer System can help prevent electromagnetic interference by 
maintaining a minimum distance between portable and mobile RF communications equipment (transmitters) and the Aquarius Urodynamic 
Analyzer System as recommended below, according to the maximum output power of the communications equipment. 
 

WARNING: Portable RF communications equipment (including peripherals such as antenna cables and external antennas) should be 
used no closer than 30 cm (12 inches) to any part of the Aquarius system, including cables specified by the manufacturer. Otherwise, 

degradation of the performance of this equipment could result. 
 

 

Rated maximum output 
power of transmitter 

(W) 

Separation distance according to frequency of transmitter (m) 

150 kHz to 80 MHz 
𝑑𝑑 = 1.17  �𝑝𝑝 

 

80 MHz to 800 MHz 
 

𝑑𝑑 = 1.17  �𝑝𝑝  

800 MHz to 2.5 GHz 
𝑑𝑑 = 2.33  �𝑝𝑝 

 

0.01 0.12 0.12 0.23 

0.1 0.37 0.37 0.74 
1 1.17 1.17 2.33 
10 3.70 3.70 7.37 
100 11.70 11.70 23.30 

For transmitters rated at a maximum output power not listed above, the recommended separation distance d in metres 
(m) can be estimated using the equation applicable to the frequency of the transmitter, where P is the maximum output power rating of the 
transmitter in watts (W) according to the transmitter manufacturer. 

NOTE 1 At 80 MHz and 800 MHz, the separation distance for the higher frequency range applies. 

NOTE 2 These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and reflection from structures, 
objects and people. 

Table 44: Separation Distances 
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APPENDIX D. COMMONLY USED TEST CONFIGURATIONS 
Test 

Name 
Channel 

Titles Scale Math Definition Data 
Rate 

Display 
Attribute 

Uroflowmetry 
Flow 40ml/s Null 5points/s Graphical 

Volume 600ml Null 5points/s Graphical 

Cystometry 
with 
EMG 

Pves 100cmH2O Null 5points/s Graphical 

EMG 400(none) Null 5points/s Graphical 

IH2O 200ml/min Null 5points/s Graphical 

VH2O 1000ml Null 5points/s Graphical 

Advanced 
CMG 

Pves 100cmH2O Null 4point/s Graphical 

Pabd 100cmH2O Null 4point/s Graphical 

Pdet 100cmH2O PvesPabd 4point/s Graphical 

EMG 400(none) Null 4point/s Graphical 

IH2O 200ml/min Null 4point/s Digital 

VH2O 1000ml Null 4point/s Digital 

Simple 
Pressure/Flow 

Pves 100cmH2O Null 3points/s Graphical 

Flow 40ml/s Null 3points/s Graphical 

Volume 1000ml Null 3points/s Graphical 

 
 
 
 
 

Advanced 
Pressure/Flow 

 
 
 
 
 

Pves 100cmH2O Null 3points/s Graphical 

Pabd 100cmH2O Null 3points/s Graphical 

Pdet 100cmH2O PvesPabd 3points/s Graphical 

Flow 40ml/s Null 3points/s Graphical 

Volume 1000ml Null 3points/s Digital 

IH2O 200ml/min Null 3points/s Digital 

VH2O 1000ml Null 3points/s Digital 

EMG 400(none) Null 3points/s Graphical 

UPP 

Pura 150cmH2O Null 5points/s Graphical 

Pves 150cmH2O Null 5points/s Graphical 

Pclo 150cmH2O PuraPves 5points/s Graphical 

Table 45: Test Configurations 
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APPENDIX E. APPENDIX E. GLOSSARY OF TERMS AND ACRONYMS 
TERMSxxxii USED IN URODYNAMICS TESTING 
 

Notations in italics indicate usage specific to LABORIE’s Urodynamic testing protocols. 
 

• abdominal pressure: (Pabd) the pressure surrounding the bladder, usually measured via rectum or vagina.  
o Standard channel on CMG or pressure/flow studies, measured in cmH2O. 

• abdominal leak point pressure: (ALPP) the intravesical pressure at which there is leakage of fluid from the bladder 
caused by increasing abdominal pressure by straining or coughing. ALPP less than 60cmH2O pressure is considered 
intrinsic sphincter dysfunction. ALPP greater than 90cmH2O pressure can indicate urethral hypermobility, and 
shows a low risk of intrinsic sphincter dysfunction.   

o Standard annotation in Event Menu, often on Control Panel.  
• acontractile detrusor: (formerly arreflexic bladder) absence of detrusor contraction under Urodynamic evaluation.  
• area under the curve: a calculation of the area contained by the curve of a urethral pressure profile. 

 
• bladder pressure: (Pves, intravesical pressure) pressure within the bladder. 

o standard channel on CMG, pressure/flow, or UPP tests, measured in cmH2O.  
 

• calibration: “checking calibrations” -verifying the accuracy of measurements.  
• recalibrate: a procedure to correct or improve the accuracy of  measurements.  
• capacity: notation of the sensation at which the patient feels he/she can no longer delay voiding. This is the point 

at which permission to void is given.  
o Standard annotation in Event Menu, often placed on the Control Panel.  

• closure pressure: (Pclo) the calculated value that reflects the difference between urethral pressure and bladder 
pressure. Pura–Pves=Pclo. Pclo less than 20cmH2O pressure can indicate intrinsic sphincter dysfunction.   

o Standard channel in a UPP test, measured in cmH2O.  
• cystometrogram: (CMG) the graphical recording of bladder pressures. Most commonly used to refer to general 

Urodynamic studies.  
o Standard will include Pves, Pabd, Pdet, EMG and display volume infused and infusion rate.  
 

• detrusor: muscle layer surrounding bladder.  
• detrusor leak point pressure: detrusor pressure at which urine leakage occurs.  

o in the absence of either a detrusor contraction OR increased abdominal pressure.  
o Most often seen in neurologically impaired patients such as spinal cord injury.  DLPP greater than 40cmH2O 

pressure can lead to upper urinary tract damage.  
• detrusor overactivity: characterized by involuntary detrusor contractions during the filling phase of Urodynamics – 

either spontaneous or provoked. 
• detrusor overactivity incontinence: incontinence as a result of involuntary detrusor contraction. 
• detrusor pressure: (Pdet) the calculated pressure measurement reflecting that component of total intravesical 

pressure that is generated by the detrusor muscle. Pves-Pabd=Pdet.  
o Standard on CMG or pressure/flow tests, measured in cmH2O. 

 
• electromyogram: the measurement of nerve activity – in Urodynamics to monitor sphincter muscle activity.  
• enuresis: involuntary loss of urine, usually subcategorized as nocturnal enuresis meaning involuntary loss of urine 

during sleep.  
 

• filling phase: (storage phase) often used to describe the CMG portion of a Urodynamic examination, this phase 
ends prior to voiding.  

• filling rate: the recommendation by ICS is greater than the predicted maximum filling rate (calculated at body 
weight in kg divided by 4).  Defined as between 10100ml/min, the typical filling rate during Urodynamics with adults 
is 50-60ml/min.   

o Usually displayed as a digital channel during CMG or pressure/flow tests, measured in ml per minute.  
• first desire to void: during Urodynamics, the feeling that would lead the patient to pass urine at the next convenient 

moment, but voiding can be delayed.  
o Standard annotation in Event Menu, often on Control Panel.  
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• first sensation of filling: during Urodynamics, the feeling when he/she is first aware of bladder filling. The reported 
sensation of “coldness” (secondary to room temperature infused fluid) is not usually considered the first sensation.    

o Standard annotation in Event Menu, often on Control Panel. 
• frequency: the complaint of voiding too often by day. 
• functional profile length: the length of the urethra along which the urethral pressure exceeds bladder pressure  

o calculated within a UPP segment, displayed in mm, as length of continence zone. 
 

• hesitancy: difficulty initiating voiding.  
 

• idiopathic detrusor overactivity: (formerly “detrusor instability”) incontinence due to an involuntary detrusor 
contraction with no defined cause.  

• incompetent urethral closure mechanism: when the urethra allows leakage of urine in the absence of a detrusor 
contraction. 

• incontinence: the involuntary loss of urine. May be further defined as: stress incontinence, urge incontinence, 
mixed (both stress and urge) incontinence, nocturnal enuresis, and situational incontinence.  

• International Continence Society: (ICS) “The primary interest of the International Continence Society is to study 
storage and voiding function of the lower urinary tract, its diagnosis and the management of lower urinary tract 
dysfunction, and to encourage research into pathophysiology, diagnostic techniques and treatment.” This group 
sets standards for Urodynamic testing followed by Laborie Medical Technologies ULC’s training programs.  

• intravesical pressure: (Pves) pressure measured within the bladder. Note that pressure within the bladder can 
come from two sources – pressure from the body (Pabd) and pressure from the muscle surrounding the bladder 
(Pdet).  Formerly known as “total intravesical pressure”.  

o Standard channel on CMG, pressure/flow, and UPP tests, measured in cmH2O.  
• intrinsic sphincter dysfunction: (ISD) is usually indicated by maximum urethral closure pressure less than 20cmH2O 

pressure, or ALPP less than 60cm H2O pressure. 
 

• leak point pressure: (LPP, ALPP, VLPP, CLPP) the intravesical pressure at which involuntary urine leakage in noted 
during increased abdominal pressure, in the absence of a detrusor contraction. Ex: leakage noted during 
Urodynamics when patient is asked to cough or bear down. This can be notated with the modifier of A for 
abdominal, V for Valsalva, or C for cough, but all are technically “leak point pressures”.  

o Referred to in cmH2O pressure.  
• lower urinary tract symptoms: (LUTS) these may include frequency, urgency, incontinence, nocturia, recurrent 

urinary tract infections, and many others.  
 

• maximum cystometric capacity: (capacity) the volume at which the patient can no longer delay voiding. During 
Urodynamics, this is usually the point at which permission to void is given.  

o Measured in ml, this is a standard annotation in Event Menu, often on Control Panel.  
• maximum urethral closure pressure: (MUCP) the maximum difference between urethral pressure and intravesical 

pressure. During Urodynamics, this is measured on the Pclo channel, and can be recorded independently or during 
a  urethral pressure profile.  

o Measured in cmH2O.  
• maximum urethral pressure: (MUP) maximum pressure of the measured profile.  

o Measured in cmH2O.  
• micturition study: a pressure/flow study. This study includes pressure measurements such as Pves and Pabd as well 

as Uroflow measurements.  This allows documentation of the relationship between the pressure generated during 
the voiding event and the resultant flow rate and pattern.  

 
• neuropathic detrusor overactivity: (formerly hyperreflexia) detrusor overactivity where there is a relevant 

neurological condition.  
• nocturia: complaint that patient must wake one or more times to void. 
• nocturnal enuresis: the complaint of loss of urine during sleep. 
• normal detrusor function: allows bladder to fill with little or no change in pressure, with no involuntary contractions 

despite provocation.  
 

• permission to void: annotation placed at time of reported sensation of bladder capacity, recommended by ICS to 
document when patient was told to allow voiding. This helps differentiate between contractions that are involuntary, 
and contractions that are voluntarily generated to initiate voiding.  
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• phasic detrusor overactivity: a characteristic wave form, which may or may not lead to incontinence post-void 
residual: (PVR) the volume of urine left in the bladder after voiding.  

• pressure/flow study: (Micturition study) a Urodynamic study that includes pressure measurements such as Pves 
and Pabd as well as Uroflow measurements. This allows documentation of the relationship between the pressure 
generated during the voiding event and the resultant flow rate and pattern.  

o Standard will include: Pves, Pabd, Pdet, EMG, Flow, Volume voided, and digital display of volume infused 
and infusion rate.  

• pump rates: using the pump, the rate at which fluid is infused into bladder during Urodynamic testing.  
o See” filling rate” for recommendations.  
 

• sensation: in Urodynamics, the reported sensations during testing such as first sensation, first desire, strong desire, 
and sense of reaching bladder capacity.   

o These are recorded as annotations, in the Event Menu and usually on the Control panel.  
• stress urinary incontinence: (SUI) the symptom of a loss of urine associated with exertion, often with cough or 

sneeze. This is considered a complaint unless proven through urodynamics, when it then is known as Urodynamic 
stress incontinence (formerly genuine stress incontinence).  

• strong desire to void: described as the persistent desire to void without fear of leakage.  
• subtracted pressure: usually referring to the difference between total intravesical pressure and abdominal pressure 

– Pdet.  
o Pves-Pabd=Pdet. 
 

• terminal detrusor overactivity: a single involuntary detrusor contraction occurring at capacity, which cannot be 
suppressed and results in incontinence, usually resulting in emptying of bladder.  

• total profile length: not generally accepted as a useful parameter. This is the length of the urethra measured from 
where the sensor enters the urethra to where the sensor exits the body. 

 
• uninhibited: acting without conscious inhibition – often used to describe a bladder contraction which the patient 

is unable to suppress.  
• urethra: the tube leading from the bladder to the outside of the body.  
• urethral pressure: (Pura) the pressure needed to just open a closed urethra. 

o Measured in cmH2O.  
• urethral pressure profile: (UPP) the pressures recorded throughout the length of the urethra, measured by 

withdrawing the catheter at a slow known rate (recommended: 1mm/sec). Most accurately done using a mechanical 
puller.  

o Standard will include: Pves, Pura, and Pclo. 
• urethral relaxation incontinence: leakage due to urethral relaxation in the absence of raised abdominal pressure 

or a detrusor contraction.  
• urgency: a sudden, compelling desire to void.  

o If reported during Urodynamic testing, this can be annotated. 
• urge incontinence: symptom of incontinence associated with a strong compelling desire to void. 
• Urodynamic stress incontinence: (formerly genuine stress incontinence, SUI, or stress incontinence) the 

involuntary leakage of urine during increased abdominal pressure, in the absence of a detrusor contraction. 
 

• valsalva: the attempt to forcibly exhale with a closed glottis – often used to increase intra-abdominal pressure.  
o Used to provoke stress incontinence, can be annotated as VLPP. 

• voiding phase: (emptying phase) often used to describe the portion of a Urodynamic evaluation that records both 
pressures and flow parameters during a voiding event, this would immediately follow the “filling phase”. 

 

ABBREVIATIONS 
Common abbreviations used in this manual: 

• CHC: Central Hub Computer 
• CFG: software configuration file 
• HMI: Human Machine Interface 
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CALCULATIONS 
• BOOI = pdetQmax – 2Qmaxxxxiii 
• BCI = pdetQmax + 5Qmaxxxxiii 
• BVE = (VV/BC) x 100xxxiii 

COMMON URODYNAMICS ACRONYMS 
• ALPP: Abdominal leak point pressure 
• BOOI:  Bladder outlet obstruction indexxxxiii 
• BCI: Bladder contractility index 
• BVE:  bladder voiding efficiency 
• CLP:  Cough leak point pressure  
• CMG:  Cystometrogram  
• DLPP:  Detrusor leak point pressure  
• DSD:  Detrusor sphincter dyssynergia  
• EMG:  Electromyogram  
• FUL:  Functional urethral profile length  
• ICS:  International Continence Society  
• IH2O:  Rate of fluid infusion during  
• ISD:  Intrinsic sphincter dysfunction (or deficiency) 
• LinPURR: linear passive urethral resistance 

(Nomogram available in UDS software) 
• LPP:  Leak point pressure  
• LUTS:  Lower urinary tract symptoms  
• MCC:  Maximum cystometric capacity  
• MUCP:  Maximum urethral closure pressure  
• MUP:  Maximum urethral pressure  
• NGB:  Neurogenic bladder Pabd Abdominal 

pressure 
• Pabd: Abdominal pressure  

• Pclo:  Closure pressure  
• Pdet:  Detrusor (or subtracted) pressure   
• Pura:  Urethral pressure  
• Pves:  Intravesical pressure  
• PVR:  Post-void residual  
• SUI:  Stress urinary incontinence  
• UDC:  Uninhibited detrusor contraction  
• UPP:  Urethral pressure profile  
• URA:  Urethral resistance factor - Nomogram  
• VH2O:  Volume infused during CMG  
• VLPP:  Valsalva leak point pressure  
• VS:  Valsalva  
• VUR:  Vesico-ureteral reflux 
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APPENDIX F. APPENDIX F: ARM VALUES   
MEAN VALUES RANGExxxiv 

Degree of Continence 
Number of 
Patients (F:M) 

Resting Pressure 
(mmHg) 

Squeeze Pressure 
(mmHg) 

Rectal Sensory 
Volume (mL) 

Volume for 
Reflex 
Relaxation 

Complete incontinence 39 (35/4) 51 (20-100) 88 (36-200) 31 (5-120) 18 (10-50) 

Partial incontinence 89 (72/17) 62 (18-144) 123 (0-420) 27 (5-23) 20 (5-50) 

Seepage and soilage 42 (24/18) 62 (18-169) 178 (0-395) 40 (10-100) 21 (0-60) 

Normal (controls) 35 (19/16) 88 (43-164) 204 (62-380) 19 (5-60) 19 (10-40) 

Chronic constipation 41 (30/11) 88 (30-139) 173 (60-390) 43 (10-120) 25 (10-50) 

Table 46: Arm Values – Mean Values Range 
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